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About this Guide

PEREGRINE

The Installation Guide explains concepts and provides step-by-step instructions
for installing Get-Answers.

By reading the Get-Answers Installation Guide, you will be able to:

= Install and configure the database server, search engine server, web server
and application server necessary for Get-Answers.

= Establish a connection between your application server and Web server.
= Create the Get-Answers tables and populate them with sample data.
= Index the sample documents.

Book audience

The Installation Guide was written for Get-Answers administrators. To use this
guide make sure you have knowledge of the following:

= Your organization’s process for performing software installations and your
responsibilities within that process

= Peregrine products that have been previously installed

= Your system architecture

= Your operating system user interface

= Configuring and maintaining local area networks (LANSs)

= System administration tasks in your environment

= System administration tasks for associated back-end products

About this Guide | 11



Related documentation

As you use Get-Answers, you can refer to this related documentation:

= Get-Answers Release Notes which provides information about new features,
corrected issues, and known issues and is located on the Get-Answers CD.

= Get-Answers Administration Guide which provides information about
controlling access to document collections and customizing Get-Answers.

= Get-Answers User Guide which provides information about searching the
Get-Answers document collection, working with documents, authoring
new documents, and generating reports.

= Notification Services Quick Start Guide which explains concepts, provides
step-by-step instructions, and describes tasks that you can complete in
Notification Services. It also provides information on configuring and
administering Notification Services. Notification services works with other
Peregrine applications to enable users to send and receive notifications.

Associated applications

This guide explains how to integrate Get-Answers with applications such as
ServiceCenter and how to use it with Get-Answers. For information on using,
installing, and configuring ServiceCenter, see the ServiceCenter
documentation.

Note: If you are integrating with other applications, they must be installed and
configured before you install Get-Answers.

12 | About this Guide



Typographical conventions

This guide uses typeface conventions to indicate special terms and actions.
These conventions and their meanings follow.

Convention Meaning

Bold Information that you must type exactly as shown
appears in bold. The names of buttons, menus, and
menu options also appear in bold.

Italics Variables and values that you must provide appear in
italics. New terms also appear in jtalics.

Monospace Code or script examples, output, and system messages
appear in a monospace font.

var msgTicket = new Message( "Problem" );

msgTicket.set( "_event", "epmc" );

An ellipsis (...) is used to indicate that portions of a
script have been omitted because they are not needed
for the current topic. Samples of code are not entire
files, but they are representative of the information
discussed in a particular section.

Filenames, such as login.asp, appearina
monospace font.

Special Elements

This book uses special elements to help you locate information. These special
elements and their uses are shown in the following table:

Element Usage

Important: Information that is required to complete a task

Note: Information that is of general interest

Tip: Information that can make a task easier or faster

Warning: Idnftormation thatis needed when there s arisk of losing
ata

Typographical conventions | 13



Contents of the Product CDs

The Get-Answers product comes with two installation CDs: the Get-Answers CD
and the Search Engine CD.

The Get-Answers CD contains the following items, which are required for
Get-Answers operation:

= Get-Answers application.
= Get-Answers sample data.

= A ServiceCenter unload file, sc60ga.unl.
The Search Engine CD includes the following, which are also required:

= Get-Answers Search Engine application
= Knowledge Management Library (KMLib)

Organization of the guide

The following table shows you where in this guide to find the information you

need.
This section Provides information about
Chapter 1, Get-Answers Installation Installation requirements and description
Overview of different types of installations for

Get-Answers.
Chapter 2, Setting Up the Get-Answers Detailed instructions for setting up

Servers database server and the Search Engine
server.
Chapter 3, Get-Answers Installation Detailed instructions for installing

Get-Answers in a Windows and Unix
environment.

Chapter 4, Completing the Installation Detailed instruction for the initial
configuration steps you need to complete
before you can begin using Get-Answers.

Chapter 5, Upgrading Get-Answers on Detailed instructions for upgrading
Application Servers Get-Answers.
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This section Provides information about

Chapter 6, Load-Balancing Tomcat Suggestions and instructions for loading
Application Servers the Tomcat application servers.

Chapter 7, Configuring Integrations Integrating Get-Answers with

ServiceCenter and also includes
configuration information for the email
adapter used by Notification Services.

Appendix A, Troubleshooting Installation  Troubleshooting installation problems

and Operation with Apache Web server, Tomcat, and
OAA.
Appendix B, Copyright Notices Additional licensing information.

Need further assistance?

For further information and assistance with this release, you can download
documentation or schedule training.

Customer Support

For further information and assistance, contact Peregrine Systems’ Customer
Support at the Peregrine CenterPoint Web site.

To contact customer support:

1 Inabrowser, navigate to http://support.peregrine.com

2 Log in with your user name and password.

3 Follow thedirections on the site to find your answer. The first place to search
is the KnowledgeBase, which contains informational articles about all
categories of Peregrine products.

4  If the KnowledgeBase does not contain an article that addresses your

concerns, you can search for information by product; search discussion
forums; and search for product downloads.

Documentation Web site

For a complete listing of current Get-Answers documentation, see the
Documentation pages on the Peregrine Customer Support Web.

Need further assistance? | 15
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To view the document listing:

1 Inabrowser, navigate to http://support.peregrine.com.

2 Log in with your login user name and password.

3 Click either Documentation or Release Notes at the top of the page.
4 Click the Get-Answers link.

5 Click a product version link to display a list of documents that are available
for that version of Get-Answers.

6 Documents may be available in multiple languages. Click the Download
button to download the PDF file in the language you prefer.

You can view PDF files using Acrobat Reader, which is available on the Customer
Support Web site and through Adobe at http://www.adobe.com.

Important: Release Notes for this product are continually updated after each

release of the product. Ensure that you have the most current
version of the Release Notes.

Education Services Web site

Peregrine Systems offers classroom training anywhere in the world, as well as
“at-your-desk” training using the Internet. For a complete listing of Peregrine’s
training courses, refer to the following web site:

http://www.peregrine.com/education

You can also call Peregrine Education Services at +1 858.794.5009.
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Get-Answers Installation Overview

CHAPTER

This book describes how you install Get-Answers version 4.2.
Important: Read all of the information in this chapter before you continue.
This chapter provides the following information:

= An overview of the architecture of the Get-Answers product. See
Get-Answers architecture on page 18.

= Software and platform requirements for Get-Answers. See Installation
requirements on page 20.

= Hardware requirements. Hardware requirements on page 21.

= The types of installation and the chapters you must read to complete each
type. Get-Answers installation overview on page 21.

= A worksheet for you to record information as you proceed through
installation. See Get-Answers installation worksheet on page 23.

What's new in Get-Answers 4.2

Major new features of this release include:

= Improved integration with ServiceCenter
= More configurable advanced search

= Hit highlighting for search results

= Manage retired document links
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= Configurable search mapping

= Contextual search history

= Improved document feedback management
= Save draft documents functionality

= HIPAA security

Get-Answers architecture

Get-Answers is a Web-based knowledge management application designed for
corporations to capture, store, and retrieve information in a knowledge
management database. It uses the Peregrine OAA Platform, a software platform
that provides common functionality to the following Peregrine products:
Get-Answers, Get-Services, and Get-Resources.

The Peregrine OAA Platform is not sold as a separate product. Further, you do
not need Get-Services or Get-Resources to use Get-Answers.

Note: This book contains references to OAA, which is the Peregrine OAA
platform. The Get-Answers installation includes installation of the
Peregrine OAA Platform.

Get-Answers uses three servers: a database server, a search engine server, and
an OAA/Web server. The OAA server is a generalization of an application (servlet
container) server such as Tomcat, Websphere, or WebLogic. You do not need a
detailed understanding of the functions of each server to install Get-Answers,
but a high-level understanding is necessary.
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Although all three servers interact with each other in several ways, this table
describes the basic functions of each server:

This server...

performs these functions...

Database server

OAA/Web server

Search Engine server

Stores the documents, maintains an index
of the documents, and provides
information to the other servers about
those documents.

Interacts with user’s browsers.

Accepts submissions from users for storage
on the Database server.

Stores retrieved documents in a temporary
file.

Stores submitted documents in the
temporary file.

Passes submitted documents to the
Database server for storage.

Queries the Database server to index
documents and then retrieves that
document from the Database server.

This image explains the relationships between servers as well. The Get-Answers
serversinteract with each other in several ways to manage the information users

need.

Database Serer

Temporary
Document
Storage

QaAMeb Server

Search Engine Server

The Database Server
keeps track of all
Get-Answers

e documents.

|

|

cmprEr

Users access
Get-Answers
e through their
1 User Bronsare browsers, which talk
to the OAA
Get-Answers Server.
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You can run each server on a separate computer, or you can run all servers on
one computer. Peregrine recommends that you use Get-Answers on three
computers. The installation instructions describe how to use three servers to
install Get-Answers.

Important: To install Get-Answers successfully, you must perform the steps in
this guide in the order they appear.

Three-tier architecture

Get-Answers supports a true 3-tier architecture. The 3-tierimplementation does
not incorporate the use of a File Server. The physical documents are stored on
the Database Server in the third tier.

Get-Answers Three-Tier Implementation

Tier 1 Tier 2 Tier 3

[T

‘whark ztation webServer 'E Application Search Engine Database

Firewall Server Server Flrewall SEWEF

D ata

Files, which can be written in chunks, are uploaded and downloaded to the
database. This process can be either synchronous or asynchronous.

Installation requirements

The requirements for proper installation and configuration of Get-Answers are
described in the Get-Answers Compatibility Matrix, which is available at the
Peregrine Systems Customer Support site. Go to http://support.peregrine.com;
click Documentation; choose Get-Answers; and then choose Compatibility
Matrices.

Important: Make sure to check the entire Get-Answers compatibility matrix
before starting the installation process.
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Note: If you integrate Get-Answers with ServiceCenter, you need to install it
separately. This back-end system is not included on the Get-Answers CD.
The installation instructions for ServiceCenter can be found in the
ServiceCenter documentation.

Hardware requirements

The following items are the minimum hardware requirements for Get-Answers:

Item Minimum Requirement

Processor Server: Pentium 1 GHz or faster

Client workstation: Pentium 300 MHz or faster
RAM 512 MB minimum on web server

128 MB minimum on RetrievalWare server (Search Engine server)
Disk Space 100 MB minimum available on the Web server

300 MB minimum available on Search Engine server

615 MB minimum available on Oracle server

Get-Answers installation overview

You can run Get-Answers in either:

= A Windows environment using Oracle, DB2, or SQL Server 2000 as the
database

-OR-

= An AlX or Solaris environment, using either Oracle, DB2, or SQL Server 2000
as the database.
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The following table shows what chapters in the book you must read to install
Get-Answers for your Get-Answers installation.

Installation Application Web Required chapters

and platform server type server type

type

First-time WebSphere, Apache, IBM HTTP Chapter 2, Setting Up the
installationon WebLogic, or Server, lIS50rlIS6, Get-Answers Servers
Windows, AlX, Tomcat iPlanet/SunONE Chapter 3, Get-Answers
or Solaris Installation

Chapter 4, Completing
the Installation

Upgradingto WebSphere, Apache, IBM HTTP Chapter 5, Upgrading
Get-Answers  WebLogic, or Server, lIS50rlIS6, Get-Answers on
Tomcat iPlanet/SunONE Application Servers

Chapter 4, Completing
the Installation

When you finish installing Get-Answers, no matter what type of installation you
use, read these chapters for information that might apply to you.

= Configuring Integrations on page 193
= Troubleshooting Installation and Operation on page 197
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Get-Answers installation worksheet

Use this worksheet to record information required for installation. For more
information that is specific to the database you are using, see one of the
following sections:

Setting up Oracle on the Database server on page 30
Setting up DB2 on the database server on page 33
Setting up SQL Server 2000 on the database server on page 36

Step Configuration item

1

Database Name. Required for Oracle, DB2 and SQL Server.

One of the following: the System ID (SID) for Oracle; the Instance Name for DB2;
or the Server Name for SQL Server.

Database Tablespace Name:

Database User ID:

Database User Password:

Database Server Net Service Name:

10

Database Server Hostname (machine name):

Database Server port number:

Note: The default Oracle portis 1521. The default DB2 portis 50000. The default
SQL Server port is 1443. These values can be changed. Consult your Database
Administrator for further information.

Search Engine Server Installation Directory:

From Installing the Search Engine on the Search Engine server on page 49.
Search Engine Server host name (machine name):

From Installing the Search Engine on the Search Engine server on page 49.
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Step Configuration item
11 Search Engine Search/Index Port:

From Installing the Search Engine on the Search Engine server on page 49.
12 Web Server Presentation Directory:

Tip: Print and save this table for use during the Get-Answers installation
process and for future reference.

Pre-installation checklist

Before installing Get-Answers, review this information, which outlines essential
information about some of the third-party products used in conjunction with
Get-Answers.

General recommendations

Before installing Get-Answers:

= Read the latest version of the Peregrine Systems Inc. compatibility matrix.
Available at: http://support.peregrine.com.

= Read the release notes for the product. Release notes contain the latest
information regarding the product and may include information not
available in the product documentation. Available at:
http://support.peregrine.com.
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Application server recommendations

After reviewing the compatibility matrix and product release notes:

= Ensurethattheapplication server or servers (Websphere, Weblogic, Tomcat,
iPlanet, SUnONE) on which you will be installing the servlet container have
the correct database client software loaded.

For example:

If you are using an Oracle database, make sure that you load the Oracle
client on your application server. Also, check that you loaded the correct
Oracle JDBC drivers.

If you use Microsoft SQL Server, you have the option of using the Microsoft
JDBC drivers or the JDBC drivers provided by i-Net (Sprinta driver).

= Confer with your application server administrator about having an HTTP
server such as IBM HTTP, Apache, IIS, or IPlanet available.

= Confer with your application server administrator to determine if any other
Web-based applications are installed on the server. It is helpful to know if
Get-Answers will be installed on a server that has more than one Web/http
server process running. It is also important to understand if the application
server is running other Web applications/instances. This information is
necessary to determine if the application server and Web/http server are
running on non-standard TCP ports.

For example, a Web/http server usually runs on port 80 and Tomcat defaults
to 8009 and 8080.

= Confer with your network administrator to ensure that the application
server can communicate using TCP to the Get-Answers Search Engine
server.

= Confer with your network administrator to ensure that the application
server can communicate using TCP to your database server.
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Database server recommendations

To anticipate and resolve any database issues:

= If you are using IBM DB2 version 7, ensure that both your database server
and database clients (the Get-Answers application server) are utilizing the
same version and fix-pack level. This is an IBM requirement and not
Peregrine’s.

= Confer with your database administrator to confirm that you have a valid
database user (Step 4 of the Get-Answers installation worksheet) and
password (Step 5 of the worksheet) to access the RDBMS. In addition, ensure
that a tablespace has been created for use by Get-Answers.

= Confer with your database administrator and verify the hostname and TCP
port number (Step 8 of the worksheet) of the database server hosting the
Get-Answers database.

= Confer with your network administrator to ensure that the database server
can communicate using TCP to the application server hosting Get-Answers.

= Confer with your network administrator to ensure that the database server
can communicate using TCP with the Search Engine server.

Search engine server

To anticipate and resolve any database issues:

= ForDB2, ensure that your Get-Answers search engine server (where you will
be installing the Search Engine component) has the Microsoft Data Access
Components (MDAC) installed. This software is necessary in order to create
and establish an ODBC connection to your RDBMS for use by the search
engine.

= ForSQL Server, install the SQL Server client utility.

= Ensure that the search engine server has a Java RunTime Environment (JDK)
installed (version 1.3.1_05 or greater). You can download the JDK from the
Sun Website before attempting the installation of the Search Engine.

The search engine can only be installed on a server using Windows 2000 or
2003.

26 | Get-Answers Installation Overview



The installer defaults the TCP and UDP port of the search engine to 5327. If
you wish to keep the default port number, ensure that this portis NOT in use
by any other application or process on the server.

The search engine utilizes both the TCP and UDP protocols for its
communications processes. If you install more than one search engine,
ensure that you configure the additional search engine to use a different
port number.
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Setting Up the Get-Answers Servers

CHAPTER

This chapter provides instructions on setting up the database server and the
Search Engine server. It includes instructions for setting either Oracle, DB2, or
SQL Server 2000 as your database. Complete the procedures in this chapter
before installing Get-Answers. If you are upgrading to Get-Answers 4.2

Important: Complete the tasks in the order in which they appear.

Step 1 Setting up the Get-Answers database on your Database server. See
Setting up the database server.

Step 2 Setting up and installing the Search Engine server. See Setting up and
installing the Search Engine server on page 42.

Setting up the database server

This section includes instructions for setting up the Oracle, DB2, or SQL Server
2000 database.

= If you are using Oracle, see Setting up Oracle on the Database server on
page 30.

= If you are using DB2, see Setting up DB2 on the database server on page 33.

= If you are using SQL Server 2000, see Setting up SQL Server 2000 on the
database server on page 36.
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Setting up Oracle on the Database server

Get-Answers 4.2 uses Oracle as the default database server. This section explains
how to set up the Oracle server, either version 8.1.7 or 9i, from the Oracle CD.

Note: The only versions of Oracle 9i that the search engine supports are 9.2.0.1
or higher. Both the native client and the server must be the same version.

Assume that you have installed the appropriate version of Oracle on the
database server. If you are installing Oracle for the first time on the server, set
both the database name and the database instance name to ORCL (Step 2 on
page 23 of the Get-Answers installation worksheet).

Note: Before starting the installation process, print a copy of the Get-Answers
installation worksheet on page 23; then use it to record the following
information during the Oracle installation: the Server ID (SID) (Step 2 of
the worksheet), Database Server Hostname (machine name) (Step 7 of the
worksheet), and Database Server port number (Step 8 of the worksheet).

After you install Get-Answers and start completing all installations, make
sure the Get-Answers Search Engine settings point to this database.

The next step is to add a new database user to the Oracle database.

Creating the tablespace and the rome user

The tablespace is the storage location for the Get-Answers database.
Throughout this documentation, the rome user has been designated as the
all-purpose user. You use the rome user to complete the installation.

Note: Rather than type the scripts in the following procedures yourself, you can
find the scripts for this procedure in the Oracle files directory on the
Get-Answers installation CD. The text for the create tablespace and
create user commands are in that folder.

Creating the tablespace
Create the tablespace on the database server.

Note: The tablespace requires 615 MB of free space. Make sure your hard drive
has this much free space.
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To create the tablespace:

1

On the database server, go the Start menu, select Programs > Oracle >
OracleHomeS8i > Database Administration - SQLPlus Worksheet.

Note: Do not use SQLPlus. Use SQLPlus Worksheet.

2

Log in as System, using manager as the password, or log in as the super user
for your system.

Consult your database administrator if you need help here.
Type the following:

CREATE TABLESPACE ROME DATAFILE ‘C:\ORACLE\Ora8l\database\ROME.ora’
SIZE 600M

AUTOEXTEND ON NEXT 1M MAXSIZE UNLIMITED;

commit;

Note: You can use a name other than “rome” for your tablespace if you prefer.

If necessary, edit the string to reference the drive and directory where Oracle
is installed. The path you enter, such as C: \ORACLE\ORADATA\ORCL, must
already exist on the system.

Click the lightning icon to run the script.

The script might take up to three minutes to run. When the following lines
appear, the script is finished:

Tablespace created.
Commit complete.

Look in the lower pane for any errors messages. If the previous lines
appeared and there are no errors, go to the next section, “Creating the Rome
user.”

Creating the Rome user

The rome user is the database administrator ID that Get-Answers uses to
connect to the database. The following script creates the rome user with
“connect” and “resource” rights.
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Note: Though this section uses rome as the user and tablespace names, you can
use another name if you prefer. In addition, you can tailor the script as
necessary for your system. Consult your Database Administrator for
assistance.

“Connect” provides the following rights.

Create session alter session
create table create view
create synonym create sequence
create database link create cluster

“Resource” provides these rights:

= create cluster

= create procedure
= Create sequence
= Create table

= Create trigger

To create the rome user:

1 Onthe database server, from the Edit menu, click Clear All to delete the text
in the window.

2 Type the following script.
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Note: Though the example script that follows uses rome as the user name and
tablespace name, you can use another name if you prefer. Specify the
database <password> that you want to use.

Make sure to record the Database User ID (Step 4), Database User
Password (Step 5), and Tablespace Name (Step 3) in the Get-Answers
installation worksheet on page 23.

3 Click the Lightning Bolt icon to execute the script.

Important: Do not continue to the next step until the script is finished running.
Once the script completes, proceed to Setting up and installing the
Search Engine server on page 42.

Setting up DB2 on the database server

To run Get-Answers and connect to a DB2 database, first follow the instructions
in this section to set up the DB2 database.

Important: Make sure that an expert DB2 Database Administrator sets up DB2.
The following instructions require advanced knowledge of DB2 to
complete successfully. The database administrator can provide you
with the database Server Hostname (machine name) (Step 7) and
port number (Step 8), which you record in the Get-Answers
installation worksheet on page 23 for use when installing
Get-Answers.

For best results, make sure that your database contains a minimum
tablespace size of 800 megabytes.

Tip: Forfuture reference, put the commands in this procedure in a text file and

call it from the DB2 command line using this command:
db2 -tvf <fileName>.sql
Where <fileName> is the name of your text file.

Note: Though the example that follows uses rome as the database name, you
can use another name if you prefer.

Make sure to record the Database Name (Step 1), Database User ID
(Step 4), Database User Password (Step 5), and Database Tablespace
Name (Step 3) in the Get-Answers installation worksheet on page 23 for
use when installing Get-Answers.
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To setup DB2:

1 Create the database using this command:
create database rome

This creates a database called “rome”.

2 Modify the database so that it contains a new BUFFERPOOL that serves the
application 8k, 16k, or 32k, using these commands:

connect to rome
create bufferpool bp32k size -1 pagesize 32K

3 Start and stop DB2 using these commands:

db2stop
db2start

Note: You may see an error if you stop the database while applications are
running. If so, use the commands force application all, and disconnect
<database>.

4 Create a new user and temp tablespace for each page size you have. Create
a User and Temp tablespace for the default 4k page size and a User and
Temp tablespace for the 32k page size. Use the following commands:

Make sure the user creating the bufferpool and tablespaces is the
db2admin. By default, the user creating those is the user that is logged into
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the DB2 server that stores the DB2 server software. To identify the user, type
connect to <Database_Name>

For example, type:
db2 => connect to rome

Information such as the following appears:

Database Connection Information:

Database server = DB2/NT 7.2.5
SQL authorization ID = ADMINIST...
Local database alias = rome

Note that ADMINIST... is the SQL authorization ID.

You should probably see DB2ADMIN or DB2INST1 (Windows and UNIX,
respectively).

5 If thisis set up wrong, you can correct it as the ADMINISTRATOR (assuming
that is who is logged in) by adding at the end of the section:

6 You can increase the size of the default bufferpool using the following
command, but this may require a large amount of memory. Do so only on
the advice of your DB2 database administrator.

7 Set the log file configuration parameters.
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8 Bizdoc uses this table to verify if connection is still alive, if not Bizdoc
reconnects to the database.

Note: The rome adapter uses Bizdoc as the connector to the database.

grant select on table sysibm.sysdummyl to public

9 Disconnect from the database using the following command:
disconnect rome

Setting up SQL Server 2000 on the database server

This section explains how to set up SQL Server 2000 in preparation for installing
Get-Answers. Setting up SQL Server involves the following steps:

Note: You do either step 2 or 3 depending upon which JDBC driver you use.
Step 1 JDBC drivers on page 36.

Step 2 Determining the required number of Sprinta software licenses on
page 37.

Step 3 Downloading the Microsoft SQL Server 2000 Driver for JDBC on page 37
Step 4 Preparing the SQL Server 2000 for Get-Answers on page 38.

Step 5 Select a case-insensitive Collation name. Collation name is the
drop-down list box under the General tab: on page 38.

Step 6 Creating a Security Login name on page 40.

Step 7 Setting security authentication on page 41.

JDBCdrivers

With the SQL Server database you can use the appropriate Microsoft driver for
the SQL Server database that you can download from the Microsoft Web site
(Type 4 Microsoft SQL Server 2000 Driver for JDBC). If you are using the Sprinta
driver, you must purchase Sprinta driver licenses from i-net Software. To
purchase Sprinta drivers, go to http://www.inetsoftware.de/English; search for
JDBC drivers for Microsoft SQL Server; and purchase Sprinta driver licenses.
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Determining the required number of Sprinta software licenses

The number of Sprinta licenses required for your Get-Answers deployment is
based on the maximum number of database connections that Get-Answers can
use, which depends on the number of Java Virtual Machines (JVMs) employed
and the number of database adapters configured in the Administration module.
The minimum number of connections is 3 per JVM, but in a production
environment you would expect to use 12 or more. Each JVM require up to 2
connections for administration plus the number of connections configured. The
number of connections actually used increases with load, but never exceeds the
configured maximum.

To determine the number of database adapters, click Settings in the left
Navigation Barin the Peregrine Portal; click the rome tab; and check the Adapter
Pool Size field. (The default is 10.) To calculate the maximum number of
connections use the following formula:

Maximum_Connections = Number_of_JVMs x (2 + Adapter_Pool_Size)

For example, a Get-Answers deployment application running on 3 JVMs and
configured to use 10 adapters can use up to 36 database connections,
calculated as follows: 36 =3 x (2 + 10).

Downloading the Microsoft SQL Server 2000 Driver for JDBC

To download Microsoft's driver for the SQL Server database:

1 Goto the Microsoft Web site and download the Type 4 Microsoft SQL Server
2000 Driver for JDBC. Download the latest Service Pack and at the least SP3.

2 Using setup.exe ormssqlserver.tar, find or extract these three jar files
from the resulting directory structure:

= msbase.jar
= mssqlserver.jar

= msutil.jar

Note: After you install Get-Answers, you will need to use these files to set up the
database parameters. For more information, see Setting the Mircosoft
SQL Server 2000 parameters on page 147 in Chapter 4, Completing the
Installation.
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Preparing the SQL Server 2000 for Get-Answers

You must successfully install the SQL Server and record the Database Name,
Database Server Hostname, and Database Server port number information in
the Get-Answers installation worksheet on page 23.

To prepare the SQL Server 2000:

1 Acquire and install SQL Server 2000.

2 Createthetablespace onthe database server using the Microsoft SQL Server
Enterprise Manager.

a Right-click the database.
b Select New Database.

A window opens requesting the properties of the new database; for
example, GetAnswers.

Database Properties - GetAnswers y 5[

General | Data Files | Transaction Log |

@ Hame: IGalAnswars

Database

Status [Unknown]
Owiner [Unknown]
Date created: [Unknawn)
Size: [Unknaiwn]
Space available: [Unknown]

Mumber of users: [Unknown]

Backup
Last database hackup: Hone

Last tranzaction log backup: Mane

Maintenance
Maintenance plan: Mane
Collation name: |58L_Latin1_General CF1_C1_AS =l

ok | cancel [[FTHER

Important: Make sure that the Database Name (Step 1on the worksheet) is
alphanumeric and does not contain any dashes.

3 Select a case-insensitive Collation name. Collation name is the drop-down
list box under the General tab:
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In the SQL Server Enterprise Manager, when you create a new SQL Server
database for Get-Answers, it must be case-insensitive. During the
database creation, choose a Collation name under the General tab with a
value such as SQL_Latin1_General_CP1_CI_AS, where the Cl stands for
case-insensitive. Only select the Server default for the Collation name
value if you are certain that the Server default is case-insensitive.

Important: A database Collation name that has CS as part of its value is
case-sensitive, and will not work with Get-Answers.

Consult your SQL Server help files to determine which Collation names
are case-insensitive if neither Cl nor CS appears in the Collation name.

Note: Thetablespace requires 800 MB of free space. Defragment your hard drive
if necessary to ensure that your hard drive has as much contiguous free
space as possible.

Database Properties - GetAnswers x|

General Data Files I Transaction Log

Database files

Initial size: (ME]

ol

Delete

File properties
—v Automatically grow file

File growth——————————————— - Mauimum file size
’7(" In megabytes: 1 ﬂ ’75' Unrestiicted file arowth

& By percent 15 :Il

€ Bestict file growth MBE |2 :II

Ok I Cancel | Help |

4 Under the Data Files tab in the Initial size (MB) field, set the database size to
800 (at a minimum) and set the By percent to 15.

= [fthe database is less than 800 MB at creation time, intermittent Update
failure messages will occur, and the database will need to be backed up,
dropped, a new database of size 800MB created, and the old data
restored into the newer larger database.
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= Always consult your SQLServer database administrator on how to best
configure the database.

= Click OK.

5 Record this information about your SQL Server installation in the
Get-Answers installation worksheet on page 23.

= Database Name (Step 1)
= Database Server Hostname (machine name) (Step 7)
= Database Server port number (Step 8)

Creating a Security Login name

Use the SQL Server Enterprise Manager to create a login name, assign roles, and
grant permissions.

To create a Security Login name:

1 From the SQL Server Enterprise Manager, scroll to the Security folder and
right-click Logins to open the SQL Server Login Properties - New Login
dialog box.

SQL Server Login Properties - New Login ) 5[

General | Server Roles | Database Accessl

% Hame; gaDBO .

Authentication
1 Windows duthentication

Damain I -

SEcuity access;

% Grant access

£ Deny access

% SOL Server Authentication
Password IH—

Specify the default language and database for this login.

. D atabaze: IGaUBmswars 'I

Language: <Defaults

ok I Cancel | Help |

Defaults

a Type the login name, for example rome or gaDBO.

b Select the SQL Server Authentication option and type a password.
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c Select a database from the drop-down list.
2 Click the Database Access tab to set permissions for the database roles.

SOL Server Login Properties - gaDBO b x|
Generl | Server Foles  Datsbase Access I

Specify which databazes can be accessed by this login.

|Pemit [Database |User [
1 GASHL

oo IS
e

Morthwind

(| ﬁ db_accessadmin
(] ﬁ db_securityadmin
1 db ddiadmin LI

Properties |
ok I Cancel | Help |

Setting security authentication

After you create the Security Login name, verify that your server has Security set
to SQL Server and Windows authentication.

To set security authentication:

1 From the SLQ Server Enterprise Manager, scroll to your server and
right-click.
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2 Select Properties to open the SQL Server (Configure) dialog box.

-=_a SQL Server Properties (Configure) - QA-SQLZK E

Server Seftings I [atabaze Settings I Fieplication | Active Directory I
General I Memory I Frocessor Security | Connections

— Security
SOL Server provides authentication based on ‘Windows
accounts and a named SGL Server login 1D and password,

Authentication:

Verify thatyou select the
SQL Server and
Windows option.

© Windows only

Audit lewvel:
& Mone " Failure
' Success Al

r— Startup zervice account

Start and run SGL Server in the following account:
K+

" System account

& This account IAdministrator
Pazsword: lm

QK I Cancel | Help |

3 InSecurity, select SQL Server and Windows.
4 Click OK.

5 Record the User Id (Step 4) and User Password (Step 5) on the Get-Answers
installation worksheet on page 23.

Setting up and installing the Search Engine server

In this section you set up your Search Engine server so you can install the
Get-Answers Search Engine in the next section. Follow the procedures within
this section as they appear here.

Installing and configuring an Oracle client

If the search engine server is on a different computer than the Oracle server, you
need install a client on the search engine server. This client is available on the
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Oracle CD.If you already have already installed and configured the Oracle client,
go to Installing the Search Engine on the Search Engine server on page 49.

Note: This section included two sets of configuration instructions. One is for

Oracle 8.1.7i and one is for Oracle 9i. You should follow the instructions
appropriate for your configuration. You can use a 9i client with either 8i or
9i server, but you can only use the 8i client with an 81 server. Consult with
your DBA if you require further clarification regarding Oracle server/client
compatibility.

After you install the Oracle client, use the Network Configuration Assistant to
create an entry in your tnsnames.ora file to point to the Oracle server.

Perform the following procedures on the search engine server.

To configure the Oracle client for Oracle 8i:

1

Select Start > Programs > Oracle - OraHome8i > Network Administration>
Net8 Configuration Assistant.

Select Local Net Service Name configuration and then click Next.
Select Add and then click Next.
Select Oracle 8i database or service and then click Next.

Under Service Name, type the word ORCL (or the value you listed in Step 2
of the Get-Answers installation worksheet on page 23) and then click Next.

Note: The database name should be recorded in Database Name (global name

6

7

or service name) in the Get-Answers Installation Worksheet.
Select TCP as the network protocol and then click Next.
In the Host Name text box, type the Oracle server hostname. If the port
number is not the standard port number, select Use another port number

and type the port number in the accompanying text box and then click
Next.
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Note: Use the Oracle server Hostname you recorded in Step 7and Server port
number you recorded in Step 8 on the Get-Answers installation
worksheet.

8 Select Yes to perform a test, then click Next.

A Connecting... Test successful. message appears automatically.
However, you are connecting using a default Oracle ID.

9 Click Change Login.

10 In the Change Login dialog box, type the username and password the
search engine server should use to connect to the Get-Answers database
and then click OK.

Note: Use the Database User ID (Step 4), Database User Password (Step 5), and

Tablespace Name (Step 3) that you recorded in the Get-Answers

installation worksheet on page 23.

If the test is successful, the Connecting... Test successful. message
should appear again.

11 Click Next.

12 In the Net Service Name box, type a net service name. For example,
ORCL_HOSTNAME, where HOSTNAME is your Oracle server hostname.

Note: Record the Database Server Net Service Name in Step 6 of the
Get-Answers installation worksheet.

13 Select No toindicate you do not want to configure another net service name
and click Next.

ANet service name configuration complete message appears.
14 Click Next.

15 Select Local Net Service Name configuration, and then click Finish to save
the changes.
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To configure the Oracle client for Oracle 9i:

1

Click Start > Programs > Oracle - OraHome92 > Configuration and
Migration Tools > Net Configuration Assistant.

Ensure that a Listener has been configured before you continue.
Click Local Net Service Name configuration and then click Next.
Click Add and then click Next.

Click Oracle 8i or later database or service and then click Next.

Under Service Name, type the word ORCL (or the value you listed in Step 2
of the Get-Answers installation worksheet on page 23) and then click Next.

Note: The database name (Step 10of the worksheet) should be recorded in

10

Database Name (global name or service name).
Select TCP as the network protocol and then click Next.
Type the Hostname (Step 7 of the worksheet) for name of the server hosting
the database. If the port number is not the standard port number 1521, click
Use another port number and type the port number (Step 8 of the
worksheet) in the accompanying text box and then click Next.

Select Yes to perform a test and then click Next.

A Connecting... Test successful. message appears automatically.
However, you are connecting using a default Oracle ID.

Click Change Login.
In the Change Login dialog box, type the username (Database User ID,
Step 4 of the worksheet) and password (Database User Password, Step 5 of

the worksheet) the search engine server should use to connect to the
Get-Answers database and then click OK.
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Note: Record the user name in the Database User ID step and password in the
Database User Password step of the Get-Answers installation worksheet.

If the test is successful, the Connecting... Test successful. message
should appear again.

11 Click Next.

12 In the Net Service Name box, type a net service name. For example,
ORCL_HOSTNAME, where HOSTNAME is your Oracle server hostname.

Note: Record the Net Service Name in Database Server Net Service Name in
Step 6 of the worksheet.

13 Select No toindicate you do not want to configure another net service name
and then click Next.

A Net service name configuration complete message appears.
14 Click Next.

15 Select Local Net Service Name configuration, and then click Finish to save
the changes.

In a Windows environment

Step 1 Do one of the following:

= If Oracleis your database, use the procedures in the section, Making the
ODBC connection to the Oracle database on page 47.

= IfDB2isyour database, use the procedures in the section, Setting up DB2
on page 47.

= If SQL Server 2000 is your database, use the procedures in the section,
Setting up SQL Server 2000 on page 48.

Step 2 Follow the procedure in the section, Installing the Search Engine on the
Search Engine server on page 49 regardless of which database you use.

Step 3 Complete the process by following the steps in the section, Checking

the search engine installation on page 57, regardless of which database
you use.

46 | Setting Up the Get-Answers Servers



I Installation Guide
Making the ODBC connection to the Oracle database

In Get-Answers 4.2, the Get-Answers Search Engine provides native drivers from
Convera to connect to the database. You no longer need to install an Oracle
ODBC driver.

Setting up DB2

Your Get-Answers Search engine server needs a DB2 client to connect to the
database. To install the DB2 client, see your IBM documentation.

If you are using DB2 as your database, use this section to set up the DB client on
your Search Engine server.

Once you have installed the DB2 client, make sure that the fixpack level of the
DB2 client and DB2 server match exactly.

This section includes the procedures for determining your fixpack level and for
making the ODBC connection to the DB2 database.

Determining your Fixpack level

Important: Perform this procedure on both the DB2 server and the DB2 client if
you are using DB2 version 7.

To determine your fixpack level:
Note: The following instructions are for DB2 7.2.x.

1 From the command prompt at the server, navigate to the SQLLIB/bin
directory.

2  Type db2level.

3 Write down the information you see.
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4 Repeat this procedure on the client and write down the information you see
when you type db2level.

5 Compare both the server and the client settings.

The fixpack is the same if the value of the right-most number of each
matches in the informational tokens "DB2 v7.1.0.68".

This is a match: "DB2 v7.2.0.68" on the server and "DB2 v7.1.0.68" on the
client because the right-most number 68 is the same.

This is not a match: "DB2 v7.1.0.68" on the server and "DB2 v7.1.0" on the
client.

Making the ODBC connection to the DB2 database

To make the ODBC connection to the DB2 database (versions 7 and 8), use the
DB2 Client Configuration Assistant utility to create a connection from the Search
Engine server and ensure that the "Register this database for ODBC As a system
data source" option is checked.

Setting up SQL Server 2000

Your Get-Answers Search engine server needs a SQL Server client to connect to
the database. To install the SQL Server client, see your SQL Server
documentation.

48 | Setting Up the Get-Answers Servers



Installing the Search Engine on the Search Engine server

Install the Get-Answers search engine on the search engine server.

Important: DB2 users: When you are prompted for your database connection
parameters during this installation, use your current DB2
connection parameter values.

To install the Get-Answers search engine:

1

Insert the Get-Answers Search Engine Installation CD into the CD drive.

The installation process starts automatically.

O wislcome to the GekAns
@ Choose Destination Loca..,

59705 Get-Answers Search Engine

InstallAmpwhere will quide you through the installation of Get-Answers
Search Engine 4.2

8 Select Program Folder

@ Enter Port Mumber

@ Server Host name

B Select Database Type

B Database Login Dialog

B Get-Answers Search Eng..,
B Installing

B |rstallation Complete

Itis stronaly recommended that you quit all programs before
continuing with this installation

Click the Mext' button to proceed to the next screen. Ifyou want to
change something on a previous screen, click the 'Previous' button,

You may cancel this installation at any time by clicking the ‘Cancel’
huttan

Freviaus:

This list shows you where
you are in the installation
process.
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2 Click Next.

The Choose Destination Location dialog box that opens shows the default
location for the files. Here you can accept the default location or choose

another one, as the next steps describe.

] Get-Answers Search Engine 4.2

“SEIN0S Get-Answers Search Engine

B Wielcome to the GekAns... Setup will install Get-Answers Search Engine in the fallowing folder.
O Choose Destination Loca

8 Select Program Folder Ta install to this folder, click Mesxt

@ Enter Port Nurmber Toinstalltoa mﬁeremfumer, click Choose and s.elecl ammherfﬂme.r
You can choose notto install Retrievaiare by clicking Cancel to exit
@ Server Hostname Setup

B Select Database Type

The name of the

® Datab Login Dial Destination Folder

atabase Login Dialog i
® Gel-Answers Search Eng Chgstanswers default folder
8 Installing... Restore Default Folder Choose... | appears here.

B [rstallation Complete

Previous eyt

3 To select the destination folder, do one of the following:

= To accept the default location, click Next.
= Toselect a different location, click Choose, select the folder in the dialog
box that opens, and then click Next.

Warning: Make sure there are no spaces in this path name.

Note: Record the Search Engine installation folder name in Step 9 of the
Get-Answers installation worksheet on page 23.
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4 Inthe Select Program Folder screen, select a folder or other location for
program icons. Click Next.

‘E Get-Answers Search Engine 4.2 —i=)x]

910 Get-Answers Search Engine

Welcome to the Get-Ans Where would you like to create product icons? Se|ECt a folder for
' Ghoose Destination Loca.. & In a new Pragram Group GetkAnswersSearchEngined 2 — the program iCOﬂS
’

O Select Program Folder
® Enter Port Mumber ' Inan existing Program Group: |Abacast - and C|iCk Next‘
& Server Host name

B Select Database Type
@ Database Login Dialog € Onthe Deskiop

Bec 7 /1oVvers Search Eng.. © Inthe Quick Launch Bar
B Installing

B [ristallation Complete © Other: I CHunsE:

 Inthe Start Menu

' Dontereats icons

[ Create lcons for All Users

Previous

5 In Enter Port Numbers dialog box, type the port number for the search
engine server. Click Next.

Important: The following rules are crucial for successful installation.

= Do not choose port numbers that are already in use on this server.

= Make sure the port numbers for your search engine server are unique for
your site and different from the port numbers for any other search
engine server.
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Note: Record this port number selection in Step 110f the Get-Answers
installation worksheet.

‘E Get-Answers Search Engine 4.2 —i=)x]

SIE91S Get-Answers Search Engine

1 Welcome to the Get-Ans. Enter the port number far the GetAnswers Search Endine server,
Choose Destination Loca The port number must be a number between 1024 and 65000
E Select Pragram Folder Ifthere are any other Get-Answers Search Engine servers on yaur

O Enter Port Mumber network, you must enter a different and unigue port number for this
Server

® Cerver Hostname

B Select Database Type

B Database Login Dialog
Port Number:

B Get-Answers Search Eng
B |ristalling..
B [nstzllation Complete

Previous eyt

6 Inthe Server Host name dialog box, type the host name of the search engine
server and click Next.

Note: Record the Search Engine Server host name and IP address in Step 10 of
the Get-Answers installation worksheet.

Important: Make sure that you type the host name and not the IP address.

‘E Get-Answers Search Engine 4.2 — o x|

910 Get-Answers Search Engine

fieemeiojthe Gat-Ans Please enter the host name of the server where Get-Answers Search
Choose Destination Loca.. Engine is being installed

Select Program Folder
Enter Port Mumber

Server Hostname

B Select Database Type

B Database Login Dialog

B GetAnswers Search Eng..
B Installing

tion Complete

5 EA

Hostname |your_server_name

Previous MNext
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7 Ifthe Accessing User Path Variable message appears, click Yes.

ing User PATH Y ariable

Ermor: Unable to get key value.
Probably thiz means that the variable does not exist.
Do you want to continue and by to create the variable?

8 Inthe Select RDBMS Server Type dialog box that opens, choose your server
type. Click Next.

] Get-Answers Search Engine 4.2

SISIT05 Get-Answers Search Engine

Wiglcome to the Get-Ans... Selectthe database Client Software that you will be using with the
Choose Destination Loca GekAnswers Search Engine system

Select Program Folder
Enter Port Mumber
Server Hostname
Select Database Type
B Database Login Dialog

@

@ Get-Answers Search Eng. . ODEC (0B
@ Installing  ORACLES
B [ristallation Complete " ORACLEDI

 5QL Server 2000

Previous

9 Ifyouselect SQL Server 2000, type the name of your SQL Server database in
the Database Name field. Click Next.

) Get-Answers Search Engine 4.2 o ] 3

"SEIINE Get-Answers Search Engine

WWelcorme to the Get-Ans.. Please enter name of your database:

B &

Choose Destination Loca
Select Program Folder

M Enter Port Number
Sener Host name

O Select Database Type

B Database Login Dialog
B Get-Answers Search Eng

Datahase Name:

getanswers

B |ristalling..
B [nstzllation Complete

Previous eyt
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Warning: The field only accepts alphanumeric characters. Do not use dashes or
spaces.

If you select another database, proceed to the next step.

10 Inthe Database Login dialog box, type the values the Search Engine Search
Server should use to log on to the Get-Answers database and click Next.

Field Description

Username Type the value found in Database User ID in Step 4 of
the Get-Answers installation worksheet.

Password Type the value found in Database User Password in

Step 5 of the worksheet
ODBC Data Source Name  Type the value found in Database Server Net Service
(DSN) Name in Step 6 of the worksheet.

DB2: Use the ODBC DSN

Oracle: Use the TSN name

MS SQL: Use Hostname of the RDB Server

Note: For SQL, type the HOSTNAME of the server hosting SQL Server 2000.

‘5l Get-Answers Search Engine 4.2

“SEIN0S Get-Answers Search Engine

B Wielcome to the GekAns... Flease enterthe Usemname, Passward, and RDB Connection String
E Choose Destination Loca
B Select Program Folder DBZ: Use ODBC DEN
@ Enter Port Number Oracle: Use TNS Name

M SQL: Use HOSTNAME of RDB Server
B Server Host name

O Select Database Type

B Database Login Dialog
B Gel-Answers Search Eng
@ [nstalling... Password:
B [nztallation Complete Ipasawnm

Usernarme:

Imme

Database Connection String

Previous eyt
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11 In the Configuration Information dialog box, confirm your search engine
configuration settings and make sure you have adequate disk space, and
click Install.

59705 Get-Answers Search Engine

B wislcome to the GekAns Please review the ing before

Chaoose Destination Laca... Product Name: =
Select Program Folder Get-Answers Search Engine 4.2

Entet Port Number
B st narma Install Folder:

Select Database Type Chgetanswers

Datahase Login Dialog Shortcut Folder:

C:\Documents and SettingsiAll Users\Start
MenuProgramsuGet-AnswersSearchEngined 2

B Get-Answers Search Eng..,
B Installing
B |rstallation Complete
& Install Set
Typical

| |User ID:

The installer copies the search engine files to your server. This may take
several minutes.

D Get-Answers Search Engine 4.2 =] |
9105 Get-Answers Search Engina

R Peregrine

SYSTEMS,

Welcome to the Get-Ans
Choose Destination Loca..
Select Program Folder
Enter Port Mumber

B SererHostname

Select Database Type

B Database Login Dialog

B GetAnswers Search Eng..

B Installing
B [ristallation Complete

| Installing... Archive: rw70_win.zip
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12 When the installation is complete, click Done to exit the installer.

59705 Get-Answers Search Engine

B welcome to the Get-Ans Congratulations! Get-Answers Search Engine 4.2 has been

@ Choose Destination Loca., | SHecessfullyinstalled to
B Select Program Folder
g Clgetanswers
B Enter Port Number
B ServerHostname Your systern environment has changed. You will need to reboot your
M Select Database Type systemn for these changes to take effect
E Database Login Dialog
) Flease refer to the Installation Guide for valuable information on how
GetAnswers Search Eng.. to continue the installation and setup of RetrievalWare.
B Installing
O Installation Complete

13 Click Yes to restart your system.

Installation Complete =

Please restart your system to complete this action.

WMauld you like to restart wour machine now?

[ ]

Unless the search engine server is already started as a service or running in
aDOS window, start it by choosing Start > Programs > Get-Answers Search
Engine > Start Search Engine Search Server. Press Enter to exit the
command prompt window.
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Checking the search engine installation

Get-Answers provides a method of checking your search engine connection
with the database. When the search engine installation completes successfully,
this connection is established.

To check your search engine database connection:

1 Choose Start > Programs > Get-AnswersSearchEngine > Check Database

Connection.

eck Database Connection

server_name

User:
Connection String:
Datahase Mame:

e Search Engine working directory: C:ngetanswers:-Peregrine
RDBMS Information: Uendor MS-8QL, User rome, Database getanswers. Server your_

TEST THE RDBMS CONNECTION

Testing the RDBMS connection with the following values:

Buccessfully tested the connection to the Relational Datahase.
Press RETURN to continue.

RDBMS UTILITIES

getanswers

2 Afteryou see the Successfully tested the connection to the
Relational Database message, press Enter.

Note: If the test is not successful, check the name of the working directory
displayed on the Get-Answers Search Engine working directory line. This
should be the name of the directory where you installed the search
engine followed by Peregrine\KMLib.

Example: c:\getanswers\Peregrine\KMLib

The name of the Search Engine Server Installation Directory should be
recorded in Step 9 on page 23 of the Get-Answers installation worksheet.

3 Press any key to exit.
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Get-Answers Installation

CHAPTER

This chapter explains the installation and configuration of Get-Answers on the
OAA platform on a Windows or UNIX system using the application servers listed
in the Get-Answers Compatibility Matrix. These instructions are for a new
installation of Get-Answers. If you are upgrading Get-Answers from a previous
version, see Chapter 4.

The installation program no longer deploys files directly into an application
server’s directory structure. Instead, files are deployed into a staging area on the
file system. This staging area functions as a common place into which one or
more Peregrine Portal applications are deployed. From these deployed files, the
installation program builds a WAR file and terminates.

Important: After the installation program executes, you must perform
additional steps to complete the installation process.

With the WAR file, you must use the application server’s deployment process to
install the Peregrine Portal application. Once installed and running in the
application server, an administrator can then access the Get-Answers
Administration page to complete the setup process.

This WAR file distribution complies with the J2EE application deployment
process and enables one WAR file, containing the Peregrine Portal
application(s), to be conveniently deployed into separate test and production
environments.

Before you install the OAA platform on the Web server, see the recommended

configurations in the Get-Answers Compatibility Matrix, available at the
Peregrine Systems Customer Support site.
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To view the compatibility matrices:

1 Inabrowser, navigate to http://support.peregrine.com

2 Log in with your user name and password.

3 (Click Documentation > Get-Answers > Compatibility Matrices.

Note: All of the instructions in this chapter assume that you have installed a
database server and the search engine as described in Chapter 2.

Warning: Before you begin the installation process, close all anti-virus software
programs.

This section describes configurations required for the application servers and
Web servers to support Peregrine’s Open Application Architecture (OAA) and
the Get-It applications.

Application servers Web servers
Tomcat Apache
WebSphere Application Server IBM HTTP Server
WebLogic s

iPlanet

SunONE

Note: The following configuration information assumes that the server or
servers are installed and the services are enabled and running.

Pre-installation overview

Before installing any of the Get-It 4.2 applications, make note of the following
changes.
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Note: This section provides an overview only of the configuration changes

described in this chapter. Follow the detailed instructions for all of the
configurations that Peregrine Systems supports.

Use JDK 1.4.2 with OAA 4.2 applications when the application is not being
deployed to an application server that supplies its own JDK. This simplifies
the installation process.

When using JDK 1.4.2 with any OAA 4.2 application, it is no longer necessary
to copy any filesto $JAVA_HOME/jre/1ib/ext.

Note: Placing files in JRE/1ib/ext with JDK 1.4 is not appropriate when the

standard extension to 1.3 has been integrated into 1.4, as is the case of
JAAS, JCE, JSSE and JAXP. To override the built-in behavior of the 1.4 VM,
you must use the Endorsed Standards Override Mechanism located at
http://java.sun.com/j2se/1.4.2/docs/quide/standards/index.html. This is
required for the Xerces XML parser to be used, but Tomcat already
handles this case in its startup script. While JDK 1.4 ships with Xalan, the
XML parser included is Crimson, not Xerces.

When you use a Get-It 4.2 application with JDK 1.4.2 and Tomcat, there is no
need to place any files in JRE/1ib/ext or to directly make use of the
Endorsed Standards Override Mechanism. The only files formerly installed in
jre/1ib/ext that are still required are:

js.jar

jai_core.jar

jai_codec.jar

mlibwrapper_jai.jar

Install these in WEB-INF/11ib. The Xerces and Xalan supplied with Tomcat are
sufficient, as are the versions of mail.jar and activation.jar. The
oaasecurityproxy.jar fileis nolonger needed since the bug that required
this work-around was resolved when JAAS was integrated into JDK 1.4.
Detailed instructions for doing this are in the sections that follow.

When using WebSphere with a Get-It 4.2 application, ensure that the Web
application server classloading is configured to favor classes under WEB-INF
over those visible to parent classloaders. This is configured in the WAS
administration tool. Use the parent last setting. This setting is automatically
configured when using WebLogic with the included weblogic. xm1 file.
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= Whenusing WebSphere 4 or 5, it is no longer necessary to add the following
parameters to the Tocal. xml file.
<SSLProvider>com.ibm.jsse.JSSEProvider</SSLProvider>

<HTTPSHandlerPkg>com.ibm.net.ss1.internal.www.protocol</HTTPSHandlerPkg>
<CryptoProvider>com.ibm.crypto.provider.IBMICE</CryptoProvider>

While these options are still available, you no longer need to manually set
them on any of the Peregrine Systems supported platforms for Get-It 4.2
applications.

= When you are using Tomcat with JDK 1.4, do NOT use the LE version of
Tomcat. From the Tomcat FAQ at
http://jakarta.apache.org/tomcat/faqg/misc.html

Should | use the LE version?

No. It was an experiment, it failed. (YMMV) The original purpose of LE was
because jdk1.4 provides a LOT of standard functionality that Tomcat uses
that was notin jdk1.3. So to save some space two distributions were made
to save some bandwidth. Since then, it has been an exercise in confusion...

Also, you need to place the xalan.jar in the Tomcat /endorsed directory.

= When using an application server other than Tomcat with JDK 1.4, you may
have to add both Xerces and Xalan using the Endorsed Standards Override
Mechanism.

= If you are using WebSphere Application Server (WAS) 5.1, update to
WAS 5.1.1 or later.
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Configuring the servers to run Get-Answers

You must configure your application and Web servers prior to running the
Get-Answers installer. This section describes how to configure some of the
common application and Web server combinations with Get-Answers.

Tomcat and Apache servers

These instructions describe how to configure Tomcat 4.1.x as an application
server and Apache as a Web server, with no other applications running on this
configuration. Tomcat 5.0.x uses the same procedures.

To configure Tomcat and Apache:

Step 1

Step 2

Step 3
Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Download and install the Java Software Development Kit and the
servers. See Downloading the software on page 64.

Download the Web server connectors for Apache. See Downloading the
Web server connectors for Apache on page 64.

Run the installer. See Running the installer on page 64.
Copy the oaa.war file. See Copying the oaa.war file on page 65.

Start the application server. See Starting the Tomcat application server
on page 65.

Copy the jar files. See Copying the jar files on page 65.

Add the database driver jar. See Adding the database driver jar file on
page 66.

Edit the httpd.conf, mod_jk2.conf and workers2.properties files.
See Editing the connector files on page 66.

Start the Web server. See Starting the Apache Web server on page 69.

Step 10 Test the configuration. See Testing the configuration on page 70.
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Downloading the software
Download and install the Java Software Development Kit, Tomcat application
server, and Apache Web server.

Download Web site

Java J2SE v 1.4.x Software http://java.sun.com
Development Kit (SDK)

Tomcat 4.1.x application server or http://jakarta.apache.org
Tomcat 5.0.x

Apache Web server http://httpd.apache.org

Downloading the Web server connectors for Apache

To properly configure the servers, you must download the Tomcat Web server
connectors (JK2) for Apache and extract the files.

1 Download the following compressed Tomcat Web server connectors (JK2)
file for Apache from http://jakarta.apache.org:

(jakarta-tomcat-connectors-jk2.0.4-[operating system]-apache2.x.x.zip)

2 Extractmod_jk2.so to your Apache2\modules directory.

3 Extractmod_jk2.conf.sample to your Apache2\conf directory.
a Copy it to the same directory.
b Rename it to mod_jk2.conf.

4  Extractworkers2.properties.sample to your Apache2\conf directory.
a Copy it to the same directory.

b Renameittoworkers2.properties.

Running the installer
Follow the instructions in Running the installer on page 124 to install
Get-Answers on a Tomcat application server.

Note: Make sure that you stop Tomcat and Apache before installing
Get-Answers.
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Copying the oaa.war file
The installer creates the oaa.war file that you need to deploy the application.
= Copy the oaa.war file that the installer created from the Portal directory to
the <tomcat_home>\webapps directory, where <tomcat_home> is the path to

your Tomcat application server.

The default Tomcat path is: C:\Program Files\Apache Group\Tomcat 4.1.

Starting the Tomcat application server

When you start the Tomcat application server, the application automatically
deploys, creating an oaa directory under the webapps directory. The default path
is:C:\Program Files\Apache Group\Tomcat 4.1\webapps\oaa.

Once the application finishes deploying, stop the Tomcat application server.

Copying the jar files
The installer generates jar files that you must copy to the application server
endorsed directory.

1 Copy the following files from the installation directory
C:\Program Files\Peregrine\Portal\SupportFiles\JavaExtensions

xalan.jar
xercesImpl.jar
xml-apis.jar

where C:\Program Files\Peregrine\Portal specifies the location of your
application installation,

to the <tomcat_home>\common\endorsed directory.

Note: Create the endorsed directory if one does not exist.
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2 If necessary, replace any older versions of these files.
3 If xm1ParserAPIs.jar exists in the endorsed directory, delete it.

4 For Tomcat 5.0.x, copy the following files from the installation directory
C:\Program Files\Peregrine\Portal\SupportFiles\JavaExtensions

activation.jar
mail.jar
pop3.jar

to the <tomcat_home>\webapps\oaa\WEB-INF\1ib directory.

Adding the database driver jar file

Add the database driver jar to the <tomcat_home>\webapps\oaa\WEB-INF\1ib
directory.

Editing the connector files

You must edit the httpd.conf, mod_jk2.conf, and workers2.properties files
to properly configure the servers.

1 From the Apache\conf directory, using a text editor, open httpd. conf.
a Add the following code to the end of the file:

include “C:\Program Files\Apache Group\Apache2\conf\mod_jk2.conf”

where C:\Program Files\Apache Group\Apache2\conf\mod_jk2.conf
specifies the location of the mod_jk2. conf file on your Apache Web
server.
b Save and close the file.
2 From the Apache2\conf directory, using a text editor, open mod_jk2.conf.
a Delete any contents that may already exist in this file.

b Add the following code to instruct Apache to load the jk2 module:

LoadModule jk2_module modules\mod_jk2.so
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¢ Add the following code to instruct Apache to use the
workers2.properties file for configuration:

JkSet config.file "C:\Program Files\Apache Group\Apache2
\conf\workers2.properties"

whereC:\Program Files\Apache Group\Apache2\conf\workers2.properties
specifies the location of the workers2.properties file on your Web
server.

d Add the following code to make Apache aware of the location of the
\oaa context:

Alias /oaa "C:/Program Files/Apache Group/Tomcat 4.1/webapps/oaa"

where C: /Program Files/Apache Group/Tomcat 4.1/webapps/oaa
specifies the location of the webapps/oaa directory on your Apache
Tomcat application server.
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e Add the following entries to set access to the specified content in the
/oaa directory.

68 | Get-Answers Installation



Note: You must update the path specified in the examples with the path that
matches your Tomcat installation:
(C:/Program Files/Apache Group/Tomcat/..).
f Save and close the file.

3 From the Apache2\conf directory, using a text editor, open the
workers2.properties.

a Add the following lines of code:

b Save and close the file.

Starting the Apache Web server

To activate the new configurations, start the Apache Web server.
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Testing the configuration

After the application and Web servers are properly configured, log on to the
Get-Answers Admin page to configure the settings that are stored in the
Tocal.xml file.

1 Toverify that the Tomcatand Apache servers are properly configured, check
the following URLs.

= http://<server>:80 for the Apache Web server
= http://<server>:8080 for the Tomcat application server

Make sure that the appropriate Tomcat and Apache services or applications
are started before proceeding.

2 Follow the steps described in Configuring Get-Answers on page 127 to
complete the Get-Answers configuration.

Tomcat and IIS servers

The following instructions configure Tomcat 4.1.x to connect to an IIS 5.0 Web
server and Tomcat 5.0.x to connect to an IS 5.0 or IS 6.0 Web server. These
instructions set up Tomcat to use a single Java Virtual Machine (JVM). See the
Load-Balancing Application Servers chapter in this guide for information about
installing multiple JVMs.

To configure Tomcat and IIS:

Step 1 Download and install the Java Software Development Kit and the
Tomcat application server. See Downloading the software on page 71.

Step 2 Download the Tomcat-IIS JK2 Web server connector zip file. See
Downloading the Web server connector for IIS on page 71.

Step 3 Reboot your system. See Rebooting the system on page 72.
Step 4 Run the installer. See Running the installer on page 72.
Step 5 Copy the oaa.war file. See Copying the oaa.war file on page 73.

Step 6 Start the application server. See Starting the Tomcat application server
on page 73.
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Step 7 Copy the jar files. See Copying the jar files on page 73.
Step 8 Copy the jk2.reg file. See Copying the jk2.reg file on page 74.

Step 9 Configure the ISAPI Plug-in for IIS. See Configuring the ISAPI Plug-in for
IIS on page 74.

Step 10 Configure IIS to use isapi_redirector2.d11 as an ISAPI Filter. See
Configuring the isapi_redirector2.dll as an ISAPI filter on page 76.

Step 11 Create and configure a jakarta virtual directory in IIS. See Configuring
a jakarta virtual directory in lIS on page 77.

Step 12 Create and configure an oaa virtual directory in IIS. See Configuring an
oaa virtual directory in lIS on page 77.

Step 13 Edit the server.xm1 file to add performance settings and configure
alternate communications ports (Optional). See Editing the serverxml
file for IIS on page 78.

Step 14 Install Tomcat as a service using installservice.bat (Optional). This
file can be found in the <tomcat_home>\bin directory. See Installing
Tomcat as a service on page 79.

Step 15 Test the configuration. See Testing the configuration on page 81.

Downloading the software
Download and install the Java Software Development Kit and Tomcat
application server.

Download Web site

Java J2SE v 1.4.x Software http://java.sun.com
Development Kit (SDK)

Tomcat 4.1.x or 5.0.x application server http://jakarta.apache.org

Downloading the Web server connector for 11S

To properly configure the servers, you must download the Tomcat Web server
connector (JK2) for IIS and extract the files.

Configuring the servers to run Get-Answers | 71


http://java.sun.com
http://jakarta.apache.org

1 Download the following compressed Tomcat Web server connector (JK2)
file for IIS from http://jakarta.apache.org:

(jakarta-tomcat-connectors-jk2.0.4-[operating system]-IIS.zip)

2 Extractworkers2.properties.sample to your <tomcat_home>\conf
directory.

a Copy it to the same directory.
b Rename ittoworkers2.properties.

¢ Using a text editor, add the following lines of code to the end of file:

3  Extractisapi_redirector2.d11 to your <tomcat_home>\bin directory.

Rebooting the system

Before continuing with the configuration, reboot your system.

Running the installer
Follow the instructions in Running the installer on page 124 to install
Get-Answers on a Tomcat application server.

Note: Make sure that you stop Tomcat and IIS before installing Get-Answers.
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Copying the oaa.war file
The installer creates the oaa.war file that you need to deploy the application.
= Copy the oaa.war file that the installer created from the Portal directory to
the <tomcat_home>\webapps directory, where <tomcat_home> is the path to

your Tomcat application server.

The default Tomcat path is: C:\Program Files\Apache Group\Tomcat.

Starting the Tomcat application server

When you start the Tomcat application server, the application automatically
deploys, creating an oaa directory under the webapps directory. The default path
is:C:\Program Files\Apache Group\Tomcat\webapps\oaa.

Once the application finishes deploying, stop the Tomcat application server.

Copying the jar files
The installer generates jar files that you must copy to the application server
endorsed directory.

1 Copy the following files from the installation directory
C:\Program Files\Peregrine\Portal\SupportFiles\JavaExtensions

xalan.jar
xercesImpl.jar
xml-apis.jar

where C:\Program Files\Peregrine\Portal specifies the location of your
application installation,

to the <tomcat_home>\conf directory.

Note: Create the endorsed directory if one does not exist.
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2 If necessary, replace any older versions of these files.
3 If xm1ParserAPIs.jar exists in the endorsed directory, delete it.

4 For Tomcat 5.0.x, copy the following files from the installation directory
C:\Program Files\Peregrine\Portal\SupportFiles\JavaExtensions

activation.jar
mail.jar
pop3.jar

to the <tomcat_home>\webapps\oaa\WEB-INF\1ib directory.

Copying the jk2.reg file

The jk2.reg file creates a Windows registry entry.

Copy the jk2. reg file from the installation directory
C:\Program Files\Peregrine\Portal\SupportFiles\AppServerFiles
directory to the <tomcat_home>\common\endorsed directory,

where C:\Program Files\Peregrine\Portal specifies the location of your
application installation and where <tomcat_home> is the path to your Tomcat
application server.

The default Tomcat 4.1 path is: C:\Program Files\Apache Group\Tomcat 4.1.

The default Tomcat 5.0.x path is:
C:\Program Files\Apache Software Foundation\Tomcat 5.0.

Configuring the ISAPI Plug-in for I1S

The ISAPI plug-in for IIS establishes a connection between Tomcat and the IIS
Web server. Before configuring IIS to use this connector, you must update the
registry file entry for the connector to ensure that it has the proper paths listed
for the Tomcat application server.

Use the following procedures to configure the plug-in for your intranet
environment.
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To configure the ISAPI plug-in for IIS 5.0 or IS 6.0:
1 Open thefile jk2.regin a text editor. The file path for Tomcat 4.1.x is:

C:\Program Files\Apache Group\Tomcat 4.1\conf
The file path for Tomcat 5.0.x is:

C:\Program Files\Apache Software Foundation\Tomcat 5.0\conf

N

Verify that the ServerRoot and workersFile entries list the proper
installation path to Tomcat.

= For Tomcat 4.1.x, the default values are:

= For Tomcat 5.0.x, the default values are:
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3 Verify that the HKEY_LOCAL_MACHINE path is correct for your Tomcat version.

= For Tomcat 4.1.x, modify each version of Tomcat as follows:

= For Tomcat 5.0.x, modify each version of Tomcat as follows:

4 Save and close the jk2.regfile.

5 Right-click and select MERGE or double-click the jk2. reg file from Windows
Explorer.

Windows adds the registry settings to the Windows registry.

Configuring the isapi_redirector2.dll as an ISAPI filter

To establish a connection between Tomcat and IIS, you must install
isapi_redirector2.d11 as an ISAPI filter.

To install isapi_redirector2.dll as an ISAPI filter:

—_

From Windows Control Panel > Administrative Tools, open the Internet
Services management console.

2 Right-click the Default Web Site node and then click Properties.
3 Click the ISAPI Filters tab.

4  Click Add.
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5 Enter the following information:

Field Value Comments

Filter Name jakarta The filter name must match the name
youdefinedinthe jk2.regregistryfile.
By default, the filter name is jakarta.
Executable isapi_redirector2.d11 Thefile pathis:

C:\<tomcat_home>\bin\
isapi_redirector2.dl]

6 Click OK.

Note: Stop and restart the IIS service for changes to take effect. Also, restart your
Tomcat service.

7 From the Internet Services management console, right-click the Default
Web Site node, then select Properties > Isapi Filters again.

The ISAPI filter in IS displays a green status arrow to indicate that it is
running.

Configuring a jakarta virtual directory in l1S
The ISAPI plugin for IIS requires a specific virtual directory in order to run. Use
the following guidelines to create the virtual directory on the Default Web Site.
For specific instructions about configuring lIS, refer to your Windows Help.

To configure a jakarta virtual directory in IIS:

Use the following guidelines to create the virtual directory on the Default Web

Site.
Requirement Setting
Create virtual directory jakarta
Map to physical path <tomcat_home>\bin
Directory access rights Read, Run scripts, Execute

Configuring an oaa virtual directory in IIS

To run Get-Answers from IIS, you need to create a virtual directory that maps to
your Tomcat deployment folder. For specific instructions about configuring IS,
refer to your Windows Help.
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To configure an oaa virtual directory in IIS:

Use the following guidelines to create the virtual directory.

Requirement Setting

Create virtual directory oaa

Map to physical path <tomcat_home>\webapps\oaa
Directory access rights Read, Run scripts

Editing the server.xml file for I1S

A default Tomcat installation is sufficient for most Get-Answers installations.
However, if you are experiencing performance problems or communications
port conflicts, you may need to edit the Tomcat server.xm1 file to correct these
problems.

Performance settings
The Tomcat server.xm1 file allows you to determine how Tomcat processes

Get-Answers files. If you are experiencing performance problems, you can
change the <Context> setting for Get-Answers to disable page reloading.
Tip: Make a back up copy of the server.xm1 file before editing.

To edit the server.xml performance settings:

1 Open the file server.xml in any text editor. The default file path is:

C:\<tomcat_home>\conf

2 Create a <Context> element entry from Tomcat to the Get-Answers
deployment directory to establish a point of reference for docBase.

= For Tomcat 4.1.x, add the entry just above the examples Context entry.
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Example:

<Context path="/o0aa"
docBase="<tomcat_home>/webapps/oaa"
crossContext="false"

debug="0"

reloadable="false" >

</Context>

= ForTomcat 5.0.x, see the code creating a <Context> element on page 15
of Editing the server.xml files.

Setting the reloadable attribute to false results in faster JSP page processing.

For the docBase attribute, set <tomcat_home> to the absolute path of the first or
master Tomcat instance.

Installing Tomcat as a service
Afteryou edit the Tomcat files, you can install Tomcat as Windows services using
the installservice.bat file. See Installing Tomcat instances as services on
page 17 for more information.

This completes the procedure for IIS 5.0.

To configure the ISAPI plug-in connection between Tomcat and IIS 6.0,
complete the following:

1 SetthelSAPI Redirector Filter DLL in the Web Service Extensions to Allowed.

Note: This explicitly allows the redirector DLL to work within IIS. The enhanced
security in 1IS 6.0 includes Web Service Extensions. The redirector DLL,
added as an ISAPI Filter, needs to be added to this area of IIS and set as
Allowed.

2 Go to the management console.

Configuring the servers to run Get-Answers | 79



3 Click Web Services Extensions.

New Web Service Extension x||

Type the name of the new Web service extension, and specity the files that
I Internet Information Services (115) Manager - st be enabled for the extension to run,

f’ File Action Y¥iew Window Help

( Extension name:

¢ E@EBE @[]0

I Jakarta-Tomcat
i_j Internet Information Services - web Service Extensions
=] -il {local computer’ Required files:

) web Sites
b | Mleb Service Extension:

Al
Frohibit

Remoye:

Properties

¥ St extension status to Allowed
Tasks » Add file

Ertter the file location and name:
I Add & new Web service extensiun;—

K2 llow all web service extensions for a
specific spplication...

I prohibit ll web service extersions oK e |

@ Open Help.
| i

ol | Extended { Standard 7
| [

Path to File:

IC:'LJakarta—TDmcat\b\n\win32\i356\isap\_redire- ”

4  Choose Add a new Web service extension.

5 Enteran extension name (for example, Jakarta-Tomcat), and then select the
Set extension status to Allowed check box.

6 Click Add.

7 Enter the path to isapi_redirector2.d11 and click OK.
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Testing the configuration

After the application and Web servers are properly configured, log on to the
Get-Answers Admin page to configure the settings that are stored in the
Tocal.xml file.

1 To verify that the Tomcat and IIS servers are properly configured, check the
following URLs.

http.//<server>:80 for the IIS Web server

http.//<server>:8080 for the Tomcat application server

Make sure that the appropriate Tomcat and IS services or applications are
started before proceeding.

2 Follow the steps described in Configuring Get-Answers on page 127 to
complete the Get-Answers configuration.

WebLogic 6.1 SP4 and IIS

The following procedures configure WebLogic to run Get-Answers on Windows.

To configure WebLogic 6.1 SP4 with IIS:

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Stop both WebLogic and your Web server. See Stopping the servers on
page 82.

Edit the startWebLogic. cmd file to set the system password, memory
settings, and start mode. See Editing startWebLogic.cmd on page 82.

Edit the Server.Policy file to set the debug to true. See Editing the
Server.Policy file on page 84.

Run the Get-Answers installer. See Running the installer on page 84.

Move jar files to the Java development kit ext directory. See Moving jar
files to the Java Development Kit ext directory on page 84.

Configure IIS to use iisforward.d11 as an ISAPI filter and create an

extension. See Configuring the iisforward.dll as an ISAPI filter and an
extension on page 85.
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Step 7 Configure lIS to use iisproxy.d11 as an extension. See Configuring the
iisproxy.dll as an extension on page 86.

Step 8 Copy the installed files to your WebLogic directory. See Copying the
installed files to your WebLogic directory on page 87.

Step 9 Create a virtual directory for Get-Answers in your Web server. See
Creating a virtual directory for Get-Answers on page 88.

Step 10 Restart WebLogic and your Web server. See Restarting the servers on
page 89.

Step 11 Configure Get-Answers. See Configuring Get-Answers on page 89.

Stopping the servers

Before you begin configuring WebLogic, you must close your WebLogic server
and Web server.

To begin configuring WebLogjic:
1 Stop the WebLogic application server.

2 Stop the Web server.

Editing startWebLogic.cmd
To edit startWebLogic.cmd:

1 Using atext editor, open the startWebLogic.cmd file. The default file pathis:

c:\bea\wlserver6.1\config\<mydomain>\
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2 Scroll to the following section of the script.

echo B o o R o S R o e R S e S e S e S e S e SR e
echo * To start WeblLogic Server, use the password @
echo * assigned to the system user. The system &
echo * username and password must also be used to &
echo * access the WeblLogic Server console from a web  *
echo * browser. &
echo B o o R o o R e o S e S e S o S e S o SR e
@rem Set WLS_PW equal to your system password for no password
prompt.

set WLS_PW=password

3 Inthe last line, change the word password to your WebLogic system
password.

4 Search for the -ms parameter and set it to 256m or greater.

5 Search for the -mx parameter setting in the file. The recommended setting
is 512m.

Note: Make sure that the setting for maximum heap size is less than the free
RAM available to the application server(s). Exceeding the amount of
available RAM causes the JVM processes to swap to disk, reducing overall
performance.

6 Setthe STARTMODE variable to STARTMODE=false.

Thefirst time you start WebLogic after the installation, you need to start itin
development mode for it to find the Web applications that you deployed.

7 Add the following phrase to the entry that precedes the weblogic.Server
entry. Keep the quotation marks.

“-Djava.security.auth.login.config==<WebLogic>\1ib\server.policy”

Where <WebLogi c> is the installation path for WebLogic. The default pathiis:
c:\bea\wlserver6.1l

8 Save the file.

Configuring the servers to run Get-Answers | 83



Editing the Server.Policy file

To edit Server.Policy:

1 Using a text editor, open the Server.Policy file. The default file path is:
c:\bea\wlserver6.1\Tib\

2 Add the following lines to the end of the file.

ServerLoginModule

{
weblogic.security.internal.ServerLoginModule required debug=true;

e
3 Save and close the file.

Running the installer

Follow the instructions in Running the installer on page 124 to install
Get-Answers on a WebLogic 6.1 application server.

Moving jar files to the Java Development Kit ext directory

The installer generates jar files that you must copy, or FTP, to the Java
Development Kit ext directory.

To move jar files:

1 Verify that the following directory exists. If it does not, create it:
c:\bea\jdk1l31\jre\Tib\ext

2 Goto<install_dir>\Portal\image\WEB-INF\T1ib where <install_dir>
is the location where you installed Get-Answers. The default location is
C:\Program Files\Peregrine\Portal\image\WEB-INF\T1ib.

a Move the Tog4j-1.2.6.jar file to \bea\jdk131\jre\1lib\ext.

b Copy the following files to \bea\jdk131\jre\1ib\ext.

jai_codec.jar
jai_core.jar
mlibwrapper_jai.jar
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3 Gotothe<«install_dir>\Portal\SupportFiles\JavaExtensions

directory and copy the following files to the \bea\jdk131\jre\1ib\ext
directory.

jaas.jar

jcel 2_2.jar
jcert.jar

jnet.jar

jsse.jar
ocal_policy.jar
oaasecurityproxy.jar
sunjce_provider.jar
US_export_policy.jar
xalan.jar
xercesImpl.jar
xml-apis.jar

4 Copy the following files from the installation directory
C:\Program Files\Peregrine\Portal\SupportFiles\JavaExtensions

activation.jar
mail.jar
pop3.jar

to the <APP_DEPLOYMENT_DIR>\WEB-INF\1ib directory.

Configuring the iisforward.dll as an ISAPI filter and an extension

To establish a connection between WebLogic and IIS, you install the
iisforward.d11 file as an ISAPI filter.

To install iisforward.dll as an ISAPI filter and an extension:

1 Open the Internet Services management console.

2 Right-click the <Machine_name> and then click Properties.

Note: This is not a Web site; it is the parent node in the tree for the Web sites.
3 Click Edit from the Master Properties pane.

4  Click the ISAPI Filters tab.

5 Click Add.
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6 Enter the following information.

Filter Name iisforward

Executable iisforward.d11

The default file path is:
c:\bea\wlserver6.1\bin\iisforward.d11

7  Click OK.
8 Click the Home Directory tab.
9 C(lick Configuration.
The Application Configuration page opens on the App Mappings tab.

10 Verify that there is a mapping for the .w1forward extension. If it does not
exist, click Add to map the .w1forward extension.

11 Enter the following information.

Executable iisforward.d11

The default file path is:
c:\bea\wlserver6.1\bin\iisforward.d11

Extension .wlforward
12 Close the Internet Services management console.

Configuring the iisproxy.dil as an extension

To establish a connection between WebLogic and IIS, you install the file
iisproxy.dl11 as an extension.

To install iisproxy.dll as an extension:
1 Open Internet Services management console.

2 Right-click the Default Web Site node and then click Properties.
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3 Click the Home Directory tab.
a Select the Read check box to enable it.

b From the Execute Permissions drop-down list, select Scripts and
Executables.

4 Click Configuration.
The Application Configuration page opens on the App Mappings tab.

5 Verify that there is a mapping for the . jsp extension and that it is mapped
to c:\bea\wlserver6.1\bin\iisproxy.dll.

a Ifthe .jsp extension mapping is not there, click Add.
b Enter the following information:

Executable iisproxy.dll

The default file path is:
c:\bea\wlserver6.1\bin\iisproxy.dll

Extension .jsp

Note: Ensure that the iisproxy.d11 is located in the same directory as the
iisforward.d11.

6 Close the Internet Services management console.
Copying the installed files to your WebLogic directory

The installer generates files that you must copy, or FTP, to your WebLogic
application directory.
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To copy the installed files:

1 Copy the Portal\image directory (the default path is
C:\Program Files\Peregrine\Portal\image) to the
<WebLogic>\applications directory.

The WebLogic default path is: C:\bea\weblogic6.1\config\<my-domain>

2 Rename <WebLogic>\applications\image directory to
<WebLogic>\applications\oaa.

Tip: If you need to FTP files from one server to another to perform the copy, it
is more convenient to FTP the oaa.war file in <Portal>\oaa.war to your
WebLogic server than to extract the oaa.war files into a
<WebLogic>\applications\oaa directory.

Creating a virtual directory for Get-Answers

To run Get-Answers, you create a virtual directory in your Web server that maps
to your WebLogic deployment directory.

To configure a virtual directory:

1 Use the following guidelines to create the virtual directory in WebLogic and
map it to your deployment directory with the following settings.

Requirement Setting

Create virtual directory <o0aa>

Access Permissions Read, Run scripts

Map to physical path <WeblLogic>\applications\oaa

Set Execute Permissionsto  Scripts and Executables

Where <oaa> is the name of the virtual directory you want to use for
Get-Answers. Peregrine recommends oaa as the virtual directory name. Use
this name in your application server configuration.

For <WebLogic>, enter the path to your WebLogic installation. The default
file pathis: c:\bea\weblogic6.1\config\<my-domain>\applications\oaa
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2 Right-click the newly created virtual directory under Default Web Site.
a Select Properties.
b Verify that the permission is Scripts and Executables.

3 Click Configuration on the Home Directory tab.
The Application Configuration page opens on the App Mappings tab.

4 Verify that there is a mapping for the . jsp extension and that it is mapped
to c:\bea\wlserver6.1\bin\iisproxy.dl1l.

Restarting the servers
To activate the new WebLogic configurations, restart the servers.

To activate the WebLogic configurations:
1 Restart your Web server.
2 Restart the WebLogic server.

3 Start Get-Answers.

Configuring Get-Answers
Follow the instructions in Configuring Get-Answers on page 127.

WebLogic 8.1

The following sections provide instructions for installing, setting up, and
configuring Get-Answers on a Windows or Unix platform with WebLogic 8.1
using WebLogic's internal Web server.

Step 1 Install Get-Answers, then copy or FTP the image directory. See Installing
Get-Answers on page 90.

Step 2 Copy the jar files. See Copying jar files on page 91.

Step 3 Edit the startmydomain file. See Editing the startmydomain file on
page 92.
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Step 4 Edit the Server.Policy file. See Editing the Server.Policy file on
page 94.

Step 5 Deploy the Web Application Module to the application server. See
Deploying to the application server on page 94.

Step 6 Modify the Tocal.xm1 file to configure Get-Answers. See Configuring
Get-Answers using the local.xml file on page 94.

Installing Get-Answers

Follow these step-by-step instructions to install Get-Answers on a WebLogic 8.1
application server. The installer creates an image directory that you must copy
or FTP to a deployment directory on the WebLogic server.

To install Get-Answers:

1 Run theinstaller on the installation CD. (See Running the installer on
page 124)

2 Do one of the following:
= OnWindows, copy the entire contents of the image directory (the default

path is C:\Program Files\Peregrine\Portal\image)to a deployment
directory of your choice on the WebLogic server.

Example: C:\Program Files\Peregrine\Portal\applications\oaa
= On Unix, FTP the entire contents of the image directory (the default path
is C:\Program Files\Peregrine\Portal\image) to a deployment directory
of your choice on the WebLogic server.

Example: app\peregrine\applications\oaa.

Note: These instructions refer to the deployment directory as
<APP_DEPLOYMENT_DIR>.
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I nstallationGuide
Copying jar files

The installer generates jar files that you must copy, or FTP, to the application
server endorsed directory.

= On Windows, copy the following files to the <jdk_dir>\jre\Tib\endorsed\
directory on the WebLogic server, where <jdk_dir> represents the path to
the JDK home directory.

xercesImpl.jar
xalan.jar
xml-apis.jar

The default path for these files is:
C:\Program Files\Peregrine\Portal\JavaExtensions
Create the endorsed directory if it does not exist in the JDK home directory.

= On Unix, FTP the following files to the <jdk_dir>\jre\1ib\endorsed\
directory on the WebLogic server, where <jdk_dir> represents the path to
the JDK home directory.

xercesImpl.jar
xalan.jar
xml-apis.jar

The default path for these files is:

C:\Program Files\Peregrine\Portal\JavaExtensions

Create the endorsed directory if it does not exist in the JDK home directory.

= Copy, or FTP, the following files from the installation directory
C:\Program Files\Peregrine\Portal\SupportFiles\JavaExtensions

activation.jar
mail.jar
pop3.jar

to the <APP_DEPLOYMENT_DIR>\WEB-INF\1ib directory.
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o CerAmwers
Editing the startmydomain file

= On Windows, use a text editor to modify the startmydomain.cmd file (or
whichever file you use to start the WebLogic server).

Add the following string to the final start up command (led by calling java):

-Djava.security.auth.login.config=%WL_HOME%\server\1ib\Server.Policy

Example:

= On Unix, modify the startmydomain.sh file according to your operating
system.
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Operating System Action

Solaris Add the following string to the final start up command (led by calling java).
-Djava.security.auth.login.config=${WL_HOME}/server/1ib/Server.Policy

Example:

java ${JAVA_VM} ${MEM_ARGS} ${JAVA_OPTIONS}
-Dweblogic.Name=${SERVER_NAME}
-Dweblogic.management.username=${WLS_USER}
-Dweblogic.management.password=${WLS_PW}
-Dweblogic.ProductionModeEnabled=${STARTMODE}
-Djava.security.policy="${WL_HOME}/server/1lib/weblogic.policy"
-Djava.security.auth.login.config=${WL_HOME}/server/1ib/Server.Policy
webTlogic.Server

AIX At the top of the file, add a single entry for LIBPATH and set it to the path for the
appropriate ServiceCenter libraries.

For example, when running ServiceCenter 5:
LIBPATH=<APP_DEPLOYMENT_DIR>/WEB-INF/1ib/AIX/ServiceCenter5

When running ServiceCenter 6:
LIBPATH=<APP_DEPLOYMENT_DIR>/WEB-INF/T1ib/AIX/ServiceCenter6

Export the completed variable entry using the following command:
export LIBPATH

Add the following string to the final start up command (led by calling java).
-Djava.security.auth.login.config=${WL_HOME}/server/1ib/Server.Policy

Example:

java ${JAVA_VM} ${MEM_ARGS} ${JAVA_OPTIONS}
-Dweblogic.Name=${SERVER_NAME}
-Dweblogic.management.username=${WLS_USER}
-Dweblogic.management.password=${WLS_PW}
-Dweblogic.ProductionModeEnabled=${STARTMODE}
-Djava.security.policy="${WL_HOME}/server/1ib/weblogic.policy"
-Djava.security.auth.login.config=${WL_HOME}/server/1ib/Server.Policy
webTlogic.Server

Linux Add the following string to the final start up command (led by calling Java).
-Djava.security.auth.login.config=${WL_HOME}/server/1ib/Server.Policy

Example:

java ${JAVA_VM} ${MEM_ARGS} ${JAVA_OPTIONS}
-Dweblogic.Name=${SERVER_NAME}
-Dweblogic.management.username=${WLS_USER}
-Dweblogic.management.password=${WLS_PW}
-Dweblogic.ProductionModeEnabled=${STARTMODE}
-Djava.security.policy="${WL_HOME}/server/1lib/weblogic.policy"
-Djava.security.auth.login.config=${WL_HOME}/server/1ib/Server.Policy
weblogic.Server
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Editing the Server.Policy file

Edit the Server.Policy file to define the back-end system.

= Create or edit the Server.Policy file (in the <wL_HOME>/server/1ib directory
for Unix or<wL_HOME>\server\1ib\ for Windows), with the following contents..

oaa{
com.peregrine.oaa.security.0OAALoginModule optional target=rome;
com.peregrine.oaa.security.0AALoginModule optional target=oaakm;

’
getit.admin{com.peregrine.oaa.security.GetitAdminLoginModule required;};
getit.anonymous{com.peregrine.oaa.security.GetitAnonymousLoginModule required;};
rome{com.peregrine.oaa.security.0OAALoginModule required target=rome;};

oaakm{com.peregrine.oaa.security.0AALoginModule required target=oaakm;};
ServerLoginModule{weblogic.security.internal.ServerLoginModule required;};

Deploying to the application server

Deploy the Web Application Module from the WebLogic 8.1 Web console using
the <APP_DEPLOYMENT_DIR> as the target.

Configuring Get-Answers using the local.xml file

To configure Get-Answers, you need to manually edit the 1ocal.xm1 file found
in <APP_DEPLOYMENT_DIR>/WEB-INF/Tlocal.xm1. If you do notfind the Tocal. xm1 file
in <APP_DEPLOYMENT_DIRECTORY/WEB-INF/, you need to create it by following the
steps in Creating a local.xml file on page 94. If you have a Tocal.xm]1 file, go to
Editing the local.xml file on page 95.

Creating a local.xml file
1 Start the WebLogic 8.1 server with the startmydomain.sh script.

Once the server finishes initializing, open the URL
http://<WebLogic Server>:7001/<Context Root>/admin.jsp in a browser.
This assumes your server port is 7001. Substitute your port number in the
URL if you are not using port 7001.

2 Log in with username System, keeping the password field blank.

a From the Administration menu, click Settings.

b Select the Common tab.
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¢ Scroll down to the Server URL field and replace the entry with the correct
URL.

Exannp|e:http://<WebLogicServer>:7001/<Context Root/login.jsp
d Click Save at the bottom of the tab.
e Log out of the Peregrine Portal.
f Stop the WebLogic server.

This creates the Tocal. xm1 file, which you now need to edit.

Editing the local.xml file

Edit the Tocal.xm1 file found in
<APP_DEPLOYMENT_DIRECTORY/WEB-INF/Tocal.xml.

To edit the local.xml file:

1

Using a text editor, add the following lines to the <settings></settings>
section of the <APP_DEPLOYMENT_DIR>/WEB-INF/local.xml file.

<jaas_config>
<useStandard]AASConfiguration>true</useStandardJAASConfiguration>
<jaasConfiguration>oaa</jaasConfiguration>

</jaas_config>

Start the WebLogic 8.1 server with the startmydomain.sh command or the
startmydomain.cmd command.

Once the server finishes initializing, open the URL http://<WebLogic
Server>:7001/<Context Root>/admin.jsp in a browser.

This assumes your server port is 7001. Substitute your port number in the
URL, if you are not using port 7001.

Log in with username System, keeping the password field blank.

Follow the steps described in Configuring Get-Answers on page 127.
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Gevnswers
WebLogic8.1and 1IS 5

The following instructions configure the WebLogic 8.1 application server with
the Microsoft Internet Information Server (lIS) Web server.

Step 1 Stop both WebLogic and your IIS Web server. See Stopping the servers
on page 96.

Step 2 Run the Get-Answers installer. See Running the installer on page 96.

Step 3 Copy the installed files to your WebLogic directory. See Copying the
installed files to your WebLogic directory on page 96.

Step 4 Create the oaa virtual directory. See Creating a virtual directory for
Get-Answers on page 97.

Step 5 Copythe iisproxy.d11 file. See Copying the iisproxy.dll file on page 98.
Step 6 Configure the lIS plug-in. See Configuring the IIS plug-in on page 99.
Step 7 Restart the servers. See Restarting the servers on page 103.

Step 8 Test your configurations. Testing the configuration on page 103.

Stopping the servers

Before you begin configuring WebLogic, you must close your WebLogic server
and lIS Web server.

Running the installer
You must do this on a Windows machine. See Running the installer on page 124.

Copying the installed files to your WebLogic directory

The installer generates files that you must copy, or FTP, to your WebLogic
application directory.
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To copy the installed files:

1

Copy the Portal\image directory (the default path is
C:\Program Files\Peregrine\Portal\image) to the
<WebLogic>\applications directory.

The WebLogic default path is: C: \bea\weblogic8.1\config\<my-domain>

Rename <WebLogic>\applications\image directory to
<WebLogic>\applications\oaa.

Tip: If you need to FTP files from one server to another to perform the copy, it

is more convenient to FTP the oaa.war file in <Portal>\oaa.war to your
WebLogic server than to extract the oaa.war files into a
<WebLogic>\applications\oaa directory.

Creating a virtual directory for Get-Answers

To run Get-Answers from IIS, you need to create a virtual directory that maps to
your WebLogic deployment directory.

1

Create the virtual directory in WebLogic and map it to your deployment
directory with the following settings:

Requirement Setting

Create virtual directory <oaa>

Map to physical path <WebLogic>/applications/oaa
Directory access rights Read, Run scripts, Execute

Where <oaa> is the name of the virtual directory you want to use for
Get-Answers. Peregrine recommends oaa as the virtual directory name. You
must replicate the name that you enter as the virtual directory name in your
application server configuration.

For <WebLogic>, enter the path to your WebLogic installation. The default
file pathis: c: /bea/weblogic81l.
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2 Copy, or FTP, the following files to the <jdk_dir>/jre/1ib/endorsed/
directory on the WebLogic server, where <jdk_dir> represents the path to
the JDK home directory.

xercesImpl.jar
xalan.jar
xml-apis.jar
The default path for these files is:

C:/Program Files/Peregrine/Portal/JavaExtensions

Create the endorsed directory if it does not exist in the JDK home directory.

3 Copy the following files from the installation directory
C:\Program Files\Peregrine\Portal\SupportFiles\JavaExtensions

activation.jar
mail.jar
pop3.jar

to the <APP_DEPLOYMENT_DIR>\WEB-INF\1ib directory.

Copying the iisproxy.dll file

These instructions use the WL_HOME/server/bin directory as the default
location for the DLLs.

= Copy the iisproxy.d11 file from the WL_HOME/server/bin directory of your
WebLogic Server installation to a convenient directory that is accessible to
I1S.

Where WL_HOME/server/bin is the top-level directory for the WebLogic
Platform and Server and contains the WebLogic Server installation files.

BEA recommends that this directory also contain the iisproxy.ini file that
you create in Step 5 on page 102 of Configuring the IIS plug-in.
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Configuring the IS plug-in

WebLogic supports two methods of configuring the IIS plug-in:

= proxying by path

= proxying by MIME type

These instructions focus on the proxying by path method. It takes precedence
over proxying by MIME type. For more information about these methods for

configuring the IS plug-in, refer to your BEA WebLogic documentation.

1 Start the Internet Information Service Manager by selecting it from the Start
menu.

2 Place the iisforward.d11 file in the same directory as the iisproxy.d11
file,and add the iisforward.d11 file as a filter service in IIS.

a Open the properties for the Default Web site by right-clicking the Web
site selection in the left panel and selecting Properties.

Note: Substitute the appropriate Website if you do not want to use the Default
Website.

b Select the ISAPI Filters tab and click Add.
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¢ Define the ISAPI filter as shown in the following example.

Default Web Site Properties 2=l

Diirectory Security I HTTP Headers | Custom Errors I Server Extenzions I
‘wieb Site | Operators I Performance  1SAP Filters |H0me Directoryl Documents

Filters installed here are active for thiz \Web site only. Filters are executed in the
order listed below:

Filter Properties |
~ Add... |
Filter Mame: Iiisforward Remove |

Executable: IE:\bea\webIogicS‘I\server\bin\iisforward.dII Edit |
Diseie |
QK | Cancel Help |
QK | Cancel | Apply | Help |

d When you finish, click OK to save the configuration.
3 Register .wlforward as a special file type that iisproxy.d11 handles.

a Inthe Properties panel, select the Home Directory tab, and click
Configuration in the Applications Settings section.
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b Define the Application Mapping as shown in the following example.

4 Application Configuration LI ll
App Mappings | App Options | Process Options | App Debugging I I

[V Cache ISAPI applications

rAppIication Mapping: 1

Add/Edit Application Extension Mapping

Executable:
Extension: IW
Werh
& allVerbs
 Limit to: I

IV Script engine

™ Check that file exists 0K I Cancel Help

I .

QK | Cancel | Apply | Help |

¢  When you finish, click OK to save the configuration.

d Inthe Application configuration window, select the Cache ISAPI
applications option.
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e Click OK to save the configuration.

f Atthe Website properties window, set the Application Protection to
High (isolated).

Default Web Site Properties 2=l

Diirectory Security I HTTP Headers I Custom Errors | Server Extenzions I
‘wieb Site I Operators I Performance I IS4P Filters  Home Directory | Documents
‘wihen connecting to this resource, the content should come from:
& & directory located on this computer
" & share located on another computer
& redirection to a URL

Local Path: c:hinetpubhwnaaroot Browse... |

™ Script source access V' Log visits
vV Bead [V Index this resource
[~ wiite

[ Directary browsing

Application Settings

Application name: IDefauIt Application Femove |
Starting point: <Default Web Site>
Configuration... |
E=ecute Permissions: IScriptS and Executables &
Application Protection: | High [1zolated) j Unilad |
Low (115 Process)
tMedium (Pocled]

ted

ok | Cancel | gw | e |

4 Createtheiisproxy.ini inthe samedirectory wherethe iisproxy.d11is
located.

5 Define the following properties in the iisproxy.ini.

# This file contains the configuration parameters

# for the IIS/WeblLogic plug-in.

WebLogicHost=csx602

# substitute your WebLogic hostname above

WebLogicPort=7001

# substitute your WeblLogic port number above
ConnectTimeoutSecs=20

ConnectRetrySecs=2

WLIOTimeoutSecs=unlimited

W1ForwardPath=/0aa/servilet/archway, /oaa/servlet/oemlicense.0OE
MLicenseServlet,/oaa/answers/attachments/*,/oaa/serviet/rpcro
uter,/oaa/servilet/messagerouter,/oaa/serviet/download/*,/oaa/
attachments/*, /oaa/servlet/upload, /oaa/*.do,/oaa/*.jsp,/oaa/*
.jsv,/oaa/*.jsw,/oaa/j_security_check
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Note: The WLForwardPath parameter is all one line, delimited by commas.

If you need to debug your application, set the Debug=0N parameter in
iisproxy.ini.The system generates a c:\tmp\iisforward.log file that
contains a log of the plug-in’s activity that you can use for debugging purposes.

For more information on the available configuration parameters for the
iisproxy.ini file, refer to your BEA WebLogic documentation.

Restarting the servers

Restart WebLogic and your IIS Web server for the new settings to take effect. The
IIS Admin and World Wide Web Publishing services control the IIS plug-in.

1 Start the WebLogic application server.

2 ForllS, from the Start menu, click Control Panel > Administrative Tools >
Services, then select IIS Admin and World Wide Web Publishing services.

Testing the configuration

After the application and Web servers are properly configured, log on to the
Get-Answers Admin page to configure the settings that are stored in the
Tocal.xml file.

Make sure that the servers and services are started before proceeding.

1 To verify that the WebLogic and IIS servers are properly configured, check
the following URLs.

» http://<server>:7001/0aa/login.jsp for the WebLogic application server
= http://<server>/oaa/login.jsp for the IIS Web server

2 Follow the steps described in Configuring Get-Answers on page 127 to
complete the Get-Answers configuration.

WebLogic 8.1 and Sun ONE

The following instructions configure the WebLogic 8.1 application server with
the Sun ONE 6.1 Web server. You must modify two Sun ONE files, obj . conf and
magnus . conf, found in the <SunONE_Home>/https-<server.domain>/config
directory.
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Important: Before you begin using this procedure, ensure that you have
completed all of the steps for configuring the WebLogic 8.1 server
as described in WebLogic 8.1 on page 89.

To configure WebLogic 8.1 and Sun ONE:

Step 1 Modify the obj. conf file. See Modifying the obj.conf file.

Step 2 Modify the magnus. conf file. See Modifying the magnus.conf file on
page 109.
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Modifying the obj.conf file

For the WebLogic and Sun ONE servers to run the Peregrine Portal, you must
configure the obj . conf file.

To modify the obj.conf file:

Note: These instructions refer to the deployment directory as
<APP_DEPLOYMENT_DIR>.

1 With a text editor, update the original obj . conf file.

Original obj . conf file

Configuring the servers to run Get-Answers | 105



a Add the following lines of code to the original obj . conf file.

Note: When you add these lines, add them to the file in the order shown in the
example obj . conf file.

Note: The PathCheck line entry instructs the Sun ONE server to reject any
request with a URL that contains the path /WEB-INF. Each servlet
application (context) has a special WEB-INF directory. This directory
contains sensitive configurations data and Java classes and must be
hidden from Web users.

b Comment out the following lines of code.
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¢ Add the following new configuration object.

d Verify that the obj . conf you modified matches the following sample in
both content and the order of the lines of code.
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Sample obj . conf after you have made the required modifications

2 Save and close the file.
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Modifying the magnus.conf file

For the WebLogic and Sun ONE servers to run the Peregrine Portal, you must
configure the magnus. conf file.

Note: These instructions refer to the deployment directory as
<APP_DEPLOYMENT_DIR>.

To modify the magnus.conf file:

1 Using a text editor, replace the following line of code in magnus. conf:

with these two lines.

2 Verify your changes.

Original section of the magnus. conf file being modified.

Updated section of the magnus. conf file being modified.

3 Save and close the file.

After you have modifed the obj.conf and the magnus. conf configuration files,
you need to update the Sun ONE configuration on the server.
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To update the Sun ONE configuration:

1 Use Sun One Web Server Administration Server to update the Sun ONE
cofiguration.

2 Restart the Sun One Web server.

3 Restart the WebLogic application server.

4 Verify that the server is running.
http://<servername>/oaa/admin.jsp

5 Log in with username System, keeping the password field blank.

6 If necessary, follow the steps described in Configuring Get-Answers on
page 127.

WebSphere 5.0.2

You must configure your application and Web servers prior to running the
Get-Answers installer.

Assumptions
Before beginning installation, verify that you have the following software.

= WebSphere 5.0.2 using Java version 1.3.1 or later
= Java(™) 2 Runtime Environment, Standard Edition (build 1.3.1)

s Classic VM (build 1.3.1, J2RE 1.4.1 IBM Windows 32 build
cn1411-20031011 (JIT enabled: jitc))

= IBMHTTP Server 1.3.26 or later

Configuring WebSphere 5.0.2

Use the following procedures to configure WebSphere 5.0.2 to run Get-Answers.
Step 1T Run the installer. See Running the installer.

Step 2 Deploy the oaa.war file. See Deploying the oaa.war file.
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Step 3 Copy the jar files. See Copying jar files on page 112.

Step 4 Edit the application settings using the WebSphere Administrative

Console. See Editing the application settings on page 113.

Step 5 Edit the httpd.conf file to add the plug-in modules. See Editing the

httpd.conf file on page 115.

Step 6 For AlX, if you are using ServiceCenter as the back-end, update the path

to the ServiceCenter libraries in the startServer file. See Editing the
startServer file for AIX on page 115.

Step 7 Start the WebSphere Administration server. See Starting the

WebSphere Administration server on page 116.

Step 8 Complete the configuration. See Configuring Get-Answers on page 116.

Running the installer
You must do this on a Windows machine. See Running the installer on page 124.

Deploying the oaa.war file

The oaa.war file creates the directory structure necessary to deploy Get-Answers
to your application server.

To deploy the oaa.war file using the WebSphere Administrative Console:

1

2

Start the WebSphere Administration Server.

Log on to the WebSphere Administrative Console.

Click Applications on the Administrative Console menu.

Click Install New Application.

In the Local path field, browse to the oaa.war file created at installation.

Specify the Context Root, a value such as oaa (the virtual directory name).
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7 Click Next.
This may take several minutes.
8 Accept the default settings and click Next.
9 Click Use Binary Configuration.
10 In the Application Name field, specify a name, such as oaa.
11 Keep all the other settings at their defaults, and click Next.
12 Keep the default settings, and click Next.
13 Keep the default settings, and click Next.
14 Click Finish.
15 Click Save to Master Configuration to save the server configuration.
16 Click Save.
17 Log out of the Administrative Console.

18 Stop the WebSphere Administration Server.

Copying jar files

The installer generates jar files that you must copy to the application server
endorsed directory.

1 Verify that the following files are in the
<APP_DEPLOYMENT_DIR>/WEB-INF/1ib directory, where
<APP_DEPLOYMENT_DIR> is the path to your Get-Answers deployment
directory.

js.jar

jai_core.jar
jai_codec.jar
mlibwrapper_jai.jar
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2

Copy, or FTP, the following files from the installation directory
C:\Program Files\Peregrine\Portal\SupportFiles\JavaExtensions

activation.jar
mail.jar
pop3.jar

to the <APP_DEPLOYMENT_DIR>\WEB-INF\1ib directory.

Copy, or FTP, the following files from the installation directory
C:\Program Files\Peregrine\Portal\SupportFiles\JavaExtensions

jaas.jar

xalan.jar
xercesImpl.jar
xml-apis.jar
oaasecurityproxy.jar
jsse.jar

where C:\Program Files\Peregrine\Portal specifies the location of your
application installation,

to the $JAVA_HOME/jre/1ib/ext directory.
a If necessary, replace any older versions of these files.

b If xm1ParserAPIs.jar exists in the ext directory, delete it.

Editing the application settings
Using the WebSphere Administrative Console, edit the application settings.

To edit the application settings:

1

Start the WebSphere Administration Server.
Log on to the WebSphere Administrative Console.
Click the Enterprise Application link.

Click the Get-Answers link from the list for the application that you just
installed.
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5 Click Web Modules under Related Items.
6 Click the oaa.war link.
7 Change the Classloader Mode to PARENT_LAST.

8 Click OK, click Save, then click Save again under Save to Master
Configuration to save the server configuration.

9 Configure the database library to the application.

s Click Environment > Shared Libraries.
= Inthe main frame, click New.

= Type a name for the library in the Name field, and the full path to
classesl2.jar or db2java.zip in the Classpath field.

»  Click Apply.

= Under Applications, go back to the definition for the OAA Enterprise
Application.

= Click Libraries under Additional Properties.

= Click Add.

= Select the library you defined and click Apply.
= Save the master configuration.

10 To regenerate the plug-ins, click Environment > Update Web Server
Plugin.

= Click OK to update the Web server plugin.
= Wait for confirmation that the plugin is updated.

11 Log out of the Administrative Console.

12 Stop the WebSphere Administration Server.
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Editing the httpd.conf file

Modify the httpd.conf file to add the plug-in modules, an alias for the virtual
directory, and an alias for EOPro.

1 From the IBM HTTP Server configuration /conf/httpd.conf file, add the
plug-in modules.

On Windows:

LoadModule ibm_app_server_http_module
<AppServerPath>\bin\mod_ibm_app_server_http.dl1
WebSpherePluginConfig <AppServerPath>\config\cells\plugin-cfg.xml

On UNIX:

LoadModule ibm_app_server_http_module
<AppServerPath>/bin/mod_ibm_app_server_http.so
WebSpherePluginConfig <AppServerPath>/config/cells/plugin-cfg.xm]l

2 Create analias in httpd. conf for the virtual directory.

Alias /oaa <AppServerPath>/AppServer/installedApps/<hostname>
/oaa_war.ear/oaa.war

Note: The /oaa alias needs to match the Context Root specified in Step 6 on
page 111 of Deploying the oaa.war file.

3 Create an alias for EOPro to <APP_DEPLOYMENT_DIR>/eopro.

Alias /eopro <AppServerPath>/AppServer/installedApps/<hostname>
/oaa_war.ear/oaa.war/eopro

4  Save and close the file.

Restart the IBM HTTP Server.

Editing the startServer file for AIX

When using ServiceCenter as the back-end, the AlX environment requires you to
add the path to the ServiceCenter libraries in the startServer.sh file.

1 Using a text editor, open the startServer. shfile.
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2 Atthetop of the file add a single entry for LIBPATH and set it to the path for
the appropriate ServiceCenter libraries.

For example, when running ServiceCenter 5:

LIBPATH=/WebSphere/AppServer/installedApps/oaa.ear/oaa.war/
WEB-INF/1ib/AIX/ServiceCenter5

When running ServiceCenter 6:

LIBPATH=/WebSphere/AppServer/installedApps/oaa.ear/oaa.war/
WEB-INF/Tib/AIX/ServiceCenter6

Export the completed variable entry using the following command:
export LIBPATH

3 Save and close the file.

Starting the WebSphere Administration server
Start the WebSphere Administration server for the new settings to take effect.

Configuring Get-Answers

To complete the configuration, follow the instructions in Configuring
Get-Answers on page 127.

WebSphere 5.1 and IBM HTTP server

You must configure your application and Web servers prior to running the
Get-Answers installer.

Assumptions
Before beginning installation, verify that you have the following software.

= WebSphere 5.1 using Java version 1.4.1 or later
= Java™ 2 Runtime Environment, Standard Edition (build 1.4.1)

= Classic VM (build 1.4.1, J2RE 1.4.1 IBM Windows 32 build
cn1411-20031011 (JIT enabled: jitc))

s IBMHTTP Server 1.3.26 or later
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Configuring WebSphere 5.1

Use the following procedures to configure WebSphere 5.1 to run Get-Answers.

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Run the installer. See Running the installer on page 117.
Deploy the oaa.war file. See Deploying the oaa.war file on page 117.
Copy the jar files. See Copying jar files on page 118.

Edit the application settings using the WebSphere Administrative
Console. See Editing the application settings on page 119.

Edit the httpd. conf file to add the plug-in modules. See Editing the
httpd.conf file on page 121.

For AlX, if you are using ServiceCenter as the back-end, update the path
to the ServiceCenter libraries in the startServer file. See Editing the

startServer file for AIX on page 122.

Start the WebSphere Administration server. See Starting the
WebSphere Administration server on page 122.

Complete the configuration. See Configuring Get-Answers on page 122.

Running the installer
You must do this on a Windows machine. See Running the installer on page 124.

Deploying the oaa.war file

The oaa.war file creates the directory structure necessary to deploy Get-Answers
to your application server.

To deploy the oaa.war file using the WebSphere Administrative Console:

1 Start the WebSphere Administration Server.

2 Logon to the WebSphere Administrative Console.

3 Click Applications on the Administrative Console menu.

4 Click Install New Application.
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5 Inthe Local path field, browse to the oaa.war file created at installation.
6 Specify the Context Root, a value such as oaa (the virtual directory name).
7  Click Next.
This may take several minutes.
8 Accept the default settings and click Next.
9 C(lick Continue.
10 Click Use Binary Configuration.
11 In the Application Name field, specify a name, such as oaa.
12 Keep all the other settings at their defaults, and click Next.
13 Keep the default settings, and click Next.
14 Keep the default settings, and click Next.
15 Click Finish.
16 Click Save to Master Configuration to save the server configuration.
17 Click Save.
18 Log out of the Administrative Console.

19 Stop the WebSphere Administration Server.

Copying jar files

The installer generates jar files that you must copy to the application server
endorsed directory.

1 Verify that the following files are in the
<APP_DEPLOYMENT_DIR>/WEB-INF/11b directory, where
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<APP_DEPLOYMENT_DIR> is the path to your Get-Answers deployment
directory.

js.jar
jai_core.jar

jai_codec.jar
mlibwrapper_jai.jar

2 Copy, or FTP, the following files from the installation directory
C:\Program Files\Peregrine\Portal\SupportFiles\JavaExtensions

activation.jar
mail.jar
pop3.jar

to the <APP_DEPLOYMENT_DIR>\WEB-INF\1ib directory.

3 Copy, or FTP, the following files from the installation directory
C:/Program Files/Peregrine/Portal/SupportFiles/JavaExtensions

xalan.jar
xercesImpl.jar
xml-apis.jar

where C: /Program Files/Peregrine/Portal specifies the location of your
application installation,

to the $JAVA_HOME/jre/1ib/endorsed directory.
a If necessary, replace any older versions of these files.
b If xm1ParserAPIs.jar exists in the endorsed directory, delete it.

¢ Create the endorsed directory if one does not exist.

Editing the application settings
Using the WebSphere Administrative Console, edit the application settings.

To edit the application settings:

1 Start the WebSphere Administration Server.
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2 Logon to the WebSphere Administrative Console.
3 Click the Enterprise Application link.

4 Click the Get-Answers link from the list for the application that you just
installed.

5 Click Web Modules under Related Items.
6 Click the oaa.war link.
7 Change the Classloader Mode to PARENT_LAST.

8 Click OK, click Save, then click Save again under Save to Master
Configuration to save the server configuration.

9 Configure the database library to the application.

s Click Environment > Shared Libraries.
= Inthe main frame, click New.

= Type a name for the library in the Name field, and the full path to
classesl2.jar or db2java.zip in the Classpath field.

= Click Apply.

= Under Applications, go back to the definition for the OAA Enterprise
Application.

= Click Libraries under Additional Properties.

= Click Add.

= Select the library you defined and click Apply.
= Save the master configuration.

10 To regenerate the plug-ins, click Environment > Update Web Server
Plugin.

= Click OK to update the Web server plugin.
= Wait for confirmation that the plugin is updated.
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11 Log out of the Administrative Console.

12 Stop the WebSphere Administration Server.

Editing the httpd.conf file

Modify the httpd.conf file to add the plug-in modules, an alias for the virtual
directory, and an alias for EOPro.

1 From the IBM HTTP Server configuration /conf/httpd. conf file, add the
plug-in modules.

On Windows:

On UNIX:

2 Create an alias in httpd. conf for the virtual directory.

Note: The /oaa alias needs to match the Context Root specified in Step 6 on
page 118 in Deploying the oaa.war file.

3 Create an alias for EOPro to <APP_DEPLOYMENT_DIR>/eopro.

4 Save and close the file.

5 Restart the IBM HTTP Server.
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Editing the startServer file for AIX

When using ServiceCenter as the back-end, the AIX environment requires you to
add the path to the ServiceCenter libraries in the startServer.sh file.

1 Using a text editor, open the startServer. sh file.

2 Atthetop of the file add a single entry for LIBPATH and set it to the path for
the appropriate ServiceCenter libraries.

For example, when running ServiceCenter 5:

LIBPATH=/WebSphere/AppServer/installedApps/oaa.ear/oaa.war/
WEB-INF/1ib/AIX/ServiceCenter5

When running ServiceCenter 6:

LIBPATH=/WebSphere/AppServer/installedApps/oaa.ear/oaa.war/
WEB-INF/Tib/AIX/ServiceCenter6

Export the completed variable entry using the following command:
export LIBPATH

3 Save and close the file.

Starting the WebSphere Administration server
Start the WebSphere Administration server for the new settings to take effect.

Configuring Get-Answers

To complete the configuration, follow the instructions in Configuring
Get-Answers on page 127.

Specifying a file path to the local.xml file

The default path to the parent directory of the Tocal.xm1 file is
<APP_DEPLOYMENT_DIR>\WEB-INF\.You may specify an alternate directory path
by adding a JVM runtime property to your Get-Answers application through
your application server's administrative interface. Consult your application
server's documentation on adding a JVM runtime property. The property name
is com.peregrine.sharedSettingsDir.
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For example, if your directory path is c: \share\oaa\ (or /usr/share/oaa), you
provide a URl as file:/c:/share/oaa/ (or file:/usr/share/oaa) or a file
system path as c: /share/oaa/ (or /usr/share/oaa).

If no administrative interface exists to perform the change, you can use
command line switch as part of the JVM runtime property command that
executes the Java JVM, as follows:

-Dcom.peregrine.sharedSettingsDir=file:/c:/share/oaa/
or
-Dcom.peregrine.sharedSettingsDir=c:/share/oaa/

Alternately, you can set the path as an initialization parameter to the Archway
servlet. You can do this through the application server's administrative
interface. Consult your application server's documentation on adding a servlet
initialization parameter. The parameter name and value are as described above.

If no administrative interface exists to add the initialization parameter, you can
edit the web. xm1 file in <APP_DEPLOYMENT_DIR>/WEB-INF/ manually to contain
an init-param for the Archway servlet as follows:

<serviet>
<servlet-name>Archway</servlet-name>
<display-name>Archway</display-name>
<description></description>
<servlet-class>com.peregrine.oaa.archway.ArchwayServiet</servlet-class>
<load-on-startup>1</load-on-startup>
<init-param>
<param-name>com.peregrine.sharedSettingsDir</param-name>
<param-value>file:/c:/share/oaa/</param-value>
</init-param>
</serviet>

You have to restart the application server for Get-Answers application after
making any of these.
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Running the installer

Prior to Get-Answers installation, you must install and configure the application
and Web servers for your environment.

To install Get-Answers:
1 Insert the Get-Answers installation CD-ROM into the CD-drive.

If you are installing on a system that has autorun enabled, the CD browser
starts automatically. If autorun is disabled, you can manually start the
installer from the CD.

= Use Windows Explorer to navigate to the CD-ROM directory.
Double-click Autorun.exe.

= Start the Get-Answers installation from the Windows command prompt.
Type D:\>autorun where D identifies the CD-ROM drive. Substitute your
CD-ROM drive identifier.

srowsetieco Peregrine Portal va

Peregrine.com

n intuitive and useful search

Solutions
Training
formation about installing and configuring Peregrine Get-Answers,
Administration Guide
Support

nformation about administration of Get-Answers, The guide incudes
extensive information about Peregrine GA#, the software platform on which
Get-Answers is based, and specific infarmation about the Peregrine Partal.

User Guide

Provides infarmation shout how to use Get-Answers to perform basic and
advanced seeraches, how to authar documents, and how to perform user
assigned tasks within a workflow process.

MNotification Services Quick Start Guide
Provides information about installation, ronfiguration, administration, and the
use of Naotification Services,

€. Peregrine it et

2 Click Install Get-Answers to start the setup wizard.
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8

9

At the Welcome screen, click Next.

Accept the License Agreement and click Next.

Choose your destination directory and click Next.

Confirm the setting of your Java installation and click Next.
Click Install to install Peregrine Portal 4.2.

The command prompt window shows what is being deployed and added.
This may take several minutes.

When the installation is complete, click Finish.

Click Exit Install.

Theinstaller creates the oaa.war and oaadeploy.properties filesinthe Portal
directory. The default location is: C:\Program Files\Peregrine\Portal.

File Purpose

oaa.war Most of the application server configurations require

this file to deploy the application.

oaadeploy.properties Thisfile is useful if you run oaadeploy to recreate the

image directory or when you are installing a patch.
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Installing multiple Peregrine Portal applications

When multiple Peregrine Portal applications, including Get-Answers, are
deployed, all applications must use the same version of OAA. Multiple Peregrine
Portal applications that use different versions of OAA are not supported.

The oaa.war file contains the files that you need for each application. When you
install additional applications, the installer appends the application files you
need to the oaa.war file.

Important: Make sure that you use the same installation directory for each
Peregrine Portal application.

To install multiple Peregrine Portal applications:
1 Back up your Tocal.xm1 file.

2 Use the application server to stop and uninstall existing Peregrine Portal
applications.

For Tomcat, stop Tomcat, then delete the OAA deployment directory and
oaa.war file from Tomcat's directory structure.

For example, if Tomcat 4.1 is your application server, the default path is:
C:/Program Files/Apache Group/Tomcat 4.1/webapps/oaa

3 Runtheinstaller (see page 124) for the application.

4 Usethe application server’'s deployment mechanism to deploy the WAR file
that contains all the applications.

For Tomcat, merely place the WAR file into the webapps directory.
5 Copy the local.xm1 file into the deployment directory’s WEB-INF directory.
6 Use the application server to start the Peregrine Portal.

For Tomcat, start Tomcat.

126 | Get-Answers Installation



Configuring Get-Answers

This section contains information on how to use the Administration function to
configure search engine, the database, and the database values. The settings
are stored in the Tocal.xm]1 file.

To configure Get-Answers:

1

2

Log on to the Peregrine Portal Administration login page (admin.jsp).
From the Administration menu, click Settings.
Click the Get-Answers tab.

Type the host name for the Search Engine Server and number for the Search
Engine Port.

Scroll to the bottom of the tab and click Save.
Click Settings menu on the left.

Click the Rome tab.

Type and verify the following database settings:

= Database Type
= Database URL
= Database Driver Class
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= Database User Name
= Database User Password

Use the following information in completing the database settings.

Oracle

Database Management System Oracle

Database URL jdbc:oracle:thin:@dbserver:dbport:dbservice
Database Driver Class oracle.jdbc.driver.OracleDriver

Database User Name dbuser

Database User Password dbpassword

The dbserver is the computer name or IP address of the database server.
The dbport is the port the db uses (default 1521).

The dbservice is the servicename for the Oracle service (as registered for
tnshames.ora).

The dbuser and dbpassword are set for the database when following the
setup instructions in Chapter 2 of the Get-Answers Installation Guide.

DB2

Database Management System DB2

Database URL jdbc:db2:dbname

Database Driver Class COM.1ibm.db2.jdbc.app.DB2Driver
Database User Name dbuser

Database User Password dbpassword

The dbname, dbuser, and dbpassword are set for the database admin
when following the setup instructions in Chapter 2 of the Get-Answers
Installation Guide.

SQLServer 2000

Database Management System MSSQLServer (Sprinta driver)

Database URL jdbc:inetdae7:dbserver:dbport?database=dbname
Database Driver Class com.inet.tds.TdsDriver

Database User Name dbuser

Database User Password dbpassword
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Database Management System MSSQLServer (Microsoft driver)

Database URL

jdbc:mircrosoft:sqlserver://SERVERNAME: PORT;D
atabaseName=DATABASE;SelectMethod=cursor

Database Driver Class com.microsoft.jdbc.sqlserver.SQLServerDriver

The dbserver is the computer name or IP address of the database server.

The dbport is the port the database uses (default 1433).

The dbname, dbuser, and dbpassword are set for the database admin
when following the setup instructions in Chapter 2 of the Get-Answers
Installation Guide.

9 If the back-end database is:

Database

Action

DB2

SQLServer

Oracle

Copy the db2java. zip file to the
<APP_DEPLOYMENT_DIR>/WEB-INF/1ib directory and rename it
todb2java.jar.

Copythe msbase.jar, mssqlserver.jar, msutil.jarfiles
to the <APP_DEPLOYMENT_DIR>/WEB-INF/11ib directory

or

Copy the Sprinta. jar file to the
<APP_DEPLOYMENT_DIR>/WEB-INF/Tib directory.

Copy the classes12.zip file to the

<APP_DEPLOYMENT_DIR>/WEB-INF/Tib directoryand
renameitto classesl2.jar.

10 Click Save.

11 Click the Settings menu on the left.

12 Click the Common tab.
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GerAnswers
=
13 Set the Server URL to the URL you opened after starting your application
server (Tomcat, WebLogic, Websphere), replacing admin. jsp with
Togin.jsp?_bookmark=.

example:

http://<application_server_hostname:<port>/<Context
Root>/login.jsp?_bookmark=

Substitute your port number in the URL.
14 Ensure that the Common Backend is set to rome.
15 Ensure that the Event queue is set to rome.
16 Click Save.
17 From the Administration menu, click Control Panel.

18 Click Reset Peregrine Portal.
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Uninstalling Get-Answers from Windows

Use the Windows Add or Remove Programs option from the Control Panel to
remove Get-Answers.

To uninstall Get-Answers:
1 From the Windows Control Panel, select Add or Remove Programs.
2 Scroll to Peregrine Portal 4.2 and click Remove.
3 Click Yes when asked to remove Peregrine Portal 4.2 from your computer.
4 From Windows Explorer, navigate to the installation files.
The default path is: C: /Program Files/Peregrine/Portal.
5 Delete the Portal directory and its contents.

6 From your application server, remove the deployment directory and its
contents.
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CHAPTER

Completing the Installation

This chapter describes the initial configuration steps you need to complete
before you can begin using Get-Answers.

Step 1 Setting up the database driver. See page 133.

Step 2 Accessing the Peregrine Portal Admin module. See page 134.

Step 3 Configuring the adapters. See page 140.

Step 4 Setting up the search engine. See page 150.

Step 5 Verify the Get-Answers installtion. See page 154.

Once you have complete these steps you should be able to use Get-Answers.

Refer to the Get-Answers Administration Guide for additional information
regarding administering Get-Answers.

Setting up the database driver

After you have installed Get-Answers, you need to copy the appropriate JDBC
driver files to <OAA_DEPLOYMENT_DIR>\WEB-INF\lib\. This section identifies
the files you need to copy to this directory for each of the databases
Get-Answers supports.
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Oracle

If you are using an Oracle database, you need to create a copy of
classes12.zip,renamethe copytoclassesl2.jar,then move classesl2.jar
to <OAA_DEPLOYMENT_DIR>\WEB-INF\T1ib\.

DB2

If you are using a DB2 database, you need to create a copy of db2java.zip,
rename the copy to db2java. jar, then move to
<OAA_DEPLOYMENT_DIR>\WEB-INF\1ib\.

SQL Server 2000

If you are using an SQL Server 2000 database with the Microsoft SQL Server 2000
driver copy the following files to <OAA_DEPLOYMENT_DIR>\WEB-INF\lib\

= msbase.jar
= mssqglserver.jar
= msutil.jar

If you are using an SQL Server 2000 database with the Sprinta driver copy
Sprinta.jar to <OAA_DEPLOYMENT_DIR>\WEB-INF\lib\.

Accessing the Peregrine Portal Admin module

The Peregrine Portal administrator login page accesses the Peregrine Portal
Admin module. You use the Admin module to define the settings for your
Peregrine system.

A default administrator, System, gives you access to the Admin module without
being connected to a back-end system. After you configure your user name on
the Common tab, you can also access the Admin module from the Navigation
menu.

Important: When you change parameters using the Admin module, a
Tocal.xm1 file is created in the \<appsrv>\WEB-INF directory to
store these parameters. If you reinstall Get-Answers, make a copy of
this file and store it outside your Get-Answers installation. Failure to
do this will result in your parameter values being lost during the
new installation.
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To access the Peregrine Portal administrator login page:

1 Verify that your application server (for example, Tomcat) is running.

2 Inyour Web browser Address field, type:
<hostname>/oaa/admin.jsp

3 Click Go to open the Portal administrator login page.

4 =10l x|
File Edt View Favorites Tools Help ‘ i
@Back - O = D @ <h ‘ pSEarEh *Favw\tes AP vedia | B- ; < 2 J @ H Ssnaglt 12 JLms >
Adress [{€] hetpsflocalhost oaa/admin = &

N
- T e e
( Peregl'lne E“ Evolve Wisely™
SYSTEMS. 2

Login

System Maintenance Login

* login Please provide your system maintenance user name and password,

User Name: |
Password:

System Mairtenance lagin

&] Dane [ [ [sdiocalintranet v
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4 In the Name field, type System.
No password is required on initial login. Refer to the Get-Answers
Administration Guide for detailed instructions on how to change the

Administrator login name and password.

5 Click System Maintenance login to open the Control Panel page.

Administration

Control Panel

+ Admin Hers is 5 list of the adapters currently registered in this server. If nscessary, you may alsa resst the Persgrine Partal

ol oot and its adapter connections.

Deploved Yersions
Connaction Status

Server Log

farget _________Jadapter _______________________________________ [taws_______]
Settings GICammonDE com peregrine oas.adapter sc,SCAdapter connscted
Show Seript Status portalDEs com peregrine.oaa.adapter.sc.SCAdapter connected

s com peregrine.oas.adapter.sc.SCAdapter connected
mail com peregrine.oas adapter.mail Mailadapter discannected
weblication com peregrine.oas adapter.sc.SCAdapter connected

Show Message Queues
Show Queue Status

Adapter
Transactions/Minute
e
1M Websphere Portal
local.xml File localhost o 0 o 1
Page Hits per Minute
[rorverame Tt [rie  Jomme e ]
localhast 1] 0 1 11
Reset Peregrine Portal

The left pane Activity menu provides access to a number of different
administrative utilities for Get-Answers. You need to access some of these
during this installation process. The utilities and their functions are described in
detail in the Get-Answers Administration Guide.

Using the Control Panel

Use the Control Panel page to check the status of the connections to the
databases you are accessing with Get-Answers and your Web applications. You
can also reset the connection between the Archway servlet and the adapters to
the back-end systems.

Note: When you first access the Control Panel page, the status for all target

adapters is “Disconnected.” The status changes after you define target
adapters, as described later in this section.

136 | Completing the Installation



All changes involving the Control Panel require the following steps.
Step 1 Login to the Admin page with the username System.

Step 2 Go to the Settings page.

Step 3 Make your changes.

Step 4 Reset the portal server.

Accessing the Peregrine Portal Admin module | 137



Get AT S
Using the Settings page

From the Admin module Activity menu, click Settings to open the current
parameter settings. The Settings page is divided into tabs. The tabs that you see
depend on the Web applications that you installed and the adapters that you
use. The Common tab is available for all installations.

To open the Settings page:

1 From the Admin module, click Settings.

You use the tabs to configure settings for Get-Answers.

By default, the Common settings page opens.

L E-rnail | Get-Answers | Get-Answers Portal | Logging | MotificationDB | Motification Services | Portal | Portal DB
rome | Thermes | Web Application | Workflow DB | Workflow Engine | XSL

Maxirmurn attached file size (in KB]): The size limit, in KB, of files that may be submitted as attachments,

Ib value of 0 indicates that no limit is set. Thiz setting iz a default that
can be overridden by individual attachrent fields,

Cornmon Backend: Adapter target nare used to support cornmon user operations,

Irome Click far default: [partallB]

List of target aliases: Specifies a list of semicolon delimited target aliases used by web

Iweblication;mail applications in this package,

Systermn Maintenance username: The systermn maintenance usernarne, Thiz login provides access to

ISl,lstem administrative functionality, The systern maintenance user is

independent of any deployed adapter(s), Use this login to configure
newly installed systern or to troubleshoot an existing install,

Systern Maintenance password: The system rmaintenance password,

Application path: Directary location of the Peregrine Portal Web Applications,
|WEB-INFf apps/

Event queuse: Enter the name of the adapter that should be used by the Peregrine
Irome Portal event queue engine, For exarmple:

* To use ServiceCenter's repositary, enter "sc"
® To use AssetCenter's repository, enter "ac"

Click far default: [partallB]

2 Click the appropriate tab to change setting parameters.
When you change the parameter default value for any setting and save it,
the corresponding description column adds a link with the default value
listed in brackets so that you can return to the default at any time.

To revert to the default setting:

1 Navigate to the appropriate setting parameter.
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2 From the description column next to the changed parameter, select the
Click for default link.

Personalization

End user personalization: The level of personalization access granted to end
Enabled = users:

» Enabled - Full end user access to personalize
SCreens.

» Disabled - Disable personalization for non
admin end users,

® Limited - Mon admin end users limited to
move or remove existing fields,

( Click for defsult: [Limited] )

3 Toreturn to the default setting, click Click for default: [Limited] and click
Save.

The parameter returns to the default state.

Resetting the server

After making any configuration changes in the Peregrine Portal Administration
modaule, the following informational message appears at the top of the page.

The settings have been saved. To ensure all changes take effect,
you must reset the Peregrine Portal server.

Return to the Control Panel to reset the server and apply your configuration
changes to Get-Answers.

To reset the connection between the Archway servlet and back-end system:
1 From Control Panel, click Reset Peregrine Portal.

When the operation is complete, the following message indicates that the
connections are reset.

The Peregrine Portal and its Adapter connections have been
successfully reset. If you have deployed in a clustered
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environment all web application instances must be reset to
ensure consistent application of the new configuration.

2 Verify your changes in the Connection Status table.

Changes include the addition, removal, or connectivity of the target
adapters.

Configuring adapter connections

This section describes how to configure and verify the following settings.
KMGAAdapter

Portal DB adapter
Web Application database adapter

Connection settings

This section describes how to configure and verify settings.
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To define common settings for Get-Answers:
1 From the Peregrine Portal Admin module, click Settings.

This displays the Settings page which provides access to the various tabs
that configure settings for Get-Answers.

The Common settings page opens by default.

Cormrno E-rnail | Set-Answers | Get-Answers Portal | Logaing | HotificationDB | Motification Services | Portal | Portal DB
rome | Thernes | Web Applicstion | Workflow DB | Workflow Engine | ®SL

Maxirmum attached file zize (in KB): The size limit, in KB, of files that rnay be subritted 2z attachments, A

Ib walue of 0 indicates that no limit is set. This setting is a default that
can be overridden by individual attachment fialds.

Common Backend: Adapter target name used to support common user operations,

Imme Click for default: [portalDB

List of target aliazes: Specifies a list of semicolon delimited target aliases used by web

[weblication;mail spplications in this package.

Systern Maintenance username: The systern maintenance username, This login provides access to

ISystem administrative functionality, The system maintenance user is

independent of any deployed adapter(s). Use this login to configure a
newly installed systern or to troubleshaat an existing install,

Systern Maintenance password: The systern maintenance password,

Application path: Directory location of the Peregrine Paortal web Applications,
|wER-INF/ apps/

Event queue: Enter the name of the adapter that should be used by the Peregrine
Imme Portal event queues engine, For example:

® To use ServiceCenter's repository, enter "sc"
® To use AssetCenter's repository, enter "ac"

Click for default: [portalDe

2 Update the fields as required.
The Common tab includes the following settings.

Language Translation
Personalization

Attachments

Server-Side Scripts

Encoding, Locales, and Sessions
Performance Tuning
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Tip: You can reload forms without having to reset your Peregrine OAA server.
Set the Reload Forms option to Yes under Performance Tuning. This works
best in a production environment.

:_le"grma“;e T_t““i;‘i | Set the Reload Forms option to

e ange onitor Ilnterval: .

o Yes to aut_oma’glcally reload
the forms if their sources are

modified after the server

Reload Forms:
| # ves Cno started.

3 Click Save.

4  Click Control Panel > Reset Peregrine Portal to apply your changes to the
system.

Checking the status of the KMGAAdapter

The KMGAAdapter connects the Web server to the Search Engine search server.

Perform the following steps on the Web server.

Important: You cannot do this procedure until you index the documents. See
Reindexing the sample documents in the Troubleshooting chapter.

1 From the Peregrine Portal Admin module, click Settings.
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2 Verify the line on the next screen containing a reference to oaakm and
com.peregrine.oaa.adapterKMGAAdapter reads connected.

Connection Status

notification DB com. peregrine, oaa, adapter.bizdoc BizDocAdapter connected
portalbe corm. peregrine, oaa, adapter.bizdoc BizDocAdapter connected
mail com.peregrine.oaa. adapter.mail. Mailadapter connected
rome com.peregrine.oaa. adapter.bizdoc BizDocAdapter connected

HeflowDB r.peregrine.aaa adapter hizdac BizD dapter nnected

( caakm com.peregrine. oaa. adapter. kr, KMGAAdapter connected )
wehlication cor.peregrine.oaa. adapter. bizdoc BizDocAdapter connected
3 Logout.

Cormmrnon | E-rnail | Get-Answers | Get-Answers Portal | Logging | MotificationDB | Motification Services | Portal [aias )
Themes | Web Application | Workflow DB | Workflow Engine | RSL

Default capabilities:

rome

Semicolon separated list of default access rights that all users should
[partalbe(g=tit, partal) have regardless of their profile. Access rights are assigned to target
adapters in the following way: portalDB[getit. portal)

#lias far: Specifies the target configuration for which this target is an aliss.
|ramne glick for default: [1
Save

4 In the Alias for field type rome, then click Save.

Note: You must manually set this field.

5 Click Control Panel > Reset Peregrine Portal to apply your changes to the
system.

6 When the operation completes, verify that the adapter for the portalDB
target is com.peregrine.oaa.adapter.bizdoc.BizDocAdapter and
displays Connected in the Connection Status table.

Important: If you specify one alias and subsequently change that alias, you lose
the personalizations of your portal application screens.

Setting the Web Application database adapter

Get-Answers requires a database adapter connection to store settings and
customizations to the Web application’s interface screens. Until a database

adapter is defined for the Web application, users cannot make personalization
changes to the Web application.
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To configure Get-Answers to save personalization to the Web application:
1 From the Peregrine Portal Admin module, click Settings.

2 Atthe top of the Settings page, click the Web Application tab to open the
Web Application settings page.

Cormmon | E-rmail | Get-Answers | Get-Answers Portal | Logging | MotificationDB | Motification Services | Portal
rome | Thermes | Web Application | Workflow DB | Workflow Engine | XSL

Default capabilities: Semicolon separated list of default access rights that all

IbortalDB(getit.portal) users should have regardless of their profile, Access rights
are assigned to target adapters in the following way:
portalDB(getit. partal)

Alias for: Specifies the target configuration for which this target iz an

Irome aliaz,

Click for default:

Save

3 Inthe Alias for field type rome, then click Save.
Note: You must manually set this field.

4 Click Control Panel > Reset Peregrine Portal to apply your changes to the
system.

5 When the operation completes, verify that the adapter for the weblication
target is com.peregrine.oaa.adapter.bizdoc.BizDocAdapter and
displays Connected in the Connection Status table.

Important: If you specify one alias and subsequently change that alias, you lose
personalizations made to forms.

The installation is complete. For information on using Get-Answers, see the
Get-Answers User Guide and the Get-Answers Administration Guide.

Updating Admin module settings

After connecting to the OAA Admin module at
(http://<localhost>/oaa/admin.jsp) you can log on to Get-Answers Admin
module from the System Maintenance page. In the OAA Administration module
you can update the settings.
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Common tab settings

To update the Admin settings:

1

Use a browser to connect to http://<localhost>/oaa/admin.jsp

The System Maintenance Login page opens.

Please provide your system maintenance user name and password.

User Nama:

1
1

System Maintenanes login

Password:

Log on as user System with no password.
Click System Maintenance.

Click Settings in the Activity menu.

The Admin Settings page opens.

- 4
+ Rome Admin E-mail | Get-Answers | Get-Answers Portal | Lagging | MotificationDB | Notification Services | Portal | Portal DB =

| Rome | Themes | web application | workflow De | warkflaw Engine | xsL |

Table Creation

The sizs limit, in KB, of files that may be submitted as attachments.
A walue of 0 indicates that no limit is set, This setting is a default
that can be owerridden by individual attachment fields

Adapter target name used to support commen user operations.

Maximum sttached file size (in KB):

Control Panel
Deploved Wersions

Commen Backend:

Server Log [rome | Click for defsult: [oartalDB
u Settings

Specifies a list of semicolon delimited target aliases used by web
applications in this package.

List of target aliases:
[

Show Script Status
[ mail

Show Message Queues
Show Queue Status

adapter
Transactions/Minute
1BM Websphere Portal
Intearation

local.xml File

The system maintenance username. This login provides access ta
administrative functionality, The system maintenance user is
independent of any deployed adapter(s). Use this login to configure
a newly installed system or to troubleshoot an existing install.

The system maintenance password.

System Maintenance username:
|system

System Maintenance password:

application path:
| WEB-IMF/apps/

Directory location of the Peregrine Portal Web Applications.

Event queus: Enter the name of the adapter that should be used by the Peregrine
[rome | Partal event queue engine. For example:

* Touse ServiceCenter's repositary, enter "sc*

® Touse AssetCenter's repository, enter "ac”

<

5 Onthe Common tab:

= Inthe Common Backend text box, type rome.
= In the Event queue text box, type rome.
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= Inthe Server URL text box, change
http://<localhost>/0aa/login.jsp?_bookmark=

to
http://<actual_server_name>:<port>/o0aa/login.jsp?_bookmark=

fillinginthe actual_server_name with your application server name and,
you must add the port number <port>, if you install on a port other than
80.

6 Click Save.

7 Onthefollowing tabs, type rome (or the alias you are using, such as ac or sc)
in the Alias for text box.

Portal DB
Web Application

Workflow DB
NotificationDB

8 C(lick Save.

9 Onthe Web Application tab in the Alias for text box, type rome.
10 Click Save.

11 Click the Control Panel link on the Activity menu.

12 Click Reset Peregrine Portal.

Rome tab setting for the database parameters

This section describes the parameters you need to set on the database you are
using with Get-Answers. You can set or verify these parameters on the Rome tab
of the Admin Settings page.

To update the database parameters on the Rome tab:

1 Onthe Admin Settings page click the Rome tab.
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2 Scroll to the section that displays the following parameters:

Database Management System
Database URL

Database Driver Class
Database User Name

Database User Password

Use the parameters identified below.

3 Click Save.

Setting the Oracle parameters

Database URL: jdbc:oracle:thin:@dbserver:dbport:dbservice
Database Driver Class: oracle.jdbc.driver.OracleDriver
Database User Name: dbuser

Database User Password: dbpassword

The dbserver is the computer name or IP address of the database server. The
dbport is the port the db uses (default 1521). The dbservice is the servicename
for the Oracle service (as registered for tnsnames.ora). The dbuser and
dbpassword are set for the database when following the setup instructions in
Chapter 2 of the Get-Answers Installation Guide and should be available on the
Get-Answers Installation worksheet.

Setting the DB2 parameters

Database URL: jdbc:db2:dbname

Database Driver Class: COM.ibm.db2.jdbc.app.DB2Driver
Database User Name: dbuser

Database User Password: dbpassword

The dbname, dbuser, and dbpassword are set for the database admin when
following the setup instructions in Chapter 2 of the Get-Answers Installation

Guide.

Setting the Mircosoft SQL Server 2000 parameters

Note: These settings depend upon which driver you are using.
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Use the following settings for the Sprinta driver.

= Database URL jdbc:inetdae7:dbserver:dbport?database=dbname
= Database Driver Class com.inet.tds.TdsDriver
= Database User Name dbuser

= Database User Password dbpassword
Use the following settings for the Microsoft driver.

= Database URL

jdbc:mircrosoft:sqlserver://SERVERNAME:PORT;DatabaseName=DATAB
ASE;SelectMethod=cursor

= Database Driver Class com.microsoft.jdbc.sqlserver.SQLServerDriver
= Database User Name dbuser

= Database User Password dbpassword

The dbserver is the computer name or IP address of the database server. The
dbport is the port the database uses (default 1433). The dbname, dbuser, and
dbpassword are set for the database admin when following the setup
instructions in Chapter 2 of the Get-Answers Installation Guide.

Updating the Get-Answers tab

This section describes the parameters you need to set for Get-Answers. You can
set or verify these parameters on the Get-Answers tab of the Admin Settings
page.

To update the search engine parameters on the Get-Answers tab:

1 Onthe Admin Settings page, click the Get-Answers tab.
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2 Set the following parameters:

= Search Engine Server: type the host name of the Search Engine server.

= Search Engine Port: type the port number that the Search Engine server
listens on.

Use the host name and port number that you used in the section Installing
the Search Engine on the Search Engine server in Chapter 2 of the

Get-Answers Installation Guide.

3 Click Save.

Resetting the server

After you update the parameters on the Admin Settings page, you need to reset
the server.

To reset the server:
1 Click Control Panel in the Activity menu on the Administration tab.
The Control Panel page opens.

Home [WERLEVECERE Get-answers | People | Uorkflows

Control Panel

+ Rome Admin ' Hers is & lst of the adapters currently registered in this server, If necessary, you may also reset the Peregrine Portal and its adapter
Table Creation connections.
+ Admin
= control Panel Connection Status
o gt [adapter
Deploved Versians n DB cam perearing 02a.adapter.bizdor.BizDochdapter w
Server Log portalDB com.peregrine.nas.adapter.bizdoc.BizDocAdapter
Settings mail com.peregrine.0aa.adapter.mail MailAdapter disconnected
Show Seript Status rome com.peregrine.0aa.adapter.bizdoc.BizDocAdapter Tonnectsd
oaaworkflowDe com peregrine.naa.adapter.bizdoc.BizDocAdapter connected
show Messags Queuss | o0 com peregrine 0aa.adapter.km KMGAAdapter connected
Show Queue Status wehlication com peregrine.naa.adapter.hizdac.BizDocAdapter connectsd
Import / Export
Adapter Active User Sessions
1BM Websphere Portal localhiost 1 1 1 2
Integration
local.xml File Page Hits per Minute
< Notification Services fservertame ____Jlactrin_______JsMinAve._________[2oMin.Avg._________[poak ]
Administration localhost ] ] 0 16

Plug-in Status
Plug-in Registry
Motification Types
Render Types
Templates

Default Work Hours

Reset Feregrine Fortal

Data Import
Redeliver Notifications %
| =

=
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2 Verify the connection status before you create the tables.

3 Click Reset Peregrine Portal.

Table creation

Follow these steps to create the required tables in the database.
To create tables:

1 Click Table Creation on the Activity menu in the Rome Activity section of
the menu.

2 C(lick Create Tables.
3 Verify the process completes without any error messages appearing.

4  Stop and start the application server.

Setting up and starting the search engine

This section explains how to setup the search engine server you installed as
described in Chapter 2, Setting Up the Get-Answers Servers.

Setting up the search engine server as an NT service

On Windows NT systems, you can run the Search Engine server as an NT service.
To run the Search Engine server as an NT service:

Note: If you do not run the Search Engine server a service, always make sure the
Search Engine is running before you start Tomcat.

1 From the Start menu, choose Programs > Get-Answers Search Engine >
Services Console.

2 Inthe RetrievalWare Services Console window, select the Service menu and
click New Service.
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3

In the RetrievalWare Services Console, choose RetrievalWare Executive and
click OK.

# RetievalWare Services Console

Serice View Help
x| =) |-
Hame [ Statss [ Service D[ Info
Fietrizvahtfare Exsculive [new) Mot conligured  Execd? [neve ey - properties not yet miliaized)
4] J i
For Help. press F1 [ NUM v

In the Services Console the status of the new service is “Not configured.”
4  Click the new service to select it. Then click Service > Properties.

The RetrievalWare Executive Properties dialog box is displayed.

Retrievalware Executive Properties

Senice | Reievatvare |

Service Propestes
Run zervice as thiz NT account [Domanuzer);

Pazzword:
||'Dstname\.l‘-\drrinisllalm

l

I¥ Launch Execulive sevice sutomaticall on sta

File Name for Eree Log: Browse,
|I::\W[NN ThSystem32\LagFiles\Exacdlag
oot |

5 On the Service tab, make the following entries and selection:

= IntheRun service as this NT account (Domain\user) text box, type a valid
domain\username combination for an administrator account. The
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account must have the rights to log on as a service, and have a valid login
name and password for the Search Engine server.

Example: administrator\password
= Select the Launch Executive Service Automatically on Startup check box.
6 On the RetrievalWare tab, perform the following:

= Inthe Port address box, type the correct port number.

You entered this information on the Get-Answers installation worksheet
on page 23. If the default port number is not the number you see when
you start your search engine manually, change the port number. For
example, if your Get-Answers Search Engine Executive window displays
the message: 'Execd v7.0 started on port 6003', then change the port
number to 6003.

= Click the Browse button. Locate the exec.cfg file underthe \config
folder.

Example: C:\getanswers\Peregrine\config\exec.cfg
No entry is required in the Remote Name Server Address section.

Note: To confirm the correct port number, click Start > Programs >
GetAnswersSearchEngine > Start Search Engine Server.

7 Click OK.
8 Inthe Service Console window, the Executive service status is now
“Stopped.” To start the service, select the Executive service and click Service

> Start Service.

A message confirms that the service is being started, and the status in the
Service Console window changes to “Running.”

Note: If the service will not start, close the Search Engine Services Console. Open
the NT or Windows 2000 Services; double-click the RetrievalWare
Executive service to open it; change the permissions under the Log On
tab; and then start the service.

9 Close the RetrievalWare Services Console window.
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Setting up the Web crawler

The following section describes how you set up the Web crawling feature (also
called the spider feature) in Get-Answers. The Get-Answers Search Engine must
be installed before you can configure Web crawling.

Note: The Get-Answers Search Engine directory is installed in

$USER_INSTALL_DIRS$, under C:\getanswers by default.

To setup the Web crawler:

1

To initialize the Spider Database, run the DBSETUP. BAT file found in
<$USER_INSTALL_DIR$>\spider\bin.

A command prompt/log opens with the setup processes taking place.
In the start.1st file found in
$USER_INSTALL_DIR$\spider\KMSpider\config, add the URLs (one per

line) where you want to “crawl” for documents. For example:

http://www.peregrine.com

Note: See the chapter “Setting up Get-Answers” in the Get-Answers

Administration Guide for a detailed description of configuring the Web
crawler.

Starting the search engine

To start the search engine:

1

On the server console for the search engine server, click Programs >
Get-AnswersSearchEngine4.2 > Start Search Engine Server.

A command window opens.
Press any key to continue. This starts the search engine.

Restart the application server.
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Verify the Get-Answers installation

The following instructions describe how to verify the Get-Answers installation.
To verify the Get-Answers installation:

1 Log off Admin module (http.//<localhost>/oaa/admin.jsp).

2 Log on to Get-Answers (http://<localhost>/oaa/login.jsp) as suser.

3 Contribute Doc (authored).

4 Publish from Workflow.

5 Browse to Doc.

6 After five minutes, search for keywords.
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Upgrading Get-Answers on
cnaeren - Application Servers

The installation program no longer deploys files directly into an application
server’s directory structure. Instead, files are deployed into a staging area on the
file system. This staging area functions as a common place into which one or
more Peregrine Portal applications are deployed. From these deployed files, the
installation program builds a WAR file and terminates.

Important: After the installation program executes, you must perform
additional steps to complete the upgrade process.

You must backup any customizations from previous versions and backup
certain configuration files, then uninstall the existing Peregrine Portal
application from the application server using the application server’s uninstall
mechanism.

You then merge the backed up customizations and configuration files with the
application files in the staging area, and re-create the WAR file. With the WAR
file, use the application server’s deployment process to install the upgraded
Peregrine Portal application. This process of modifying files in the staging area,
then generating the WAR file, is a best practice for customizations and future
upgrades.

This WAR file distribution complies with the J2EE application deployment
process and enables one WAR file, containing the Peregrine Portal
application(s), to be conveniently deployed into separate test and production
environments.

Once installed and running in the application server, an administrator can then
access the Get-Answers Administration page to complete the setup.
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Upgrading Get-Answers on Tomcat 4.1.x and 5.0.x

If you are upgrading from Get-Answers 4.1.x to Get-Answers 4.2, complete the
following steps.

Step 1 Backup the Tlocal.xm1 file and any customizations from your current
installation of Get-Answers. See page 156.

Step 2 Uninstall Get-Answers from Tomcat. See page 157.
Step 3 Run the Get-Answers installer. See page 157.

Step 4 Apply the backed up Tocal.xm1 file and customizations to the staging
area created by the installer. See page 157.

Step 5 Generate the WAR file from the files in the staging area. See page 158.

Step 6 Copy, or FTP, the WAR file to the Tomcat server machine, into the
Tomcat's webapps directory. See page 158.

Step 7 Verify XML parser files are the same version as those from the installer.
See page 158.

Step 8 Start Tomcat and complete the Get-Answers upgrade, then verify and
complete the configuration. See page 159.

Backing up the local.xml file and any customizations

Before you make changes to any files, create a backup copy.
1 Backup the Tocal.xm1 file. The default location is:

<tomcat_home>webapps\oaa\WEB-INF\1ocal.xm]l

where <tomcat_home> is the root directory in which Tomcat is installed.

2 Backup any schema extensions and any customization of themes created
for the existing version. First read Completing the Get-Answers upgrade on
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page 170 to familiarize yourself with how certain customizations will be
performed later.

Follow the steps in Get-Answers pre-upgrade procedure on page 167.

Uninstalling Get-Answers from Tomcat

Prior to uninstalling Get-Answers, make note of the OAA application directory
name.

1

3

4

Note the name of the OAA application directory installed in
<tomcat_home>\webapps. The default is oaa, such as
<tomcat_home>\webapps\oaa. You will need to give the WAR file you will
later generate the same name.

Stop Tomcat.

Delete the above application directory.

Delete any OAA WAR file existing in <tomcat_home>\webapps, like oaa.war.

Running the Get-Answers Installer

Follow the instructions in Running the installer on page 67.

Applying backed up files to the staging area

The installation program deploys files into a staging area where one or more
Peregrine Portal applications are deployed. Back up the following files to this
staging area.

1

Copy the backed up Tocal.xm1 file into the
<install_dir>\1image\WEB-INF directory where <install_dir>is the
directory in which you directed the installer to deploy its files. The default is
C:\Program Files\Peregrine\Portal.

Apply your backed up customizations to the files in the
<install_dir>\1image directory.
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Generating the WAR file

The following steps generate a WAR file.

1 From the command prompt, change your current working directory to
c:\Program Files\Peregrine\Portal\image.

2 From the command line, type:
"<Java-path>\bin\jar.exe cvf <directory-where-war-file-will-be>\oaa.war ."

where <Java-Path> is the path to your Java installation.
Important: The command must contain the period after following oaa.war.
3 Press Enter.

Important: Name the WAR file the same name you noted in Step 1 on page 157
of Uninstalling Get-Answers from Tomcat. For example, if the
directory name was myQOaa, name the WAR file myOaa.war.

Copying the WAR file to the Tomcat server machine

Copy, or FTP, the WAR file you just generated into the <tomcat_home>\webapps
directory.

Verifying XML parser files

Make sure that you have the correct version of the JAR files.

1 If the Java JDK Tomcat is using version 1.3.X, follow the instructions in
Copying the jar files on page 7 to copy the latest version of the XML parser
files. However, instead of the destination directory of
<tomcat_home>\common\endorsed, use <java_home>\jre\Tib\ext.

where <java_home> is the root directory of the Java JDK that Tomcat is
using.

2 Ifthe Java JDK Tomcat is using version 1.4.X, follow the instructions in

Copying the jar files on page 7 to copy the latest version of the XML parser
files.
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Starting Tomcat and upgrading Get-Answers

You must start the application server to deploy the WAR file.
1 Start Tomcat to have it automatically deploy the upgraded WAR file.
2 Follow the steps in Completing the Get-Answers upgrade on page 170.

3 Follow the steps in Configuring Get-Answers on page 71 to configure the
Get-Answers Admin settings.

Upgrading Get-Answers on WebLogic 6.1 and 8.1

If you are upgrading from Get-Answers 4.1.x to Get-Answers 4.2, complete the
following steps.

Step 1 Backup the local.xml file and any customizations from your current
installation of Get-Answers. See page 160.

Step 2 Uninstall Get-Answers from WebLogic 8.1. See page 160.
Step 3 Run the Get-Answers installer. See page 160.

Step 4 Apply the backed up Tocal.xm1 file and customizations to the staging
area created by the installer. See page 161.

Step 5 Generate the WAR file from the files in the staging area. See page 161.

Step 6 Copy, or FTP, the WAR file to the WebLogic server machine, into the
WebLogic’s webapps directory. See page 161.

Step 7 Verify WebLogic has the latest XML parser files. See page 162.
Step 8 Deploy the WAR file to the WebLogic server. See page 162.
Step 9 Verify and complete the configuration. See page 162.

Step 10 Complete the Get-Answers upgrade. See page 162.
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Backing up the local.xml file and any customizations

Before you make changes to any files, create a backup copy.

1 Backup the configuration Tocal.xm1andweb.xm1 files. The defaultlocation
for the Tocal.xm1 file is

<APP_DEPLOYMENT_DIRECTORY>/WEB-INF/Tocal.xm]l

where <APP_DEPLOYMENT_DIRECTORY> is the deployment directory of the
Peregrine Portal within the WebLogic Server. For example:
app\peregrine\applications\oaa

2 Backup any schema extensions and any customization of themes created
for the existing version. First read Completing the Get-Answers upgrade on
page 170 to familiarize yourself with how certain customizations will be
performed later.

3 Follow the steps in Get-Answers pre-upgrade procedure on page 167 that
are applicable to the WebLogic server.

Uninstalling Get-Answers from WebLogic

Prior to uninstalling Get-Answers, make note of the Web Module name.
1 Stop WebLogic.

2 Note the name of the Web Module installed. You will need to redeploy
Get-Answers using the same Web Module later.

3 Delete the Web Application Module using the WebLogic User Interface (Ul).

4 Delete OAA files from the file system.

Running the Get-Answers Installer

Follow the instructions in Running the installer on page 67.
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Applying backed up files to the staging area

The installation program deploys files into a staging area where one or more
Peregrine Portal applications are deployed. Back up the following files to this
staging area.

1 Copythebackeduplocal.xml fileinto the <install_dir>\image\WEB-INF
directory where <instal1_dir> is the directory in which you directed the
installer to deploy its files. The default is
C:\Program Files\Peregrine\Portal.

2 Apply your backed up customizations to the files in the

<install_dir>\1image directory. Follow the appropriate steps provided in
the section Migrating Get-Answers Customizations in this chapter.

Generating the WAR file
The following steps generate a WAR file.

1 From the command prompt, change your current working directory to
c:\Program Files\Peregrine\Portal\image

2 From the command line, type:

"<Java-path>\bin\jar.exe cvf <directory-where-war-file-will-be>\oaa.war ."

where <Java-Paths> is the path to your Java installation.
Important: The command must contain the period after following oaa.war.

3 Press Enter.

Copying the WAR file to the WebLogic Server machine

Copy, or FTP, the WAR file you just generated into the WebLogic server machine
and extract to the <WebLogic>\applications directory. See Copying the
installed files to your WebLogic directory on page 29 for details.
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Verifying WebLogic has the latest XML parser files

Make sure that you have the correct version of the JAR files.

= Ifyouare using WebLogic 6.1, follow the steps in Moving jar files to the Java
Development Kit ext directory on page 26.

= If you are using Weblogic 8.1, follow the steps in Copying jar files on
page 33.

Deploying the WAR file to the WebLogic server

Use the WebLogic User Interface (Ul) to deploy using the same Web Module
name noted in Step 2 on page 160 of Uninstalling Get-Answers from WebLogic.

Verifying and completing the configuration for Get-Answers

Follow the steps in Configuring Get-Answers on page 71 to configure the
Get-Answers Admin settings.

Completing the Get-Answers upgrade

Follow the steps in Completing the Get-Answers upgrade on page 170 to
complete the upgrade.
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Upgrading Get-Answers on WebSphere 5.0.2 and 5.1

If you are upgrading from Get-Answers 4.1.x to Get-Answers 4.2, complete the
following pre-upgrade steps.

To prepare for the WebSphere upgrade:
1 Remove the following lines from the current Tocal.xm1. file.

<SSLProvider>com.ibm.jsse.JSSEProvider</SSLProvider>
<HTTPSHand1erPkg>com.ibm.net.ss1.internal.www.protocol</HTTPSHandlerPkg>
<CryptoProvider>com.ibm.crypto.provider.IBMJCE</CryptoProvider>

2 For WebSphere 5.0.2 only, remove the following files from
$JAVA_HOME/jre/1ib/ext.

oaasecurityproxy.jar
pop3.jar

js.jar

jai_core.jar
jai_codec.jar
mlibwrapper_jai.jar
xalan.jar
xercesImpl.jar
xml-apis.jar

3 Verify that there are no added entries for the following:

= On Windows, remove any path entries to the ServiceCenter libraries
placed in the $PATH environment variable.

= On Solaris or Linux, verify that startServer. sh has no added entries for
the LD_LIBRARY_PATH variables.

= On AlX, remove any added path entries in startServer.sh for the
LIBPATH variable, except for the path to the ServiceCenter libraries.

For example, when running ServiceCenter 5, keep this entry:

LIBPATH=/WebSphere/AppServer/installedApps/oaa.ear/oaa.war/
WEB-INF/1ib/AIX/ServiceCenter5
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For example, when running ServiceCenter 6, keep this entry:

LIBPATH=/WebSphere/AppServer/installedApps/oaa.ear/oaa.war/
WEB-INF/1ib/AIX/ServiceCenter6

When you complete the pre-upgrade steps for WebSphere, continue with the
following instructions.

Step 1 Backup the Tocal.xm1 file and any customizations from your current
installation of Get-Answers. See page 164.

Step 2 Uninstall Get-Answers from WebSphere. See page 165.
Step 3 Run the Get-Answers installer. See page 165.

Step 4 Apply the backed up Tocal.xm1 file and customizations to the staging
area created by the installer. See page 165.

Step 5 Generate the WAR file from the files in the staging area. See page 166.

Step 6 Copy, or FTP, the WAR file to the WebSphere server machine. See
page 166.

Step 7 Copy required runtime libraries. See page 166.

Step 8 Use WebSphere to deploy the WAR file, then verify and complete the
configuration. See page 166.

Backing up the local.xml file and any customizations
Before you make changes to any files, create a backup copy.

1 Backup the Tocal.xm1 file. The default location is

<websphere_home>\AppServer\installedApps\<server_name>
\oaa.ear\oaa.war\WEB-INF\Tocal.xml.

where <websphere_home> is the root directory in which WebSphere is
installed and <server_name> is the name of your server.

2 Backup any schema extensions and any customization of themes created
for the existing version. First read Completing the Get-Answers upgrade on
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page 170 to familiarize yourself with how certain customizations will be
performed later.

Follow the steps in the section below under Get-Answers Pre-upgrade
Procedure.

Uninstalling Get-Answers from WebSphere

Prior to uninstalling Get-Answers, make note of the Context Root and
Application names.

1

2

3

Log on to the WebSphere Administrative Console.
Note the name of the Get-Answers Context Root installed in WebSphere.
The default is oaa. Also note the Application Name. You will need to provide

these names when you install the upgraded WAR file.

Uninstall Get-Answers using the WebSphere Administrative Console.

Running the Get-Answers Installer

Follow the instructions in Running the installer on page 67.

Applying backed up files to the staging area

The installation program deploys files into a staging area into which one or
more Peregrine Portal applications are deployed. Back up the following files to
this staging area.

1

Copy the backed up 1ocal.xml file into the <install_dir>\image\WEB-INF
directory where <install_dir> is the directory in which you directed the
installer to deploy its files. The default is

C:\Program Files\Peregrine\Portal.

Apply your backed up customizations to the files in the
<install_dir>\1image directory.
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Generating the WAR file

The following steps generate a WAR file.

1 From the command prompt, change your current working directory to
c:\Program Files\Peregrine\Portal\image.

2 From the command line, type:
"<Java-path>\bin\jar.exe cvf <directory-where-war-file-will-be>\oaa.war ."
where <Java-Path> is the path to your Java installation.

Important: The command must contain the period after following oaa.war.

3 Press Enter.

Copying the WAR file to the WebSphere server machine

Copy, or FTP, the WAR file you just generated to the WebSphere server machine,
or verify the WAR file is accessible from the WebSphere server machine.

Copying required JVM libraries
The installer generates jar files that you must copy to the application server.

1 Ifyour WebSphere version is 5.0.2, follow the instructions in Copying jar files
on page 55 to copy required runtime libraries.

2 If your WebSphere version is 5.1, follow the instructions in Copying jar files
on page 61 to copy required runtime libraries.

Using WebSphere to deploy the WAR file

The oaa.war file creates the directory structure necessary to deploy
Get-Answers to your application server.

1 Follow the steps in Deploying the oaa.war file on page 54 (for WebSphere

5.0.2) or Deploying the oaa.war file on page 60 (for WebSphere 5.1) to
deploy the upgraded WAR file.

166 | Upgrading Get-Answers on Application Servers



Important: Setthe Context Rootand Application Name to the names you noted

in Step 2 on page 165 in Uninstalling Get-Answers from WebSphere.

2 Follow the steps Editing the application settings on page 56 (for

WebSphere 5.0.2) or Editing the application settings on page 62 (for
WebSphere 5.1)to set class loading to PARENT_LAST and to regenerate the
WebSphere plug-in.

You do not need to follow the step to set a Shared Library since it should
already be set.

Stop and start the Administrative Console.

Follow the procedures in Completing the Get-Answers upgrade on
page 170 to complete the upgrade process.

Follow the steps in Configuring Get-Answers on page 71 to configure the
Get-Answers Admin settings.

Get-Answers pre-upgrade procedure
Backing up your database

Always protect your Get-Answers data by backing up your database before the
upgrade. See your System Administrator or the documentation from your
database provider to backup your data.

Printing configuration information

1

2

Log in to Get-Answers as an administrator.
Go to the Administration tab.
Print copies of the information on the Common tab and other tabs that are

used by your current version. See the Installation and Administration guide
for your current version to determine which tabs are being used.
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Clearing Tomcat’s cache

If Tomcat is your application server, and you are upgrading from Get-Answers
4.1.2t0 4.2, delete the files in Tomcat’s cache so that the new edit-on Pro will
work properly. The default location is:

C:\Program Files\Peregrine\Apache Group\Tomcat4\work\Standalone
\TocaThost\oaa.

Upgrading the search engine

Itis a good practice to back up the following folders before uninstalling the
search engine.

s <search_engine_install_directory>/Peregrine/config
s <search_engine_install_directory>/resource
s <search_engine_install_directory>/spider

If you have configured the Web crawler/Spider, back up the
<search_engine_install_directory>/spider/KMSpider/config directory
and restore it after you re-install. Customized spider files include files such as:

start.1st (list of sites to crawl)

= spider.cfg (basic settings such as page and site depth)
= permission.Tst (list of allowable pages to crawl by name and wildcard)
= proxy.cfg (list of which sites to go through proxy server)

= revisit.cfg (how often to update the spider indexes if they vary from site
to site)

= The settings for spider crons in the exec. cfg file in the
getanswers\Peregrine\config directory.

If you have configured how often the spider or any other process runs using the
CRONTAB settings in the exec. cfg file, back up the exec.cfg file and then
restore the CRONTAB settings after you install the 4.2 search engine.

If you have added any custom fields to your rware. cfgfile, you should back this
file up before uninstalling and reinstalling the search engine. The rware. cfgfile
from 4.1.2 is NOT compatible with 4.2. Once you have installed the 4.2 Search
engine, you need to copy and paste your custom fields from the 4.1.2 rware.cfg
into the 4.2 rware. cfg. Copy ONLY your custom fields as some field flags and
definitions for the default fields have changed.
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If you have added a search engine custom dictionary or thesaurus using the
instructions described in the Get-Answers Administration Guide, Chapter 9 in the
section, Setting up custom dictionaries, then you should save your customized
files before uninstalling and reinstalling the search engine. The following
instructions below explain what to do if you added an English dictionary named
userdict in the default installation directory C:\getanswers. You may need to
modify these instructions for your dictionary language and your installation
directory.

To save your customized dictionary or thesaurus:

1

Back up (make a copy of) the directory someplace other than
C:\getanswers.

Example: C:\getanswers\resource\rw_english\userdict
Back up the following files to a directory other than C:\getanswers.

s C:\getanswers\resource\rw_english\Tlang.cfg
s C:\getanswers\resource\rw_english\rw_english.i1x

Uninstall the 4.1 version of the search engine by clicking Start > Settings >
Control Panel > Add or Remove Programs.

Click Get-Answers Search Engine 4.1.
Click Remove.

Some files will remain in the search engine's installation directory; for
example, the C:\getanswers directory. You need to delete these files
manually.

Use the instructions in the section, Setting up and installing the Search
Engine server, in Chapter 2 of the Installation Guide, to install the 4.2 search
engine. Install it in the same directory for ease of upgrading, then restart the
server.

Note: Do not start the search engine yet.

8

Restore the backed up that you made of the custom dictionary directory to
the same place that you backed it up from in step 1. For example, if you
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added an English dictionary named userdict under the default installation
directory C:\getanswers, then restore the directory to
C:\getanswers\resource\rw_english\userdict.

9 Restore the Tang.cfgand rw_english.ilxfiles to the same place that you
backed them up from in step 2.

Example:
C:\getanswers\resource\rw_english\lang.cfg

C:\getanswers\resource\rw_english\rw_english.ilx

10 Refer to the instructions in Chapter 9 of the Get-Answers Administration
Guide in the section title, Setting up custom dictionaries. In these instructions,
the last step is to regenerate the indexes. To do this, follow the instructions
in steps 5 and 6 of the Setting up the search engine section in Chapter 9.

=  Openacommand line and navigate to the C: \getanswers\bin directory

= 5-Re-index the main Get-Answers dictionary (not your user dictionary)
using the following command:

C:\getanswers\bin>dict_xrf.exe C:\getanswers\resource\rw_english\dict

= 6 -Re-index the user dictionary, “userdict” with the following
command:

C:\getanswers\bin>dict_xrf.exe c:\getanswers\resource\rw_english\userdict

Completing the Get-Answers upgrade

Follow the procedures in this section to complete the upgrade process.

Expiration dates and creation dates

In Get-Answers 4.1, the expiration date and creation date values on a view-only
form rendered as yyyy-mm-dd. This is not consistent with the locale-specific
date format. In order to consistently render these and any other date fields,
perform the following steps after your system has been upgraded from
Get-Answers 4.1 to Get-Answers 4.2.
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To update the date format:

1 Log on to Get-Answers as the document team owner or the Get-Answers
administrator.
2 Click the Get-Answers tab.
3 Inthe Get-Answers activity menu, click the Manage Document Types link.
4 Inthe Search page, click View All to list all of the document types.
5 From the Search Results page click one of the document types listed,
Problem Solution for example.
6 Inthe Document Details page, click the first Document View link listed,
Default Probsol View, for example.
The Document View Details page opens.
Home | Administration e People | Workflows
Document Yiew Details
R Answers Document Type: Problem/Salution ~
F— Security Level:
o Cateqories Roles (1) _add
P 0 Catalt
Draft Document Lit
Retired Docurnent List Field List: Insert Selested ff Cursar
et S B,
Mansge Document Fram Other View Weblink Hew Upload Image Shared Cortert
Ownership Teams
S 2 % B @[ o o gk |[none ~ [ IDefaut) v[Momal || B U 7 % < AL | E E|
Shared Content — 5| ¥ x| OTE G
User Settinags
Import Documents :T” N o eation Date:
g?‘::arr\rt\:le\gtls.mked EiDucument Id: *GA*EmDocumentTd*GA AR mDocumentCre ationDate " GA™
¥ Reports zzzzzszzzzss==zzz===zzz==zzzz=zzzz:z:z
Documents xpiration Date: *GA%EmDocumentExpDate*GA*
Document Feedback
Usage History : ;“:}; i
Search History {Summary: *GA*KmDocument/Summary*GA* P*GA*E mDocument! AuthorfldentcationFull Tame*G |
e a— S . B ||
edit-an® Pra by RealObjects "ﬁ 1
7 Inthe text edit, you need to change the prefix (*GA*) and suffix (*GA_Date*¥)

of each date field to indicate that it is a date field. For example,

From
*GA*rKmDocument/CreationDate*GA*

*GA*rKmDocument/ExpDate*GA*

To
*GA_Date*rKmDocument/CreationDate*GA_Date*
*GA_Date*rKmDocument/ExpDate*GA_Date*
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8 After you edit all the date fields, click Submit View Changes.
9 Inthe Details page, select the next view to edit.

10 Continue editing the document views for the document type until all you
have updated all of the document views for the document types.

11 Click Submit Changes.

A confirmation message appears. For example,
Document updated: 8320

12 Select the next document type in the list of document types on the
Document Type Search Results page and repeat steps 6 to 11 until you have
updated the date fields for all of the views in all of the document types.

Home | administration [ People | Workflows

Document Type Search Result:

v Get-Answers Document updated: 8320
Search Please click on any item to view it in detail.

Browse Categories

Docurment Value

DOraft Document List Problem/Solution  Description of & solution for a prablem. probsol
B . External n documnent created outside of Get-Answers, Examples are MS Office Documents, PDF, HTML, native
Retired Document List oct..,

Manage Cateqories How-To Question and Answer fields you can edit howto
e — Reference i one-field description of the reference, reference
Ownershin Teamns Error Description of an error message, steps taken before receiving the error message, and a work-  errormsg

Message/Cause around for the error.
= Manage Document

Mew S al N
Shared Content ey S i

User Settings
Import Documents

Recongcile Linked
Docurnents

~ Reports
Documnents

Docurnent Feedback
Usage History
Search Histary

Docurnent Team
Ackivity

Re-creating customizations in Get-Answers 4.2

You cannot directly migrate customizations implemented before version 4.0.1
to Get-Answers 4.2. Instead, you must re-create your changes using the new
features and methods available in Get-Answers 4.2.

The following sections describe how to re-create your customizations from
previous versions.
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No customizations

If you have made no customizations to Get-Answers, you can simply install
Get-Answers 4.2 on a new system and migrate your data from your existing
back-end database.

Customized JSP files

In previous versions, users had to directly modify JSP files in order to add or
remove certain functionality. The following table describes how to re-create
some of the more common JSP file modifications.

JSP file modification New method to use

Remove the user self-registration option  Enable or disable the user registration

from login page option from the Administration Settings
page

Remove the change password option Enable or disable the change password

from the login page option from the Administration Settings
page

Personalized pages

Get-Answers 4.2 offers many more pages that you can personalize directly from
the Web interface. If you personalized pages in a previous version, you must
re-create your personalized pages in Get-Answers 4.2 using DocExplorer. Refer
to the Get-Answers Administration Guide for information on personalization.

You can use personalization to:

= Add or remove fields from a page

= Save a personalized search results or details on your portal page

Customized skins, stylesheets, and themes

Get-Answers 4.2 has combined all interface images and stylesheets into themes.
Users can no longer select separate skins and stylesheets. The new themes
consist of skins (which themselves are composed of image files, frame
definitions, and layer files), cascading stylesheet definitions, and XSL templates.

Although you can copy over older custom themes to Get-Answers 4.2, you may
experience rendering errors due to the new images, CSS definitions, frame
definitions, and layers. It is recommended that you re-create any custom themes
using the Get-Answers 4.2 version of the classic theme as your template. Refer
to the Get-Answers Administration Guide for information on customizing.
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Alternate login pages and authentication methods

If you used a custom login page or an alternate authentication method in a
previous version, you can re-use or re-create these customizations using the
updated instruction. You can find information about alternate security methods
in the Get-Answers Administration Guide.

Preserving customized web.xml file settings

You can open the web.xm1.xxx.bak file, copy its customized configuration
settings into the new web . xm1 file, and save the new file to preserve your
customizations.

Note: Note that the <appsrv>\WEB-INF\web.xm1 file has been renamed to
<appsrv>\WEB-INF\web.xm1.xxx.bak, where <appsrv> is the path to
your application server, and xxx represents a unique sequence of
characters. This preserves any customizations that you might have.

After upgrading Get-Answers to 4.2, a new file called web . xm1.xxx.bak is
created in the <appsrv>/WEB-INF directory. You must reconcile the contents of
this file with the contents of the new web . xm1 file. Any portion of the

web . xm1.xxx.bak file that does not exist in the new web.xm1 file needs to be
added to the web.xm1 file.

Table Creation

Follow the instructions provided in the Table Creation section of the
Completing Installation chapter to run Table Creation on the Admin menu to
automatically upgrade the back-end database.
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Load-Balancing Tomcat Application
chnprer O@TVEIS

This chapter covers the following topics:

= Load balancing application servers

= Load balancing with Apache and Tomcat on page 178
= Load balancing with 1IS and Tomcat on page 181

= Creating multiple instances of Tomcat on page 183

Load balancing application servers

A server running a Web application such as Peregrine’s Get-Services,
Get-Answers, or Get-Resources consumes approximately 256 MB of memory per
application server instance. You should not set the maximum heap size of the
JVM in excess of the free RAM available to the application server(s). Exceeding
the amount of available RAM causes the JVM processes to swap to disk,
reducing overall performance.

Unlike other Adapters, the AssetCenter and ServiceCenter Adapters each create
a single connection to the back end. Therefore, the memory consumed on the
AssetCenter database server is the same as that consumed by a single client
connection. The memory consumed on the ServiceCenter server is also the
same as that of a single ServiceCenter client process.

Note that memory usage does not increase significantly per session, because
the architecture is based on the sharing of a set of resources and database
connections among all sessions handled by the same application server
instance. The small amount of memory consumed for session-specific
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information is released as the users log off or as their sessions expire. Note that
server sessions do not expire unless the browser is closed or the user navigates
to a different domain.

Because ServiceCenter and AssetCenter adapters maintain a single connection
to the back end, adding extra application server instances brings the added
benefit of concurrent access to the back-end data store.

The need for extra application server instances and therefore JVMs is directly
related to three variables:

= The number of concurrent users.
= The processing power of the machine hosting the Get-Answers Web server.
= The number of processors on the machine.

Each deployment may make different demands of the software and hardware,
but, in any case, optimal back-end throughput for ServiceCenter and
AssetCenter is achieved with the maximum number of application server
instances that the server can handle without degraded performance due to lack
of CPU headroom, file system swapping, and context switching.

Cache synchronization with Symmetric MultiProcessing (SMP) servers can, in
most cases, be ignored as a performance tuning factor except in the case of the
extremely large-scale systems.

To serve as a control guideline, low-end processors, such as a Pentium 450,
should be capable of producing acceptable load handling for around 100
concurrent sessions on a single application server process. A dual Pentium 1000
with 2 gigabytes of RAM (a common data center configuration) should be
capable of handling 400+ concurrent sessions using multiple application server
instances. When using adapters capable of pooling, for example, the
BizDocAdapter, performance beyond the 400-concurrent-user benchmark can
be achieved.
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The following diagram illustrates the architecture of multiple JVMs.
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Note: A white paper on Peregrine OAA architecture and optimization is
available on the Customer Support Web site at
http://support.peregrine.com. In the Search Knowledge Base question
field, type optimize and click Go. Click Get-It: Guide for planning and
implementing OAA-based applications in the search results list and
download the document.
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Load balancing with Apache and Tomcat

Note: The following procedures assume that you already installed Get-Answers
and configured it with Tomcat and Apache. Refer to the installation
chapter for more information on installing Get-Answers.

Step 1 Login to the Get-Answers administration page and disable the script

poller settings. See Disabling script pollers on the primary Tomcat
instance on page 184.

Step 2 Create multiple instances of Tomcat. See Creating multiple instances of
Tomcat on page 183.

Step 3 Edit Apache’s mod_jk2. conf file to establish a connection between
Tomcat and Apache. See Editing the mod_jk2.conf file on page 179.

Step 4 Edit the httpd. conf file to define the Tomcat workers available for
Apache. See Editing the httpd.conf file on page 180.

Step 5 Test the configuration. See Testing load balancing on Apache on
page 180.

Disabling script pollers on the primary Tomcat instance

You only need one Tomcat instance running script pollers. Before you copy your

primary Tomcat instance, you should login to the Get-Answers administration

page and turn off script polling. This will disable script polling on all of the

Tomcat instances you create by copying the primary Tomcat instance.

To disable script pollers on the primary Tomcat instance:

1 Login to the Get-Answers administration page. The default URL is:
http://<appsrv>/oaa/admin.jsp

2 Click Settings.

Get-Answers displays the common settings page.
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3 Scroll down to the Server-Side Scripts section, and select No for the Enable
script pollers option.

4 Scroll down to the bottom of the form and click Save.
5 Click the link for the Control Panel page.

6 Click Reset Peregrine Portal to commit your changes.
7 Log out of the Get-Answers administration page.

8 Stop the Peregrine Tomcat service to temporarily disable Get-Answers.

Creating multiple instances of Tomcat

See Creating multiple instances of Tomcat on page 183.

Editing the mod_jk2.conffile

The mod_jk2. conf file defines where the worker files are available in Apache.
Editmod_jk2.conf only after successful deployment of necessary Get-Answers
files; otherwise the Get-Answers mount points, file locations, and directories are
not included in the mod_jk2. conf file and have to be manually added.

To edit the mod_jk2.conf file:

1 Make a copy of the mod_jk2. conf file and rename the copy to
mod_jk2.conf.backup.

The mod_jk2.conf file is located in the Apache/conf directory.
2 Open the mod_jk2. conf file in any text editor.

3 Verify that JkSet points to theworkers2.properties file in the Apache/conf
directory. For example:

JkSet config.file "C:\Program Files\Apache Group\Apache?2
\conf\workers2.properties"

4  Save thefile.
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Editing the httpd.conf file

The httpd. conf file must include mod_jk2.conf.
To edit the httpd.conf file:
1 Open the httpd. conf file in any text editor.
The default location is: C:\Program Files\Apache Group\Apache2\conf
2 Update the following line to point to Apache’s mod_jk2. conf file:

include "<Apache>/conf/mod_jk2.conf"

For <Apache> enter the path to your Apache installation. The default file
pathis: C:\Program Files\Apache Group\Apache2\Tomcat4.1

3 Save the file.

Testing load balancing on Apache

After you create additional Tomcat instances, you can test load balancing.

To test load balancing:

1 Start all Tomcat instances.
If you are running on a Windows operating system and you installed Tomcat
as a service, open the Windows Control Panel and start each instance from
the Services dialog box.

2 Start the Apache web server.

3 Open abrowser and log in to Get-Answers.

4  Perform an action in Get-Answers, such as a search.

5 Leave the browser open.
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6 Repeat steps 3 through 5 for the same number of times as the number of
Tomcat instances you created.

The load balancing mechanism uses a round-robin algorithm. If load
balancing is working correctly, each login should use a different Tomcat
instance.

7 Open the archway. 1og file from a Tomcat instance in a text editor. By
default, there should be on archway . Togfile in each of the Tomcat instances
working directory.

8 Verify that each archway. Tog contains log messages that state the port
number on which the Tomcat instance is listening.

For example, if you have set on the Administration page the logging level to
DEBUG, there will be log messages such as, “Beginning a new
session:<session number>.<hostname>.<port>" where <port> is the port
number on which a Tomcat instance is listening.

If a Tomcat instance does not have its own archway . Tog containing text
with the rquired port number, then the system is not load balancing and
needs troubleshooting.

Load balancing with IIS and Tomcat

You can create multiple instances of Tomcat to load balance request to
Get-Answers. Although this is not required, itimproves performance, makes the
instances easier to manage, and provides extra functionality. For example, you
can restart the service if it fails or if the machine on which the instances are
installed needs to be restarted.

Note: The following procedures assume that you already installed Get-Answers
and configured it with Tomcat and IIS. Refer to the installation chapter for

more information on installing Get-Answers.

Step 1 Complete the steps described in Creating multiple instances of Tomcat
on page 183.

Step 2 Test the configuration. See Testing load balancing on IIS on page 182.
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Creating multiple instances of Tomcat

See Creating multiple instances of Tomcat on page 183.

Testing load balancing on IIS

After you have created additional Tomcat instances, test load balancing.

To test load balancing:

1 Start all Tomcat instances.
If you are running on a Windows operating system and you installed Tomcat
as a service, open the Windows Control Panel and start each instance from
the Services dialog box.

2 Start the lIS web server.

3 Openabrowser and log in to Get-Answers.

4 Perform an action in Get-Answers, such as a search.

5 Leave the browser open.

6 Repeat steps 3 through 5 for the same number of times as the number of
Tomcat instances you created.

The load balancing mechanism uses a round-robin algorithm. If load
balancing is working correctly, each login should use a different Tomcat
instance.

7 Open the archway.1og file from a Tomcat instance in a text editor. By
default, there should be on archway . 1ogfile in each of the Tomcat instances

working directory.

8 Verify that each archway . 1og contains log messages that state the port
number on which the Tomcat instance is listening.

For example, if you have set on the Administration page the logging level to
DEBUG, there will be log messages such as, “Beginning a new
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session:<session number>.<hostname>.<port>" where <port> is the port
number on which a Tomcat instance is listening.

If a Tomcat instance does not have its own archway . 1og containing text
with the rquired port number, then the system is not load balancing and
needs troubleshooting.

Creating multiple instances of Tomcat

You can create multiple instances of Tomcat to load balance request to
Get-Answers. Although this is not required, it improves performance, makes the
instances easier to manage, and provides extra functionality. For example, you
can restart the service if it fails or if the machine on which the instances are
installed needs to be restarted.

To create multiple instances of Tomcat:

Step 1 Log in to the Get-AnswersAdministration page and disable the script
pollers setting. See Disabling script pollers on the primary Tomcat
instance on page 178.

Step 2 Create copies of the Tomcat directory. See Copying the Tomcat
directory on page 184.

Step 3 Edittheworkers2.properties file of the first or master Tomcat instance
to set the values for each additional Tomcat instance. See Editing the
workers2.properties file on page 185.

Step 4 Edit the server.xm1 files for each Tomcat instance. See Editing the
server.xml files on page 187.

Step 5 Editthe jk2.properties filesfor each Tomcatinstance. See Editing the
jk2.properties files on page 189.

Step 6 For Windows operating systems, install multiple instances of Tomcat as

a service using installservice.bat. Installing Tomcat instances as
services on page 190.
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Step 7 Login to the Get-Answers Administration page for the primary Tomcat
instance and enable the script pollers setting. See Enabling script pollers
on the primary Tomcat instance on page 191.

Disabling script pollers on the primary Tomcat instance

You only need one Tomcat instance running script pollers. Before you copy your

primary Tomcat instance, you should login to the Get-Answers administration

page and turn off script polling. This will disable script polling on all of the

Tomcat instances you create by copying the primary Tomcat instance.

To disable script pollers on the primary Tomcat instance:

1 Login to the Get-Answers administration page. The default URL is:
http.//<appsrv>/oaa/admin.jsp

2 Click Settings.

Get-Answers displays the common settings page.

3 Scroll down to the Server-Side Scripts section, and select No for the Enable
script pollers option.

4 Scroll down to the bottom of the form and click Save.
5 Click the link for the Control Panel page.

6 Click Reset Peregrine Portal to commit your changes.
7 Log out of the Get-Answers Administration page.

8 Stop Tomcat to disable Get-Answers temporarily.

Copying the Tomcat directory

You create a separate folder for each instance of Tomcat you want to use for
load balancing.

Important: Stop Tomcat if it is still running before you begin copying a Tomcat
directory.
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To copy the Tomcat directory:
1 If you are running on a Windows operating system, copy the

<Portal_Install_Dir>/SupportFiles/AppServerFiles/

installservices.bat file to the <Tomcat>/bin directory,

where <Portal_Install_Dir> is the path you directed the installer to
deploy its files and <Tomcat> is the root of the Tomcat installation.

2 Copy the Tomcat install folder. For example, C:\Program Files\Apache
Group\Tomcat.

3 Paste the folder into the same root path. For example,
C:\Program Files\Apache Group

4 Rename the new folder to a unique name.

Tip: Include the port number to be used by the Tomcat instance in the folder
name. For example, if you want four instances of Tomcat listening on ports
8009, 8011, 8013, and 8015, create four copies of the Tomcat folder and
name them \Tomcat_8009, \Tomcat_8011, \Tomcat_8013, and
\Tomcat_8015.

Warning: If you are using more than four Tomcat instances, change the port
numbers to avoid conflicts.

5 Repeat steps 1 through 4 for each instance of Tomcat you want to use.

Editing the workers2.properties file

For each Tomcat instance installed, there is only one workers2.properties file
needed. This file is shared by all other Tomcat instances on that particular server.

Theworkers2.properties file specifies the worker threads that the Web server
connector creates in order to communicate with the Tomcat instances. Each
Tomcat instance must communicate on a different port. The host should be set
to the name of the server running the Tomcat instances or localhost if they are
running on the same server.
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To edit the worker2.properties file:
1 If you installed:

= Apache with Tomcat, edit theworkers2.propertiesinthe Apache/conf
directory.

= IS with Tomcat, edit the workers2.properties in the Tomcat/conf
directory of your primary Tomcat instance.

2 Opentheworkers2.properties file in any text editor.
3 Create a channel.socket entry for each Tomcat instance.
Example:

[channel.socket:<servers>:<port>]
1b_factor=1

Note: For the existing channel.socket entry only, replace host=1ocalhost
port=8009 with the line, 1Tb_factor=1.

For <servers> enter the server name where the Tomcat instance is located.

For <port> enter the communications port on which the Tomcatinstance is
listening.

The Tb_factor is a number greater than or equal to 1 used to load balance
the workers. If all the workers are running on servers that have equal
performance strengths, you should set the 1b_factor numbers to equal
values (typically 1). If you want to assign more user sessions to a given
worker, then assign it a lower 1b_factor number relative to the other
workers.

4  Create an AJP13 worker for the channel.socket defined in the previous
step.

[ajpl3:<server>:<port>]
channel=channel.socket:<server>:<port>
group=1b
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Note: For the existing ajp13 entry, verify <server> and <port> are correct.

Where <server> and <port> are the values you have for the
channel.socket definition.

5 Save the file.

Editing the server.xml files

A separate server.xm] file is required for each Tomcat instance. The
server.xm] file contains the information that Tomcat needs to connect to the
Web server and to find Peregrine OAA Platform Web application files.

Tip: Make a back-up copy of the server.xm1 file before editing it.
To edit the server.xml files:

1 Each Tomcat instance has a server.xm1 file located in the conf directory.
Open server.xml in any text editor.

2 Update the port number attribute of the <Server> element to a unique
value that does not conflict with other port numbers used by Tomcat.

Peregrine Systems recommends that you use the port numbers 8005-8008
when configuring four Tomcat instances.

Warning: If you are using more than four Tomcat instances, change the port
numbers to avoid conflicts.

For example:
<Server port="8005" shutdown="SHUTDOWN" debug="0">

3 Update the port number attribute of the Coyote/JK2 AJP 1.3 Connector
<Connector> element to a unique value that will not conflict with other port
numbers used by Tomcat.

Peregrine Systems recommends that you use port numbers 8009, 8011,
8013, and 8015 when configuring the Coyote Connector. Your primary
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Tomcat instance may already have this set to 8009, and you will only need
to modify the other instances.

Example:

Note: Change port number only. Leave all other values the same.

4 Create a <Context> element entry from the first or primary Tomcat instance
and copy it to the other Tomcat instances.

Example:

For the docBase attribute, set <First_Tomcat_install> to the absolute
path of the first or primary Tomcat instance.

5 Update, oradd if necessary, the jvmRoute attribute of the <Engine> element
with the server name and communications port used by each Tomcat
instance using port number 8009, 8011, 8013, or 8015 as appropriate. For
example:

<Engine jvmRoute="localhost:8009" name="Standalone"
defaultHost="Tocalhost" debug="0">
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Important: Verify that you are not modifying an <Engine> element that is

surrounded by comment tags (<! -- -->) and thus commented out.
Tomcat 5 has one <Engine> element commented out and another
that is not.

6 Update the <Host> element with the webapps directory used by the first or
primary Tomcat instance. List the server information in the appBase
attribute. For example:

<Host name="Tocalhost" debug="0"
appBase="<First_Tomcat_install>/webapps" unpackWARs="true"
autoDeploy="true">

For the appBase attribute, set <First_Tomcat_install> to the absolute
path of the primary Tomcat instance.

7 Comment out for all of the Tomcat instances except for the primary Tomcat
instance. For example:

<!-- Define a non-SSL Coyote HTTP/1.1 Connector on port 8080 -->
<l--

<Connector className="org.apache.coyote.tomcat4.1l.CoyoteConnector"
port="8080" minProcessors="5" maxProcessors="75"

acceptCount="10" debug="0" connectionTimeout="20000"
useURIValidationHack="false" />

-—=>

8 Save the server.xml file.

9 Repeat Step 2 through Step 8 for each copy of the server.xm1 file you
created.

Editing the jk2.properties files

You modify the jk2.properties file for each Tomcat instance. The
jk2.properties file sets the jk2 communication port.

To edit the jk2.properties files:

1 Openthe jk2.properties file fora Tomcatinstance in a text editor. This file
is located in the Tomcat conf directory.
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2 Insert a line at the bottom of the file for the channe1Socket port. The port
number must match the port number defined in workers2.properties file
for this Tomcat instance. For example:

channelSocket.port=8009

3 Savethe jk2.propertiesfile.

4  Repeat Step 1 through Step 3 for each Tomcat instance.

Installing Tomcat instances as services

Important: Perform these steps only if Tomcat 4.1.x is running on a Windows
operating system. For Tomcat 5.0.x refer to Apache/Tomcat5
documentation on Apache’s website for instructions on how to
install Tomcat as a service.

After you have edited the Tomcat files, you can install each instance of Tomcat
as Windows services using installservice.bat.

To install Tomcat instances as services:

1 OpenaDOS command prompt and change directories to the bin directory
of your Tomcat instance.

2 Enter the following command to create each Tomcat instance:
installservice <service_name> <tomcat_home> <jvm_d11_path>

Where <service_name> is the name you assign to the Tomcat service,
<tomcat_home> is the Tomcat install directory of the instance for which you
are creating the service, and<jvm_d11_path> is the Java SDK install
directory.

Note: The <service_name>, <tomcat_home>, and <jvm_d11_path> cannot
contain spaces.

The second and third parameters are optional if you have already set the
CATALINA_HOME and JAVA_HOME environment variables.
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Note: The command to create Tomcat instances cannot accept spaces in thefile
path. The following example avoids spaces in the file path name by
replacing Program Files with Progra~!.

installservice Tomcat8009 C:\Progra~!\Apache~1\Tomcat4_8009
C:\Progra~!\jdk1l.3.1_05\jre\bin\server\jvm.d11

3 Repeat Step 1 and Step 2 for each Tomcat service you wish to create.
Tip: You can easily remove a service. From the DOS command prompt, change
directories to the bin directory of your Tomcat instance, then enter the

following command: tomcat -Uninstall <service name>.

4  Start each Tomcat instance that you install.

Enabling script pollers on the primary Tomcat instance

You only need one Tomcat instance running script pollers. Before you test your
load balancing configuration, log in to the Get-Answers administration page of
the primary Tomcat instance and enable script polling.

To enable script pollers on the primary Tomcat instance:

1 Login to the Get-Answers administration page of the Tomcat instance. The
default URL is:

http://<appsrv>:<port_number>/oaa/admin.jsp

For <port_number> enter the connector port number you used in Editing
the server.xml files on page 187, typically port 8080.

2 Click Settings. Get-Answers displays the common settings page.

3 Scroll down to the Server-Side Scripts section, and select Yes for the Enable
script pollers option.

4 Scroll down to the bottom of the form and click Save. Get-Answers displays
the Control Panel page.

5 Click Reset Peregrine Portal to commit your changes.

6 Log out of the Get-Answers administration page.
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Configuring Integrations

CHAPTER

This chapter is intended for administrators who want to integrate Get-Answers
with ServiceCenter. It also includes configuration information for the email
adapter used by Notification Services.

Configuring the ServiceCenter Integration

See the information in the Get-Answers Administration Guide for a complete
discussion of configurating Get-Answers with ServiceCenter.

Configuring the E-mail adapter

The following parameter controls the default setting used by the E-mail
Adapter. To use Notification Services to alert users to changes in the status of
Get-Answers documents, configure the following settings.

To configure the E-mail adapter settings for Get-Answers

1 Inthe Peregrine Portal Admin module, click the E-mail tab of the Settings
screen.

Note: For information on accessing the Admin Module, see Accessing the

Peregrine Portal Admin Module in Chapter 7, Completing All Installations
of this guide.
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E-mail Settings box Default setting

2 Configure these settings..

Description

Inbound mail host mailhost

Inbound mail protocol imap

The full name or IP address
of the machine hosting the
inbound mail server. If this
field is empty, then the
status of the mail adapter
indicates the status of the
outbound mail server
connection.

The protocol used by the
inbound mail server, which
is either imap or pop3.

Inbound mail user ID

Inbound mail password

The user ID used to access
the inbound mail server.

The user password used to
access the inbound mail
server.

Mail sender address

Legal domains peregrine.com;

Anonymous user falcon
Anonymous password
Outbound mail host maiTlhost

Outbound mail user ID
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Entera
semicolon-separated list of
mail domains with which
the Peregrine Portal can
correspond. Only users
with an email address in
these domains are allowed
to complete online
self-registration.

The Anonymous user
name used when an
unknown user attempts to
communicate with the
mail adapter.

The Anonymous user
password for the mail
adapter.

The full name or IP address
of the machine hosting the
outbound mail server.

The user ID used to access
the outbound mail server.



E-mail Settings box Default setting Description
Outbound mail The user password used to
password access the outbound mail
server.
Adapter com.peregrine.oaa. Full class path for the
adapter.mail. adapter associated with
MailAdapter this target.

3 Scroll to the bottom of the form and click Save.
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Troubleshooting Installation and
areenoi - Qperation

This chapter explains the problems that may occur during or after installing
Get-Answers and their solutions. The format of each problem includes

symptom, cause, and solution.

= The symptom is the error message that appears or other sign you see when

an error occurs.

= The cause is the underlying problem that produced the symptom.

= The solution is the procedure you can use to fix the problem.

Troubleshooting errors

This table describes the errors (symptoms) you might see, the probable causes,
and the solutions. Where the solutions require a procedure, the table refers you
to the Procedures for troubleshooting problems on page 203.

Symptom Cause

Solution

You receive a General Protection Fault ~ The Authoring applet
error when using Netscape 6.2 or 6.2.1 causes these versions
browsers of Netscape to fail.

Imbedding imagesinthe documenttext Get-Answers does not

does not work properly if the name of ~ support image files if

the image file contains spaces. the name of theimage
contains spaces.

Use Internet Explorer browsers or
Netscape 7.x with JVM 1.4.2 when
authoring documents.

Rename the file before attaching it
to the document. Make sure the
name does not include spaces.
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Get-Answers

Symptom

Cause

Solution

You access Get-Answers by using
Tocalhost in the URL—for example,
http://Tocalhost/oaa.login.jsp
—and you encounter licensing
problems when you try to Author
documents.

When logged into Get-Answers and
using the browser’s Forward, Back and
Refresh buttons, you see unexpected
behavior.

After you refresh the login page
(login.jsp), the language option
drop-down list and the Login and
Register buttons do not appear. This is
true for both Internet Explorer and
Netscape browsers.

You see the following error repeated in
the Archway Log file:

ERROR [noticenterpoller]
GetitAnonymous(0) -
MAILsendEmail(): Unexpected error
- The mail adapter failed to
connect. -
com.peregrine.util.ResourceCreatio
nFailureException

You notice that you cannot upload a file
in Contribute Documents pages,

Your system cannot sustain more than
10 Websphere connections to DB2 at
one time.

The Tocalhost URL
does not support
licensing.

Some Get-Answers
pages do not work
properly with a
browser’s navigation
and Refresh buttons.

Unknown

The Mail adapter is
not configured.

The Maximum
Attached File Size
parameter is too
small.

Undetermined

When logging into the application
server for the first time, use the
server name (for example,
http://<servername>/oaa
/login.jsp); must match the
setting in the Admin > Common tab.

Do not use the browser navigation
or Refresh buttons on the pages that
do not behave as expected.

Click Refresh again to bring the list
and buttons back.

Remove the Mail adapter as a
target.

See Procedures for troubleshooting
problems on page 203.

Change the Maximum attached file
size parameter. See Setting
Maximum attached file size
parameters on page 207.

See the IBM Knowledge Base article
#1009742 on IBM Web site.

http://www-3.ibm.com/cgi-bin/d
b2www/data/db2/udb
/winos2unix/support
/document.d2w
/report?&fn=1009742

You notice the following error:
Error Number

: -6, Severity: FATAL, Source:
rdb_index v6.9

CQDH Server Returned Error
Clearing the indexes 1in
preparation to rdbindex -

The database
connection to the
search engine is
unstable or the Search
Engine indexes are
incomplete or
corrupted.
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Symptom

Cause

Installation Guide

Solution

You see the following error:
ORA-01658: unable to create
INITIAL extent for segment in
tablespace ROME

You are on a Solaris system and you see

the following error:
Schema not found

You see that Boolean search results
show a relevance of 0% on the
Advanced Search page.

You see the following error:

FATAL, Source: rdb_index v6.9
Connect system call failed:
''cqdh@10.11.12.231""

Users are either missing workflow
messages or receiving duplicates of
them.

On the Manage Documents page,

Multiple workflow messages occur if you

click the Transfer or Proceed button
multiple times. An Editorial workflow is
initiated for every click on the Proceed

button. A Triage Workflow is initiated for

every click on the Transfer button.

The Get-Answers workflow templates
were not imported properly as part of
the Get-Answers installation.

In the database, the
Rome tablespace
must be extended.

Your application is
using a schema or
server-side JavaScript
whose file name
contains both upper-

and lower-case letters.

Booleansearchresults
are not ranked.

You have attempted
to index your
documents without
starting the Search
Engine.

Thereis a
configuration
problem with the web
application.

You have clicked the
Transfer or Proceed
button more than
once for one item.

undetermined

See the section, Extending the Rome
tablespace on page 209.

If you add a schema or a server-side
JavaScript, make the file name all
lowercase.

Ignore these zero-ranked search
results items.

Start the Search Engine server and
then index the documents. See the
section, Starting the Search Engine
and indexing sample documents on
page 209.

Make sure that all of the properties
set on the various tabs off of
admin.jsp are correct. In particular,
make sure the Enable script pollers
property on the Common tab is set
to Yes.

If you do click one of these buttons
multiple times, you can revert the
second Editorial Workflow message
and accompanying working copy
document after the first valid
workflow is finished. You Delete any
extra Triage Workflow items.

The system will import the
templates if no template is named
Editorial Workflow or Triage
Workflow.

Log in as the Admin.

From the Workflow tab Template
Design menu item, rename any
template named Editorial Workflow
or Triage Workflow.
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Symptom Cause Solution

This error appears in the archway.log file  The noticenterpoller  Stop the noticenterpoller. See the
once every minute: is running. section Stopping the Noticenter
ERROR [noticenterpoller] poller on page 209.
GetitAnonymous(0) -

MAILsendEmail(): Unexpected error
- The mail adapter failed to
connect. -
com.peregrine.util.ResourceCreatio
nFailureException

The Search Results page shows this The Search Engineis  See the section, Avoiding the
message: not running. “unable to perform query” error on
We're sorry, but we are unable to page 206.

perform your query - please
contact your system administrator.

The Search form shows this message The KMAdapter Set the environment path correctly.
when the user attempts to search: cannot connecttothe See Setting the environment path to
We're sorry, the oaakm server is search engine. the Search Engine on page 210.

unavailable. Please contact your
administrator or try again Tlater.

This message appears in the
archway. Tog file:

KMGAdapter: :connect - ERROR:
unexpected exception when
trying to login to
RWcom.convera.hl.
RWLoginFailedException: Failed
to login to RetrievalWare
server. API not initialized.
Re-instantiate RWLoginSession.

The session times out while in the The default session Change the default setting. See
process of entering feedback and the timeout setting is for  Changing the default session
feedback is not saved. 600 seconds. timeout on page 212.
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Symptom Cause Solution

With an ODBC connection to a DB2 The setting On the Windows server(s) with the
back-end, as soon as a user logs in, the ~ LONGDATACOMPAT ODBC connection, perform the
screen displays: must be set to zero following steps:

Unexpected error in (0) inthe

OAAForm.generate().

With an ODBC connection to a DB2
backend, workflow task messages do
not appear after submitting a new
document. Under Template Design, the
workflow templates will not display. In
addition, the archway . Togfile contains
this error:

ERROR [Thread] -
Message.newMessage XML parsing
error at line -1 column -1
org.xml.sax.SAXParseException:
Premature end of file

$DB2PATH/db2c11 .1ni
file.

Open the file
$DB2PATH/db2cT1.1in1i in a text
editor.

Ensure that the value
LONGDATACOMPAT is equal to
LONGDATACOMPAT=0 in the
$DB2PATH/db2c11.1ini file.

Ensure that LONGDATACOMPAT=0
does NOT have a semicolon
preceding it; for example,

; LONGDATACOMPT=0.The semicolon
would eliminate it (comment it out)
from the code.

After a WebSphere installation, the
Admin form at
http://hostname/oaa/login.jsp does not
render.

Duplicate alias entries
can occur from the
IBM HTTP Server
httpd.conf file during
a WebSphere
installation.

Removeduplicate Alias /oaalines
fromthe httpd. conf fileunderthe
conf directory of the IBM HTTP or
Apache web server. You want only
one of the following:

Alias /oaa "C:\WebSphere
\AppServer\installedApps
\oaa.ear\portal.war"

Alias /oaa "C:/WebSphere
/AppServer/installedApps
/oaa.ear/portal.war"

On a WebSphere installation, the
Authoring applet displays a licensing
error.

During install, a
SEVERE warning
message is displayed:
Please add
OEML1icenseServiet
mapping definition
to web.xml after
the installation
completes.

Add lines to the web.xm1 and
httpd. conf files. See Licensing
error during WebSphere installation
on page 212.
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Get-Answers

Symptom

Cause

Solution

Initialization data is missing from the
database. The symptoms of this are:

the sample authoring views (How-To,
Reference, Error Message/Cause,
External, Problem/Solution) do not
display correctly

the sample authoring views are not
listed in Contribute New Document

default images do not display in the
sample authoring views

the workflow templates are missing
the out-of-box users cannot log on

the search engine shows a
KMCOLLECTIONREFERENCE error

This is caused at the
time of a new
installation by the
application server
being stopped before
it has completed the
installation and
database
initialization.
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Use these two steps to change
several presentation directory files,
and restart the application server to
re-initialize the database.

Unzip ga_default_imgs.zipin
the images folder under the
presentation directory into the same
/images director.

Remove this text
<intalled>true</installed>
from these files:

<presentation directory>
\WEB-INF\apps\getanswers\rkmDoc
ViewRoles.dat

If your database is Oracle, remove
<installed>true</installed>
from

<presentation directory>
\WEB-INF\etc\Oracle
\GATablePopulateOracle.sql

If your database is DB2, remove
<installed>true</installed>
from

<presentation directory>
\WEB-INF\etc\DB2
\GATablePopulateDB2.sql

If your database is MS SQLServer,
remove
<installed>true</installed>
from

<presentation directory>
\WEB-INF\etc\MSSQLServer
\GATablePopuTlateMSSQLServer.sql
If this does not solve the problem,
drop and recreate the user in your
database.
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Symptom Cause Solution

On SQLServer, intermittent Update There was a See the instructions for Preparing

failure messages appear when the a configuration sizing the SQL Server 2000 for Get-Answers

document is published in a workflow, or error when your on page 38. Consult your SQLServer

anewly transferred documentislostand SQLServer database  database administrator to

fails to appear in the Workflow My was created. determine how to backup your

Messages list, or a new document view database, drop it, create a new

does not display correctly. database of size 800 MB, and restore
the data into the larger new
database.

After an upgrade of the DB2 database, = The version of the Upgrade the database driver. Copy

Get-Answers doesn't function. database driveris not the db2java.zip file from the

current. <DB2home>/java directory on the

OAA Get-Answers server, rename
the copy to db2java.jar, then
move db2java. jar to this
directory on the OAA Get-Answers
server <PresentationDir>\WEB-INF\1ib

Procedures for troubleshooting problems

Some errors have solutions that do not involve procedures. Others require a a
series of steps to fix. This section describes the procedures for solving some of
the errors described in the section Troubleshooting errors on page 197. See the
table in that section to find out if the solution for an error you have seen is
included in the table or described here instead.

Removing the mail adapter

To remove the Mail adapter

1 Open http.//<servername>/oaa/admin.jsp.

2 Login as an administrator so that you have Administrator rights.
3 Click the Settings link.

4  Clickthe Common tab.

5 Inthe List of target aliases field, remove the word mail.

6 Scroll to the bottom of the page and click the Save button.
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7  Click the Notification Services tab.
8 Inthe Targets field, remove the mail.
9 Scroll to the bottom of the page and click Save.
10 Click the Control Panel link.
11 Click Reset Server.
Correcting the “RPC Failed” error
To correct this “RPC Failed” error

1 From the Start menu, choose Programs >Get-Answers Search Engine>
Stop Search Engine Server.

The following messages appear:

exec at IPAddress:port

exec - shutdown

Shutting down the Search Engine Server
Press any key to continue .

2 Press any key to continue.

3 From the Start menu, choose Programs> Get-Answers Search Engine>
System Utilities Menu.

4 Choose option 6 - Indexing and index utilities.
5 Choose option 10 - Delete and create empty indexes for a library.

6 Atthe “Indexes should be deleted for which library? Enter Library Name []>"
command prompt, type KML1ib.

7 Atthe “Are you sure? (1 = YES, 2 = NO)” command prompt, type 1.

These messages appear:

Opening Library: KMLib
Thank you!
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8

9

10

11

12

13

14

15

Press any key to continue.
Choose option 1 - Return to previous menu.
Choose option 1 - Exit this program.

From the Start menu, choose Programs> Get-Answers Search Engine>
Start Search Engine Server.

These messages appear:

Starting up the Search Engine Server
Press any key to continue .

From the Start menu, choose Programs > Get-Answers Search Engine >
Reindex all Documents.

At the “Enter the name of the library to be indexed. Enter Library Name []>"
command prompt, type KMLib.

Atthe “Are you sure you wish to index the entire RDBMS now? (warning: this
will delete any existing indexes in KMLib). (1 = YES, 2 = NO)” command
prompt, type 1.

This message appears:

A1l records have been submitted to the document handler.

Press any key to continue.

Checking and configuring adapters

Use the following procedure to resolve

1

Go to the Administration tab and click Control Panel.
The page that opens shows a list of adapters and their connection status.
If the Mail adapter is disconnected and you do not use the mail adapter for

notifications or the Business Objects database for reporting, ignore these
messages.
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4 If a adapter other than the Mail adapter is disconnected, click the Reset
Server button.

5 Ifthe status is still Disconnected, see the Get-Answers Administrator’s Guide
to configure the adapter again.

Reindexing the sample documents

To reindex the documents

1 Go to Start > Programs > Get-Answers Search Engine > System Utilities
Menu.

2 Choose option 6 - Indexing and Index Utilities.

3 Choose option 4 - Index RDBMS Records.

4 Choose option 3 - Index all RDBMS Records in your library.

5 Enter KMLib. This is the knowledge management library you want to index.
6 Enter 1 - Yes to update the index.

7 Choose option 1 - Return to previous menu.

8 Choose option 1 - Return to previous menu.

9 Choose option 1 - Exit this program.

Avoiding the “unable to perform query” error

To avoid this error

1 Make sure the Get-Answers Search Engine’s Search Engine Server is running
before you start your application server; for example, Tomcat.

Tip: Start the search engine by choosing Start > Get-Answers Search Engine
> Start Search Engine Server.

2 Then start the application server.
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Note: It must be done in this order. If you're already running the application
server, stop it, start the search engine server, then start the application
server.

To verify that you've started everything correctly

1 Inyour browser, go to
http://SERVERNAME/oaa/admin.jsp
where SERVERNAME is the name of your server.

Warning: Do not use “localhost” as the server name. There is a known defect for
problems caused when you reference the server by calling it localhost
the first time after you start the application server.

2 Inthelogin screen, use:
Togin: System
no password

Note: This should bring up the OAA control panel. You should see a line in the
list of adapters that says “oaakm.” The status of oaakm should be
“connected”.

After that, you should be able to access our sample data. We have one sample
document ownership team (called “Get-Answers Team”). That team owns one
domain (“Get-Answers”) and the Get-Answers documentation has been
published into that domain.

There are three pre-defined users.

Login Password Function

oowner password owner of the team
eeditor password an editor on the team
rreviewer password areviewer on the team

Setting Maximum attached file size parameters

Go to the Common tab in the Admin Settings. The maximum attached file size
parameter is used to limit the size of files that may be submitted as attachments.
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A value of 0 indicates that no limit is set. This setting is a default that you can
override by individual attachment fields. If for example, a value of 2048 was set,
this would limit to 2mg, the size of a file that could be submitted in Get-Answers
via the Contribute Documents menu option.

Reestablishing the database connection and restarting
the Search Engine

To re-establish the database connection

= Reboot the tomcat server.

If necessary, based on the presence of a database error in the Get-Answers
Search Engine console screen, stop and then restart the Get-Answers Search
Engine.

To restart the Get-Answers Search Engine

1 Goto Start > Programs > Get-Answers Search Engine > System Utilities
Menu.

2 Choose option 4 - Search and Indexing Servers.

3 Choose option 5 - Stop servers. The Get-Answers Search Engine Executive
window will close.

4 Press any key to continue.

5 Choose option 2 - Start servers in background. The Get-Answers Search
Engine Executive will start running in a separate window.

6 Press any key to continue.
7 Choose option 1 - Return to previous menu.

8 Choose option 1 - Exit this program.
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Extending the Rome tablespace

This procedure can resolve the cause of the following error

ORA-01658: unable to create INITIAL extent for segment in tablespace ROME

To extend the Rome tablespace

1

From the Start menu, select Programs > Oracle - OracleHome8i > Database
Administration > SQLPlus Worksheet.

Login,
User: system

Password: manager

Or you can login as the super user for your database. Consult your Database
Administrator for assistance.

3 Delete the connect line in the upper pane.

4 Run this script:

ALTER TABLESPACE ROME AUTOEXTEND ON NEXT 1M MAXSIZE UNLIMITED;
Commit;

Starting the Search Engine and indexing sample documents

1

From the Start menu, choose GetAnswers Search Engine> Start Search
Engine Server.

Index your documents by taking these steps:
a Click the Start menu, and choose Get-Answers.

b Click Search Engine, and then choose Index Updated Documents.

Stopping the Noticenter poller

To stop the noticenterpoller

1

Click Administration and choose the Show Script Status.

2 Click the noticenterpoller link to suspend it.
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Note: You must perform this step every time you start or restart the web or
application server.

3 Rename or remove the scriptpollers.ini file located in the
\WEB-INF\apps\notification directory.

You can rename the file to scriptpollers.iniSave or something similar.

You need to do this step only once. The only way to restart the
noticenterpoller is to place the scriptpollers.ini in the
\WEB-INF\apps\notification directory again.

4 Remove the default notification capabilities from the Administration ->
Settings > NotificationDB tab so that users will not see the basic notification
Ul.

For example, change:

notificationDB(oaa.ns.send;oaa.ns.view;oaa.ns.gui;oaa.ns.preferences)

to

notificationDB without the parenthesis.

5 Notify the workflow template/process designer that the notification options
on the Workflow Activity details screens will not trigger email notifications
without proper configuration of the email adapter and operation of the
noticenterpoller.

Setting the environment path to the Search Engine

If a user receives the message: The oaakm server is unavailable, it might
occur because the KMAdapter cannot connect to the Search Engine because the
environment path is not set correctly. These instructions provide solutions for
Windows and AlX installations.
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To configure the PATH environment variable on Windows

Make sure that these fields appear in the PATH environment variable and
that the PATH environment variable is less than the maximum size (256
characters).

<SearchEngineInstallDirectory>\Tib;<SearchEngineInstallDirectory>
\inso;<SearchEngineInstallDirectory>\bin;<Get-AnswersContextRoot>
\WEB-INF\Tib;

The default value for <SearchEngineInstallDirectory> is c:\getanswers.

The default value for <Get-AnswersContextRoot>on a Typical installation is
C:\Program Files\Peregrine\Common\Tomcat4\webapps\oaa.

Note: You can create a drive mapping to a shorter path using the subst

command; the subst command can then be run on startup from a batch
file.

2 Stop the search engine, application server, and Web server.

3 Restart the search engine server before starting the application server and

Web server.

On AIX

If you are running on an AlX server, you must configure your WebSphere
environment by editing the startupServer.sh script.

To configure the Websphere environment on AlX

1

Open startupServer.sh in any text editor.
Add an entry for LIBPATH and set it to the path values for AIX.
For example:

#!/bin/sh
LIBPATH=/usr/1ib:/WebSphere/AppServer/installedApps/answer.ear
/portal.4.0.0.55.war/WEB-INF/1ib/AIX:/WebSphere/AppServer
/installedApps/answ er.ear/portal.4.0.0.55.war/WEB-INF/1ib/AIX
/ServiceCenter4 export LIBPATH

Save the file.
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Changing the default session timeout

To avoid timing out while a popup window is open, modify the default session
timeout in the Admin settings to be a higher time interval than 10 minutes (600
seconds). The Common tab has a section heading called Encoding, Locales, and
Sessions. Session timeout is directly below the section heading.

To modify the default session time

1 From Admin >Settings >Common tab, scroll to the Encoding, Locales, and
Sessions heading.

2 Inthe Session timeout parameter, type the number of seconds that you
want for the session to remain active; for example, 6000.

3 Click Save, then click Reset Server.

Licensing error during WebSphere installation
To correct the licensing error message, add the mapping definition to the
web . xm1 file and update the httpd. conf file.

To correct the licensing error message

1 Using atext editor, open theweb . xm1 file located at <appsrv>\oaa\WEB-INF
and update the following sections.

Note: Be sure the lines are not within a section containing <!-- comment -->
lines.

a Add these lines to the <servlet> section.

<servlet id="Servlet_eopro">
<servlet-name>0EMLicenseServiet</serviet-name>
<display-name>Edit-On Pro License Servlet</display-name>
<servlet-class>oemlicense.OEMLicenseServlet</servlet-class>
</serviet>
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b Add these lines to the <servlet-mapping> section.

<servlet-mapping id="ServletMapping_eopro">
<servlet-name>0EML1icenseServlet</servlet-name>
<url-pattern>/servlet/oemlicense.0EMLicenseServlet</url-pattern>
</serviet-mapping>

c Save and close the file.

2 Using a text editor, open httpd. conf under the conf directory of the IBM
HTTP or Apache web server.

Note: Use the absolute path for your portal.war file.

a Add the following line to the end of the file.

Alias /eopro "C:\WebSphere\AppServer\installedApps\oaa.ear
\portal.war\eopro"

b Save and close the file.

Documents do not display message

To correct the documents not displaying error message, add the mapping
definition to the web. xm1 file.

To correct the documents not displaying error message

1 Using a text editor, open the web . xm1 file located at <appsrv>\oaa\WEB-INF
and update the following sections.
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Note: Be sure the lines are not within a section containing <!-- comment -->
lines.

2 Add the following lines after the installation completes.

a Add these lines to the <servlet> section.

b Add these lines to the <servlet-mapping> section.

c Save and close the file.
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Copyright Notices

APPENDIX

Notices

Peregrine Systems acknowledges the copyrights belonging to the following
third parties. (This appendix constitutes a continuation of the copyright page.)

Jerypt.java

JAXP

W3(

This product includes software developed by Eric Young (eay@mincom.oz.au).

See the W3C license and the Apache version 2 license below.

W3C IPR SOFTWARE NOTICE

Copyright © 2000 World Wide Web Consortium, (Massachusetts Institute of
Technology, Institut National de Recherche en Informatique et en Automatique,
Keio University). All Rights Reserved.

The DOM bindings are published under the W3C Software Copyright Notice and
License. The software license requires “Notice of any changes or modifications
to the W3Cfiles, including the date changes were made.” Consequently,
modified versions of the DOM bindings must document that they do not
conform to the W3C standard; in the case of the IDL binding, the pragma prefix
can no longer be 'w3c.org’; in the case of the Java binding, the package names
can no longer be in the 'org.w3c' package.
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Note: The original version of the W3C Software Copyright Notice and License
could be found at
http://www.w3.org/Consortium/Legal/copyright-software-19980720

Copyright © 1994-2000 World Wide Web Consortium, (Massachusetts Institute
of Technology, Institut National de Recherche en Informatique et en
Automatique, Keio University). All Rights Reserved.
http://www.w3.org/Consortium/Legal/

This W3C work (including software, documents, or other related items) is being
provided by the copyright holders under the following license. By obtaining,
using and/or copying this work, you (the licensee) agree that you have read,
understood, and will comply with the following terms and conditions:

Permission to use, copy, and modify this software and its documentation, with
or without modification, for any purpose and without fee or royalty is hereby
granted, provided that you include the following on ALL copies of the software
and documentation or portions thereof, including modifications, that you
make:

1. The full text of this NOTICE in a location viewable to users of the redistributed
or derivative work.

2. Any pre-existing intellectual property disclaimers, notices, or terms and
conditions. If none exist, a short notice of the following form (hypertext is
preferred, text is permitted) should be used within the body of any redistributed
or derivative code: “Copyright © [$date-of-software] World Wide Web
Consortium, (Massachusetts Institute of Technology, Institut National de
Recherche en Informatique et en Automatique, Keio University). All Rights
Reserved. http://www.w3.org/Consortium/Legal/”

3. Notice of any changes or modifications to the W3C files, including the date
changes were made. (We recommend you provide URIs to the location from
which the code is derived.)

THIS SOFTWARE AND DOCUMENTATION IS PROVIDED “AS IS,” AND COPYRIGHT
HOLDERS MAKE NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR ANY PARTICULAR PURPOSE OR THAT THE USE OF THE SOFTWARE
OR DOCUMENTATION WILL NOT INFRINGE ANY THIRD PARTY PATENTS,
COPYRIGHTS, TRADEMARKS OR OTHER RIGHTS.
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COPYRIGHT HOLDERS WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL
OR CONSEQUENTIAL DAMAGES ARISING OUT OF ANY USE OF THE SOFTWARE
OR DOCUMENTATION.

The name and trademarks of copyright holders may NOT be used in advertising
or publicity pertaining to the software without specific, written prior
permission. Title to copyright in this software and any associated
documentation will at all times remain with copyright holders.

Apache Version 2
Apache License, Version 2.0, January 2004, http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
1. Definitions.

“License” shall mean the terms and conditions for use, reproduction, and
distribution as defined by Sections 1 through 9 of this document.

“Licensor” shall mean the copyright owner or entity authorized by the copyright
owner that is granting the License.

“Legal Entity” shall mean the union of the acting entity and all other entities that
control, are controlled by, or are under common control with that entity. For the
purposes of this definition, “control” means (i) the power, direct or indirect, to
cause the direction or management of such entity, whether by contract or
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding
shares, or (iii) beneficial ownership of such entity.

“You” (or “Your”) shall mean an individual or Legal Entity exercising permissions
granted by this License.

“Source” form shall mean the preferred form for making modifications,
including but not limited to software source code, documentation source, and
configuration files.

“Object” form shall mean any form resulting from mechanical transformation or

translation of a Source form, including but not limited to compiled object code,
generated documentation, and conversions to other media types.
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“Work” shall mean the work of authorship, whether in Source or Object form,
made available under the License, as indicated by a copyright notice that is
included in or attached to the work (an example is provided in the Appendix
below).

“Derivative Works” shall mean any work, whether in Source or Object form, that
is based on (or derived from) the Work and for which the editorial revisions,
annotations, elaborations, or other modifications represent, as a whole, an
original work of authorship. For the purposes of this License, Derivative Works
shall not include works that remain separable from, or merely link (or bind by
name) to the interfaces of, the Work and Derivative Works thereof.

“Contribution” shall mean any work of authorship, including the original version
of the Work and any modifications or additions to that Work or Derivative Works
thereof, that is intentionally submitted to Licensor for inclusion in the Work by
the copyright owner or by an individual or Legal Entity authorized to submit on
behalf of the copyright owner. For the purposes of this definition, “submitted”
means any form of electronic, verbal, or written communication sent to the
Licensor or its representatives, including but not limited to communication on
electronic mailing lists, source code control systems, and issue tracking systems
that are managed by, or on behalf of, the Licensor for the purpose of discussing
and improving the Work, but excluding communication that is conspicuously
marked or otherwise designated in writing by the copyright owner as “Not a
Contribution.”

“Contributor” shall mean Licensor and any individual or Legal Entity on behalf of
whom a Contribution has been received by Licensor and subsequently
incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this
License, each Contributor hereby grants to You a perpetual, worldwide,
non-exclusive, no-charge, royalty-free, irrevocable copyright license to
reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or
Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License,
each Contributor hereby grants to You a perpetual, worldwide, non-exclusive,
no-charge, royalty-free, irrevocable (except as stated in this section) patent
license to make, have made, use, offer to sell, sell,import, and otherwise transfer
the Work, where such license applies only to those patent claims licensable by
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such Contributor that are necessarily infringed by their Contribution(s) alone or
by combination of their Contribution(s) with the Work to which such
Contribution(s) was submitted. If You institute patent litigation against any
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the
Work or a Contribution incorporated within the Work constitutes direct or
contributory patent infringement, then any patent licenses granted to You
under this License for that Work shall terminate as of the date such litigation is
filed.

4. Redistribution. You may reproduce and distribute copies of the Work or
Derivative Works thereof in any medium, with or without modifications, and in
Source or Object form, provided that You meet the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of
this License; and

(b) You must cause any modified files to carry prominent notices stating that
You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You
distribute, all copyright, patent, trademark, and attribution notices from the
Source form of the Work, excluding those notices that do not pertain to any part
of the Derivative Works; and

(d) If the Work includes a “NOTICE" text file as part of its distribution, then any
Derivative Works that You distribute must include a readable copy of the
attribution notices contained within such NOTICE file, excluding those notices
that do not pertain to any part of the Derivative Works, in at least one of the
following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the
Derivative Works; or, within a display generated by the Derivative Works, if and
wherever such third-party notices normally appear. The contents of the NOTICE
file are for informational purposes only and do not modify the License. You may
add Your own attribution notices within Derivative Works that You distribute,
alongside or as an addendum to the NOTICE text from the Work, provided that
such additional attribution notices cannot be construed as modifying the
License.

You may add Your own copyright statement to Your modifications and may

provide additional or different license terms and conditions for use,
reproduction, or distribution of Your modifications, or for any such Derivative
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Works as a whole, provided Your use, reproduction, and distribution of the Work
otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any
Contribution intentionally submitted for inclusion in the Work by You to the
Licensor shall be under the terms and conditions of this License, without any
additional terms or conditions. Notwithstanding the above, nothing herein shall
supersede or modify the terms of any separate license agreement you may have
executed with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names,
trademarks, service marks, or product names of the Licensor, except as required
for reasonable and customary use in describing the origin of the Work and
reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in
writing, Licensor provides the Work (and each Contributor provides its
Contributions) on an “AS IS” BASIS, WITHOUT WARRANTIES OR CONDITIONS OF
ANY KIND, either express or implied, including, without limitation, any
warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for
determining the appropriateness of using or redistributing the Work and
assume any risks associated with Your exercise of permissions under this
License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort
(including negligence), contract, or otherwise, unless required by applicable law
(such as deliberate and grossly negligent acts) or agreed to in writing, shall any
Contributor be liable to You for damages, including any direct, indirect, special,
incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited
to damages for loss of goodwill, work stoppage, computer failure or
malfunction, or any and all other commercial damages or losses), even if such
Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or
Derivative Works thereof, You may choose to offer, and charge a fee for,

acceptance of support, warranty, indemnity, or other liability obligations and/or
rights consistent with this License. However, in accepting such obligations, You
may act only on Your own behalf and on Your sole responsibility, not on behalf
of any other Contributor, and only if You agree to indemnify, defend, and hold
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each Contributor harmless for any liability incurred by, or claims asserted
against, such Contributor by reason of your accepting any such warranty or
additional liability.

END OF TERMS AND CONDITIONS
APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate
notice, with the fields enclosed by brackets “[1” replaced with your own
identifying information. (Don't include the brackets!) The text should be
enclosed in the appropriate comment syntax for the file format. We also
recommend that a file or class name and description of purpose be included on
the same “printed page” as the copyright notice for easier identification within
third-party archives.Copyright [yyyyl [name of copyright owner]Licensed under
the Apache License, Version 2.0 (the “License”); you may not use this file except
in compliance with the License. You may obtain a copy of the License at
http://www.apache.org/licenses/LICENSE-2.0 Unless required by applicable law
or agreed to in writing, software distributed under the License is distributed on
an “AS IS” BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either
express or implied.

See the License for the specific language governing permissions and limitations
under the License.
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Glossary

PEREGRINE

This glossary contains general terms used when describing Get-Answers, OAA

platform, and Workflow.

Term

Definition

Activity

A task or set of tasks that forms one logical step
within the process definition. An activity can be
a manual activity or an automated activity.

Activity instance

A single instance of an activity within a process
instance. A processinstance caninclude multiple
activity instances.

An activity that has been started is an activity
instance.

Adapter

Provides a connection between the back-end
database and the Web application, allowing data
to pass back and forth from the database to the
Web browser.

AND-Join

A point within the workflow where two or more
parallel activities are joined and the next logical
activity is executed (see Parallel routing).

AND-Split

A point within the workflow where a sequential
route splits so that two or more parallel activities
are formed for independent, simultaneous
processing (see Parallel routing). An AND-Join is
used to join the parallel activities when their
processing is complete.

Application server

Processes data from a Web application database
and delivers it to the Web server.
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Term Definition

Archway A Java servlet that listens to HTTP requests from
clients and foreign servers, routes the requests
to an appropriate server, and returns data or
displayable documents. The requests supported
by Archway can vary, but they fundamentally
consist of queries, data updates, and system
events. Archway processes HTTP requests and
formats them into messages understood by the
Get-Answers processing layer. The resulting
messages are ultimately dispatched to a data
store adapter which produces an XML formatted
result set.

Authoring Authoring is the ability to create new documents
and edit the content using an RTF editor.

Audit data An historical record of the progress of process
instances and activity instances.

Get-Answers collects the following information
for process instances and activity instances:

Process Instance Activity Instance
Date Start Date Assigned
Date Ended Date Due
Date Ended
Automated activity An activity that is performed by a computer,

without user intervention.

Business process A set of linked activities that complete a business
objective. A business process is defined in a
process definition that can include both
automated and manual activities.

Capabilities Capabilities are the tasks that Members,
Submitters, Readers, Reviewers, Editors, and
Owners can perform. There are seven
capabilities including read, create, update,
revert, retire, publish, and transfer.

Deadline A time-based scheduling constraint where the
work item for an activity must be completed by a
specified time.

Domains Domains contain published documents. Each
domain is managed by one Ownership Team.

ECMAScript Server-side scripting language. Used to write
scripts for Get-Answers.

Editor Editor is one of the four Document Ownership
Team permissions. An editor has read, create,
and update capabilities for any document
owned by the Ownership Team. An Editor also
has special responsibilities in the editorial
workflow.
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Definition

Editorial workflow

Escalation

The Get-Answers Editorial Workflow is used to
edit and review an unpublished (working copy)
document and its metadata.

A procedure that is invoked when a specific
constraint or condition is not met. An escalation
can be automated or manual and generally
involves a higher level of authority (see
Organizational Role).

Event

HTML

HTTP

Iteration

JAAS

Java Run-Time Environment

An occurrence that causes the workflow
management software to take one or more
actions. An event notifies the workflow engine of
an internal or external action.

Hypertext Markup Language. A language used
to compose Web pages, which can be read and
displayed by a Web browser.

Hypertext Transfer Protocol. The
communications protocol used to connect to
Web servers. Sends HTML pages to the Web
browser to be read and displayed. HTTPS can be
used to provide extra data level security.

A repetitive execution of one or more activities
until a specified condition is met.

Java Authentication and Authorization Service:
JAAS is used by Get-Answers to authenticate
users. The set of services against which a user
must be authenticated can be configured, and
each service can be defined as REQUIRED,
OPTIONAL, REQUISITE, or SUFFICIENT through
login modules.

A JREis required to run Java programs. It consists
of the Java Virtual Machine, the Java platform
core classes, and supporting files.

JSP

Manual activity

Member

Java Server Page. Allows separation of page
content from the design and display of a page.
HTML tags with embedded Java source code are
executed by the Web or application server. JSP
technology is an extension of Java servlet
technology.

An activity that requires user resources for
performance of the required tasks associated
with the activity.

Member is one of the two Domain permissions. A
member has read access to any document
published in the domain.
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Term Definition

Metadata Metadata consists of information stored about
each document, such as file name, title, file size,
document type, version number, creation date,
and editorial status.

OAA Platform The software platform that the Peregrine Get-It
products use. These products are Get-Answers,
Get-Resources, and Get-Services. This platform
provides features and functionality common to
the Get-It employee self-service products. The
OAA Platform is a software product included
with any or all of the Get-It products and is not
sold without them.

OR-Join A point within the workflow where two or more
alternative activity branches are joined into a
single activity.

OR-Split A point within the workflow where a sequential
route splits based on a decision upon which
branch to take. An OR-Splitis conditional and the
branch to the next activity is determined by the
value returned.

Organizational Role A group of workflow participants having a
specific set of attributes, qualifications, and skills.
The participants within the group can perform
work items that require a participant who has
that set of attributes.

Owner Owner is one of the four Document Ownership
Team permissions. An owner has read, create,
update, revert, retire, publish, and transfer
capabilities for any document owned by the
Ownership Team. An Owner also has special
responsibilities in the editorial and triage
workflows.

Ownership teams Ownership Teams manage documents. There
are four permissions associated with an
Ownership Team. They include Reader, Editor,
Owner, and Reviewer.

Parallel routing A segment of a process instance where two or
more activity instances execute in parallel.
Parallel routing normally is created with an
AND-Split and concludes with an AND-Join.

Peregrine Portal The first screen displayed when starting a
Peregrine Web application. Provides a login
screen and access to the modules that make up
the application.

Process A set of process activities designed within the
process definition according to the
requirements of a business process.
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Term

Definition

Process definition

A process definition represents a business
process and consists of activities where the
process tasks are defined.

A process definition includes information about
the activities and workflow users. Both manual
activities and automated activities can be
included in the process definition.

Process instance

Process role

A single instance of a process as defined by the
process definition.

A process that has been started is a process
instance.

A mechanism that associates workflow
participants with workflow activities. The role
defines how the user participates in a specific
process or activity.

Process state

Reader

Reviewer

A representation of the status of a process
instance. The Get-Answers workflow uses the
following process states:

Running the process instance is running
and one or more activities have
started.

Completed the process instance has
successfully completed all
activities.

Error the process instance has
encountered an error and
stopped.

Reader is one of the four Document Ownership
Team permissions. A reader has read access to
any document owned by the team. Readers play
no role in the editorial or triage workflows.

Reviewer is one of the four Document
Ownership Team permissions. A reviewer can
read any document owned by the Ownership
Team. A Reviewer also has special
responsibilities in the editorial workflow.

Roles
Sequential routing

Servlet

Roles consist of a group of users. Permissions are
given to roles and/or individual users.

A segment of a process instance where several
activity instances are executed in sequence.

A platform-independent Java application
component that is used by the system as needed
to perform server-side processing (for example,
to access a database).
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Submitter Submitter is one of the two Domain permissions.
A submitter has read access to any document
published in the Domain, and can contribute
new documents to the Domain.

Triage workflow The Get-Answers Triage Workflow is used to
examine newly submitted documents that have
never been published before, in order to
determine if the document should be further
reviewed in an Editorial Workflow, published
immediately, transferred to a different
Document Team, or deleted.

Web application An application that opens in a Web browser.

Web server Reads data directly from a Web application or
from the application server and converts it to a
form that can be displayed by a Web browser.

Work item The work to be processed by a workflow user, as
defined in the associated activity. Work items for
auserorgroup of users are accessed through the
worklist.

Workflow The automation of a business process where
tasks are passed from one user to another, as
defined by the process definition.

Get-Answers workflow consists of the lifecycle
stages of each document. Up to three copies of a
document can existat any time. They include the
published copy, the working copy, and the copy
currently under revision.

Workflow engine A software service or “engine” that provides the
run time execution environment for a process
instance.

The workflow engine interprets the process
definition, creates process instances and
manages their execution, and navigates
activities and creates work items for their
processing.

Workflow participant A user that performs the work items assigned
through the worklist. Each work item is
represented by a workflow activity.

Working copy A working copy is a version of the published
document in an editorial status.
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Term

Definition

Worklist

A list of work items associated with a specific
user or group of users.

XML

Extensible Markup Language: A documentation
meta-language that allows you to author
self-describing data documents, which can then
be formatted with a style sheet for display in a
Web browser or exchanged with foreign
systems. Unlike HTML, you create your own XML
tags and define their meaning to suit the
application.
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